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Copyrights 
and 
Trademarks

©2015-2016 Tyco Fire Protection Products. All rights reserved.

Specifications and other information shown were current as of publication and are subject to 
change without notice. TYCO, SIMPLEX, and the product names listed in this material are 
marks and/or registered marks. Unauthorized use is strictly prohibited.

Cautions 
and 

Warnings

READ AND SAVE THESE INSTRUCTIONS- Follow the instructions in this installation manual. These instructions 
must be followed to avoid damage to this product and associated equipment. Product operation and reliability 
depend upon proper installation.

DO NOT INSTALL ANY SIMPLEX® PRODUCT THAT APPEARS DAMAGED- Upon unpacking your Simplex 
product, inspect the contents of the carton for shipping damage. If damage is apparent, immediately file a claim 
with the carrier and notify an authorized Simplex product supplier.

ELECTRICAL HAZARD - Disconnect electrical field power when making any internal adjustments or repairs. All 
repairs should be performed by a representative or authorized agent of your local Simplex product supplier.

STATIC HAZARD - Static electricity can damage components. Handle as follows:
• Ground yourself before opening or installing components.
• Prior to installation, keep components wrapped in anti-static material at all times.

EYE SAFETY HAZARD - Under certain fiber optic application conditions, the optical output of this device may 
exceed eye safety limits. Do not use magnification (such as a microscope or other focusing equipment) when 
viewing the output of this device.

FCC RULES AND REGULATIONS – PART 15 - This equipment has been tested and found to comply with the limits for a Class A 
digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense.
SYSTEM REACCEPTANCE TEST AFTER SOFTWARE CHANGES - To ensure proper system operation, this product must be 
tested in accordance with NFPA-72, after any programming operation or change in site-specific software. Re-acceptance testing is 
required after any change, addition or deletion of system components, or after any modification, repair or adjustment to system 
hardware or wiring.
All components, circuits, system operations, or software functions known to be affected by a change must be 100% tested. In addition, to ensure that 
other operations are not inadvertently affected, at least 10% of initiating devices that are not directly affected by the change, up to a maximum of 50 
devices, must also be tested and proper system operation verified.

IMPORTANT: Verify FACP System Programmer, Executive, and Slave Software compatibility 
when installing, or replacing system components. Refer to the Technical Support 
Information and Downloads website for compatibility information.
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Chapter 1.
Getting Started

Introduction The 4007ES Panel Programmer is a software program designed to create “jobs” that are used 
to configure and program the 4007ES  and 4007ES Hybrid Fire Alarm Control Panel (FACP). 
The 4007ES Panel Programmer must be installed on a computer that can be either physically 
or remotely connected to the panel. 

 
In this chapter

Requirements 
and Compatibility

Computer requirements:

The Programmer must be installed on a Computer that has the following requirements:

• Windows XP with SP3 or a more recent operating system.

• Removable media for job archives and backups.

• 1 CD-ROM drive, for access to the documentation CD.

• 1 Ethernet port or optionally 1 serial port & assorted cables for communication with the ES 
Panel.

Programmer Requirements:

To install and open the Programmer, the user must have the following:

• Internet access in order to download the software. 

Downloading the 
Software

To download the 4007ES panel programmer software:

1. Connect to Internet.

2. Connect to the simplex-fire.com Tech Support website (registration is required).

3. Navigate to the Distributor Support, then Technical Support page.

4. Once in the Software Download area, click the 4007ES Hybrid. This should be the latest 
revision of the ES Programmer for the 4007ES panel. 

5. Once the file is loaded a security warning will ask you if you wish to proceed. Click Run.

6. An authorization request to copy the file to your computer’s C Drive appears. Click OK. 
The file 4100ESProg will then start to download to the C directory of your computer. 

Requirements and Compatibility .....1-1 Installing the Software .....................1-2

Downloading the Software ..............1-1 Starting the Programmer..................1-2
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Installing the 
Software

To install the software:

1. Go to the computer C Drive and open the 4100ESProg folder.

2. Double click on the ES programmer executable file (.exe). 

3. The Software Licensing agreement appears. Read the agreement and click Next to continue 
the installation. 

4. A prompt window requesting the user to specify the destination folder for the programmer 
files appears. 

• Click on the Next button to accept the default destination. It is recommended that you 
choose the default folder Simplex. When the correct entry is specified, click on Next to 
continue.

5.  Progress indicators appear, displaying the progress of the file copy operations.

6. The next prompt requests that the user restart the computer. 

Note: Before restarting the computer be sure that all open files have been saved. 

7. Click on Finish to restart and complete the installation. 

Starting the 
Programmer

To Start the ES Panel Programmer:

1. Open the Windows Start menu.

2. Click on the All Programs menu.

3. Click on the Simplex menu item.

4. Click on the version of the ES Panel Programmer you want to open and a menu appears.

5. To start the Programmer select ES Panel Programmer from the menu.

Note:  The following options are also available from the ES Panel Programmer menu:

• Compare: This option allows the user to compare job revisions.

• IP File Transfer: This option opens the IP File Transfer menu.

• Job builder: Select this option to build a Job.

• Tera Term: This option opens the Tera Term connection. 

• Uninstall ES Panel Programmer: Click on this option to uninstall the ES Panel Programmer. 

Figure 1-1. Starting the ES Panel Programmer

See page 3-1 for information on how to create a new job. 
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Chapter 2.
User Interface

Introduction The user interface has menus, icons, tabs, sub-tabs, and a status bar that help the user navigate 
through the programmer and create jobs. 

The following sections detail the user interface and the options associated with each item.

Figure 2-1. 4007ES Programmer Interface

 
In this chapter

Menus The menus are located at the top of the ES Panel Programmer:
Consult the following tables for the description of the menu items. 

Icons

Tabs

Sub-Tabs

Status Bar

Menus
Toolbar

Menus ..............................................2-1 Toolbar Icons ...................................2-4

Tabs and Sub-Tabs...........................2-5 Status bar..........................................2-5

Table 2-1. File Menu

Menu Item Description Menu Item Description

New Creates a new job. Archive Archives the job.

Open Opens an existing job. Backup Backs up the job.

Close Closes the current job. Restore Restores the previous saved version of 
the job.

Save Saves the current job. Export Allows the user to:
• Export data to service sales tools
• Export user points to text file
• Export XLG point data

Save as Allows you to copy or rename the 
current job. 

Reports Generates a digital job report. Import Allow the importation of user points 
from another file.

View report Brings up the latest report. DB Compare Compares the job to previous revisions 
of itself.

Print set up Configures the hard copy print 
specifications.

Current Job The name of the current job.

Print Label Prints labels for the FACP cards. Exit Exits the current job.

Continued on next page
2-1
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Menus Table 2-2. Edit Menu

Table 2-3. View Menu

Table 2-4. Tools Menu

Continued on next page

Menu Item Description

Cut Copies and deletes the selected content.

Copy Copies the selected content.

Paste Inserts the previously cut or copied material into the selected area.

Preferences Allows the user to configure certain aspects of the programmer. 

Menu Item Description

Revision History Allows the user to enter notes about the changes made for each revision.

*Tab List* Click on the option to open the corresponding tab. The choices are:
• Panel: Allows the user to access the following sub-tabs: General Info, System 

Options, Access Levels, Passcode Assignments, and Feature.
• Hardware: Allows the user to add and remove components and configure their 

properties.
• Point: Allows the user to edit TrueAlert devices.
• List: Allows the user to access the following sub-tabs: General List, Latching Supv 

Verification, Alarm Verification, WalkTest, and Elevator Recall.
• Custom Control: Allows the components of the ES Panel FACP to be controlled 

with user-definable custom control equations.
• TrueAlert Zone: Allows the user to view the points in each TrueAlert zone.
• Port Vectoring: Allows the user to program cards to output only specific groups of 

events.
• AMON Pt Type: Allows the user to create custom point types.
• Zone Lists: Allows the user to view the lists sorted by zone.

Checklist Displays a mandatory and an optional checklist that lets the user know which steps 
have been completed in the programming process.

Toolbar Click in the checkbox to make the tool bar icons visible.

Status Bar Click in the checkbox to make the status bar visible.

Menu Item Description

Notes Click to open a note pad where the user can type in notes about the job.

Table 2-5. Build Menu

Menu Item Allows the user to:

Build Job Build the job.

View Build Log Click to view the log of previous builds for this job.
2-2
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Menus Table 2-6. Transfer Menu

Table 2-7. Terminal Menu

Menu Item Allows the user to:

USB Transfer the job data from the computer to the USB key.

Network Click on To Panel to transfer the job data to the panel.

Menu Item Allows the user to:

Serial Enable a serial connection between the FACP and the Perle Box. This option cannot be 
used for panel serial downloads.

Network Enable a network connection between the computer and the panel.

Settings Access the service port connection settings.

Table 2-8. Help Menu

Menu Item Description

Help Topics Click to access the 4007ES Programmer Help.

About Programmer Click to access basic information, copyright of the programmer software, and the 
revision of the programmer being used.
2-3



4007ES Panel Programmer Manual (579-1167)
User Interface, Continued

Toolbar Icons The toolbar icons are shortcuts to popular programmer commands. Table 2-9 explains each 
icon and the command it is attached to. 

Table 2-9.  Icons and Commands

Icon Name Allows the user to:

New Click to create a new job.

Open Click to open an existing job.

Save Click to save the current job.

Cut Click to cut the selected information from its current location.

Copy Click to copy the selected information.

Paste Click to paste cut or copied data.

Print Click to print the current job.

Build Job Click to build the current job.

File Transfer Click to initiate a file transfer.

Checklist Click to make the checklists appear.

Note Click to add a note to the job.

About Click to access basic information and copyright of the programmer software.

Help Topics Click to access the 4007ES Online Help.

Exit Click to exit the programmer.
2-4
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Tabs and Sub-
Tabs

Each tab represents a specific component or feature of the job that must be configured. The 
tabs are placed in sequential order and should be completed in that order. Certain tabs are made 
up of multiple sub-tabs that are found at the bottom of the page. All sub-tabs must be opened 
and configured to complete the job.

Status bar The Status bar is found at the bottom of the Programmer window and indicates the:

• Programmer status

• Time

Table 2-10. Tab list

Icon Name Sub-Tabs Allows the user to:

Panel • General Info Enter and view the general panel and branch 
information.

• System Options Set the system options for the job.

• Access Levels View the default user levels for specific tasks. Right 
click on the user level to view and edit its properties.

• Passcode 
Assignments

View and edit the passcode assigned to each user 
level.

• Features Enable or disable certain features with specific 
dongles and codes. 

Hardware • Tree View Display the panel components in a branch structure. 

• Grid View Display the panel components in a grid structure. 

Point -NA- Display the list of all the points in the FACP. 
Double click on any of the points to view and edit 
their properties. 

List • General list View all the Panel lists.

• Latching Supervisory 
Verification

View and edit the items on the Latching Supervisory 
Verification list. 

• Alarm Verification View and edit the items on Alarm Verification list. 

• WALKTEST View and edit the items on the WALKTEST list. 

• Elevator Recall View and edit the items on the Elevator Recall list.

Custom Control
• Custom Control

Create custom control equations which allow 
operations to be customized per job.

• Floor Above/Floor 
Below Wizard

Control the areas in which the NACs are activated. 

• Selective Signaling 
Wizard

Control the NACs that are activated.

• Sounder/Relay Base 
Operation Wizard

Customize the default operation of select smoke 
detectors

TrueAlert Zone -NA- View the points in each TrueAlert zone. 

Port Vectoring -NA Assign certain cards to specific groups of events.

AMON Point Type -NA- View the analog monitor (AMON) points.

Zone Lists -NA- View the lists sorted by zone.

Network • Network Information
• Network Points

Add and edit the lists of public and external points.
2-5





Chapter 3.
Working with Jobs

Introduction A job is a file that contains specific programming and configuration information for the FACP. 

This chapter explains the basics surrounding creating and saving jobs, however, it is important 
to consult the following chapter in this document, Panel Information and Configuration, for 
crucial information on how to configure and program the job. 

 
In this chapter

Creating Jobs When the programmer is opened on a computer for the first time, a prompt window appears 
automatically requesting that the user create a job. If a job has been previously saved on the 
programmer it automatically opens when the programmer is started. 

To create a new job:

1. Start the ES Panel Programmer:

• If this is the first job saved for the FACP, the New Job window opens automatically.

• If a previous job opens, click on the New icon or select New from the File menu to 
open the New Job window. 

2. In the New Job window, select the job type: 

- 4007 - for the addressable panel 

- 4007H - for the Hybrid panel.

3. Enter the job number. The job name should be 8 characters long and start with a number.

• Year. This is a two-digit field. Use the last two digits of the current year to indicate the year 
in which the job is programmed.

• Month. This is a single character field. Use the numbers and letters shown in the example 
below to indicate the month in which the job is programmed. See Table 3-1.

• File Type. This field is a single letter, used to indicate the panel type. There is currently 
only a single supported type.

• Number. This is a three-digit field used to track how many of a specific job type have been 
programmed during the month. For example, if the File type is 4100ES, enter the number 
of 4100ES jobs programmed during the month.

• Job Version. When archiving a job, you can use letters to differentiate the jobs once they 
have been archived. For example, once job 103E123A is archived, new edits should be 
saved to 103E123B.

Creating Jobs ...................................3-1 Opening Existing Jobs .....................3-2

Setting Job Preferences....................3-2 Job Notes .........................................3-3

Saving Jobs ......................................3-3 Building a Job ..................................3-3

Archiving a Job................................3-4 Backing Up a Job.............................3-4
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Creating Jobs Table 3-1 describes the naming convention format.

4. Select the path to the file in which the job will be stored. 
Note: It is preferable that the default folder C:\4100UJOBS be used for job storage. 

Opening Existing 
Jobs

To open an existing job: 

1. Start the ES Panel Programmer.
2. Click on the Open icon or select Open from the File menu to access the Open window. 
3. Open the job’s folder. It will have the same name as the job. 
4. Once in the folder, open the “.SDB4100U” file.

Setting Job 
Preferences

To set the job preferences: 

1. Once in the job, open the Edit menu and select Preferences.
2. Preference allows the user to configure the following options:

•  Job: Click on the Reload Job checkbox to automatically reload the last saved job each 
time you start the programmer.

• Toolbar Icon Size: Use to select large or small icons for the programmer toolbar.
• Checklist: There are two preference settings for this option.

- Reminder: If this box is selected, the programmer generates a reminder dialog 
each time you exit a screen whose corresponding entry in the Programmer Task 
Checklist has not been marked as complete. For example, if you view the 
General Information tab and its checklist entry is not marked as complete, the 
programmer will ask whether you want to mark the task as complete when you 
exit the screen.

- Build Warning: Attempting to build a job when all mandatory checklist tasks 
are not marked as complete causes the programmer to generate warning 
messages in the job builder screen.

•  Default Central Station Email Address: This option allows you to set the default 
central station email address used by a per point SDACT. The address that you enter 
here automatically appears in the email address field of the SDACT card's 
programming screen.

• Report Print Cover page: Select this box so that a cover page is printed with every 
report.

• Editing Allow mixed case labels (non-English jobs only): This option is made to 
accommodate the characteristics of non-English languages. 

3. Click on OK once all the options are set. 

Table 3-1. Job Naming Convention

YEAR MONTH FILE TYPE NUMBER JOB VERSION

1 = Jan E=4100ES

2 = Feb

3 = Mar

4 = Apr

5 = May

6 = Jun

7 = Jul

8 = Aug

9 = Sep

A = Oct

B = Nov

C = Dec

00 5 E 001 A
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Job Notes To leave a note for the job on the programmer:

1. Once in the job, either click on the Notes icon or open the Tool menu and select Notes.

2. The Notes window opens and the user can type in relevant job notes. These notes are saved 
with the job for future reference.

Saving Jobs There are two saving options in the programmer, Save and Save As. The Save option is used to 
save the job in progress, the Save As option is used to save the job with a new name.

To save a job with Save:

• Click on the Save icon.

• Open the Edit menu and click on the Save option.

Note: When you click on the save option, the programmer overwrites the previous information and there is 
no way to backtrack to the previous job. 

To save a job with Save As:

1. Open the File menu and click on the Save As option.

2. Select either the Copy option or the Rename option:

• Copy: This option saves a copy of the currently open job under a new name in a new 
directory. This option allows you to open and reuse the previous version.

• Rename: This option saves the job under a new name and deletes the content of the 
previous job folder. For example, if a user renames job 333 as job 444, a new job 
folder named 444 appears and the job folder 333 is empty. 

Note: Conventionally, performing a Save As > Copy is the first action a technician takes when opening an 
existing job to create a new revision. This way, if complications arise, the technician can return to the 
previously saved revision. 

Building a Job A job needs to be “built” before it can be downloaded. This process transforms the .SDB file 
into a CFIG file that is compatible with the FACP. 

Note: All configuration options and panel information must be complete before building the job. Any errors 
detected during the build will abort the process. 

To build a job:

1. Open the job.

2. Make the programming changes.

3. Start the build by either clicking on the Build icon or by selecting the Build item from the 
Build menu. 

4. The Revision History window appears and the user must enter:

• Their name.

• A brief description of the edits that were made to the current revision.

Once the information has been entered click on OK.

5. The Job Builder window then appears and displays all the elements in the job and their build 
status. Once the compilation is complete, the final dialogue in the window will read either:

• Build Complete: This means the build has been successful and the job is ready to be 
downloaded to the FACP.

• Build Aborted: This means that errors were found while the job was being built and 
that the job build was aborted. The errors that caused the job to abort are listed in the 
Job Builder window. 
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Archiving a Job Once a job is archived, it is saved as a read-only .SDA4100U file that can no longer be opened 
for editing. 

To archive a job:

1. Save the job.

2. Open the Edit menu and click on the Archive menu item.

3. The Programmer Archive Utility window opens and requests that the user name the file and 
select the directory to which the file will be saved. 

4. Click on Archive. A progress meter appears, showing the progress of the operation. When 
this bar disappears, the archive operation is complete. The archived file is saved as 
.SDA4100U.

To open an archived file:
1. Open the File menu and click on the Restore menu item.

2. The Programmer Restore Utility window opens. Use the Look In search box to locate the 
archived file. 

3. Once the file is located, click on it so that its name appears in the File Name box.

4. Click on Continue.

5. The Browse for Folder window appears and requires that the user select the directory and 
file to which the file will be restored. It is recommended to use the 4100UJOB Folder. 

6. If a file with that name already exists, the user will be prompted to:

• Overwrite the existing file

• Rename the file 

• Cancel the operation: This will result in an error file and the programmer will return to 
the last saved job. 

7.  The archived file will then open as a read-only job. To save the job as a different version in 
the 4100U folder, the user must use the Save As function. 

Backing Up a Job Backing up a job creates a compressed version of the job and stores it as a read/writable 
.SDC4100U file on either a removable storage medium or a remote disk.

To back up a job:

1. Open the File menu and select the Backup menu item.

2. The Programmer Backup Utility window opens and requests that the user name the file and 
select the directory to which the file will be saved. 

3. Click on Backup. A progress meter appears, showing the progress of the operation. When 
this bar disappears, the backup is complete.

To restore a Backup file: 

1. Open the File menu and click on the Restore menu item.

2. The Programmer Restore Utility window opens. Use the Look In search box to locate the 
backup file. 

3. Once the file is located, click on it so that its name appears in the File Name box.

4. Click on Continue.

5. The Browse for Folder window appears and requires that the user select the directory and 
file to which the file will be restored. 

6. If a file with that name already exists, the user will be prompted to:

• Overwrite the existing file

• Rename the file 

• Cancel the operation

7.  The backup file will then open as normal job. 
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Chapter 4.
Panel Information and Configuration

Introduction This section focuses on items found in the Panel tab. Information in this section must be 
completed and the options must be configured before the job is successfully built. 

In this chapter

Notice to users, 
Installers, AHJ, 
and other 
Involved Parties

This product incorporates field programmable software. In order for the product to comply 
with the Standard for Control Units and Accessories for Fire alarm systems, UL864, certain 
programming features or options must be limited to specific values or not used at all as 
indicated in Table 4-1.

Panel Information Panel information provides identification reference for the technicians who created the jobs.

To enter the panel information:

1. Click on the Panel tab and select the General Information sub-tab.

2. Fill out the information requested on the page:

• Panel Information: This section requests information about the panel.
• Branch Information: This section requests information about the branch of the 

company and other useful information.

Notice to users, Installers, AHJ, and other 
Involved Parties ........................................4-1

Panel Information .................................... 4-1

Passcode Configuration ............................4-8 System Options ........................................ 4-2

Features Configuration .............................4-8 User Access Level Configuration ............ 4-7

Table 4-1. Programming Features and Options

Program Feature
or Option

Permitted 
in UL864? 
(Y/N) 

Possible Settings
Settings Permitted
by UL

Editing group properties DC group 
tab Yes

ON until completion
ON until RESET
ON until SILENCE

ON until completion

Editing Custom Control equations 
that change sensitivity levels (set 
Alarm Thresholds) for ISN- 550 
Photo smoke detectors

Yes

3.1
2.6
2.2
1.8
1.4
1.0

3.1
2.6
2.2

LVSUPV - Latching Verified 
Supervisory Smoke Detector

No

LVSDUCT - Latching Verified 
Supervisory Duct Smoke Detector

No

MACOFIRE - Carbon
Monoxide Fire Algorithm

Yes
COFIRE, COPRI2
COSUPV, UTILITY

COSUPV
UTILITY

Suppression Release Wizard Yes

Immediate Release 
(No Delay),
10 Second Delay,
System Reset after 
GREATER of 
remaining time or 10s, 
IRI Abort, Reset 
Original Time Delay, 
NYC

Immediate Release 
(No Delay),
10 Second Delay, 
System Reset after 
GREATER of 
Remaining time or 
10s 

Continued on next page
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Panel Information and Configuration, Continued
Panel Information • Programmed by: This section requests information about the people who programmed 
the FACP (branch, customer information). 

• Hardware Edit Lock: When this option is checked, the user cannot add or remove any 
hardware.

• Comment: Enter any comments about this specific FACP.

System Options ES Panel System Options are global attributes that allow the user to configure specific 
application options as well as configure certain elements of the panel's display.

To access the System Options screen:

1. Click on the Panel tab and select the System Options sub-tab.

2. Configure the options that appear on the page. The following tables list and define the 
different options.

Table 4-2. General System Options 

Option
Description

(“dflt” indicates the default setting)

Date Format • Select MM-DD-YY dflt for the panel to display the date by month, day, and 
year (example: January 4th 2013 = 01-04-13). 

• Select DD-MM-YY for the panel to display the date by day, month, and year 
(example: January 4th 2013 = 04-01-13). 

Time Format • Select 12 Hour dflt for the panel to display the time as “a.m.” and “p.m.” 
(example: 6:00 a.m., 6:00 p.m.) 

• Select 24 Hour for the panel to display the time on a 24h clock (example: 
6h00, 18h00.)

Unit Format • Select Fahrenheit dflt for the panel to display Imperial units.

(example: 96 oF, 6 ft)
• Select Centigrade for the panel to display Metric units. 

(example: 36 oC, 1.83 m)

Acknowledge 
Option

• Select Global acknowledgedfl to allow every point reporting the same alarm 
state (alarm, trouble, priority 2, or supervisory condition) to be 
acknowledged at once by pressing the according Acknowledge button. 
(Example: If 5 Trouble conditions are present on the system and global 
acknowledge is enabled, one press of the Trouble Ack button 
acknowledges all five Troubles at the same time.) 

• Select Individual Acknowledge to ensure that each point reporting an 
alarm state must be acknowledged individually. (example: If five Trouble 
conditions are present, acknowledge each one individually.)

Standard Select the system listing standard. The options are: 

• Nonedfl

• UL (US)

• ULC (Canada)

Continued on next page
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Service 
Reset

Select Service Reset to allow an operator to reset the system even though 
the device causing the alarm has not restored to normal. 

The typical application for this would be when a malfunctioning initiating 
device (detector or sensor consisting of a base and removable head) causes 
an alarm, but will not reset even though the off-normal condition is no longer 
present. With this option enabled, the head can be removed and the system 
(including the local energy masterbox, if provided) can be reset. Without this 
option enabled, removing the head will cause the system to abort the reset 
because it will not have seen the alarmed point/zone having restored to a 
normal state, and it will not be possible to reset the local energy masterbox. 
The default setting for this option is disabled.

Combined 
Alarm and 
Hardware 
Reset

If checked, pressing the Reset button performs an alarm reset followed by a 
hardware reset. If this option is not selected, an alarm reset is performed if 
there are fire alarms or supervisories in the system. Otherwise, a hardware 
reset is performed. 

Display First 
Alarm

When this option is selected, the display alternates between the summary 
screen (with the number of active alarms, troubles, etc.) and the screen 
showing detailed information on the first alarm received by the system. 

If this option is not selected, the screen indicating the number of alarm 
conditions on the system is displayed.

Non Steady 
Audible Evac

When enabled, this option allows you to select the type of operation for Non 
Steady Audible Evacuation Signals. The term Non Steady Audible Evacuation 
Signal refers to any Notification Appliance capable of sounding a coded 
signal. The default setting for this option is not enabled. Choices are:

• California Code 1. A coding pattern consisting of 12 beats within a 
10 second span of time, followed by a 2 ½ second pause. This sequence 
repeats four times (four rounds) and then terminates (i.e., the total coding 
pattern lasts approximately one minute).

• California Code 3. Same coding pattern as California Code 1, however the 
sequence repeats 12 times (12 rounds) and then terminates (i.e., the total 
coding pattern lasts approximately three minutes). 

• Fast March Time. A coded signal that uses 120 beats per minute. Each 
beat consists of ¼ second pulse on, ¼ second off. Pattern repeats until 
alarm silence.

• March Time. A coded signal that uses 60 beats per minute. Each beat 
consists of ½ second pulse on, ½ second off. Pattern repeats until alarm 
silence.

• Slow March Time. A coded signal that uses 20 beats per minute. Each beat 
consists of 1.5 second pulse on, 1.5 second off. Pattern repeats until alarm 
silence.

• Temporal 4. A CO gas warning that is a repeated sequence of four 
cycles of 100 msec on with 100 msec off, followed by 5 seconds off.

• Temporal. A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three pulse group is 
separated by 1 ½ seconds of silence. Pattern repeats until alarm silence.

• On Steady.

Note: If the coding pattern selected here is not supported by the notification appliance, 
it will be replaced by a default one.

Continued on next page

Table 4-2. General System Options  (Continued)

Option
Description

(“dflt” indicates the default setting)

System Options
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System Options

Continued on next page

Table 4-2. General System Options, Continued

Non Steady 
Visual Evac

When enabled, this option allows you to select the flash pattern output by Non 
Steady Visual Signals. The term Non Steady Visual Signal refers to any Visual 
Notification Appliance capable of emitting a pattern of flashes (such as 
incandescent visuals). The default setting for this option is not enabled.

Choices are:

• March Time. A coded signal that uses 120 beats per minute. Each beat 
consists of ¼ second pulse on, ¼ second off. 

• Slow March Time. A coded signal that uses 20 beats per minute. Each beat 
consists of 1½ second pulse on, 1½ second off. 

• Temporal. A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three pulse group is 
separated by 1 ½ seconds of silence.

Note: This option cannot be used for public mode signaling as defined in Section 4-4 of 
NFPA 72-99.

Alarm Cutout 
Timer

This option allows you to set a duration (up to 60 minutes) that specifies how 
long signals sound following an alarm. For example, with this option set at 
2 minutes, building signals sound for two minutes and then automatically stop. 
After the signals stop, the alarm condition remains active at the panel. 

If Alarm Silence/Reset Inhibit option is active, it takes precedence over this 
option. See description of Alarm Silence/Reset Inhibit below for more 
information. 

The range for this option is 60-3600 seconds. The default setting for this 
option is not enabled. Set the point type for visual NACS to SVISUAL to have 
them turn off at the same time as the audible signals. 

Note: See Appendix A for ULC Programming requirements when using this feature for 
ULC applications.

Alarm 
Silence/ 
Reset Inhibit

This option disables the Alarm Silence and System Reset buttons for a user-
definable duration that ranges from 1 to 60 minutes. The timer is activated 
only by the first alarm (i.e., subsequent alarms do not reset the timer).

If this option and the Alarm Cutout Timer are both enabled, this option takes 
precedence. For example, if the Alarm Cutout Timer is set to one minute and 
this option is set to 2 minutes, signals continue to sound after one minute. 

The default setting is not enabled. 

Note: This option must be enabled for Canadian jobs.

Door Drop on 
AC Fail

Option is grayed out

Door Drop on 
Alarm

Option is grayed out

AC Failure 
Delay

Specifies the time delay (HH:MM) in reporting an AC failure trouble to the city 
circuit (if AC fail is the only trouble) or Central Station if an SDACT is installed.

Auto Set 
Panel Time 
and Date

The time and date that appeared on the panel before the CFIG DOWNLOAD 
are automatically set after download is complete. This option will not work if 
the time/date was not set prior to the download (i.e. system time/date invalid 
trouble at the panel).
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System Options Table 4-3. Active Status Reminder System Options

Option Description

Fire 
Reminder

The Fire Reminder option programs the system to periodically sound the 
piezo if an uncleared Alarm condition exists at the panel, thereby reminding 
system operators about the uncleared condition.

By default, this option is enabled and the Resound Time is set to 8:00.

To modify the Active Status Reminder settings, do the following:

1. Make sure the box labeled Enabled is checked. 
2. Set the interval at which the piezo should sound. The range is from 0 to 

18 hours. The default is 8 hours.

Pri2 
Reminder

The Pri2 Reminder option programs the system to periodically sound the 
piezo if an uncleared Priority 2 Alarm (security) condition exists at the panel, 
thereby reminding system operators about the uncleared condition.

By default, this option is enabled and the Resound Time is set to 8:00.

To modify the Active Status Reminder settings, do the following:

1. Make sure the box labeled Enabled is checked. 
2. Set the interval at which the piezo should sound. The range is from 0 to 

18 hours. The default is 8 hours.

Supv 
Reminder

The Supv Reminder option programs the system to periodically sound the 
piezo if an uncleared supervisory condition exists at the panel, thereby 
reminding system operators about the uncleared condition.

By default, this option is enabled and the Resound Time is set to 8:00.

To modify the Active Status Reminder settings, do the following:

1. Make sure the box labeled Enabled is checked.
2. Set the interval at which the piezo should sound. The range is from 0 to 

18 hours. The default is 8 hours.

Trbl 
Reminder

The Trbl Reminder option programs the system to periodically sound the piezo 
if an uncleared Trouble condition exists at the panel, thereby reminding 
system operators about the uncleared condition.

By default, this option is enabled and the Resound Time is set to 8:00.

To modify the Active Status Reminder settings, do the following:

1. Make sure the box labeled Enabled is checked.
2. Set the interval at which the piezo should sound. The range is from 0 to 

18 hours. The default is 8 hours.

Local 
Annunciation

If there is a per point serial DACT in the system, this setting specifies whether 
the piezo on the local panel will sound. This option is useful in situations 
where the panel is located in a public area (such as a lobby) and the occupant 
does not want the piezo repeatedly sounding.
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System Options Table 4-4. Recurring Trouble Filter System Options

General Description: These options stop a recurring trouble event from continuously dialing 
the central station or from generating SafeLINC email events if the programmed criteria are 
met (number of occurrences of that point in the trouble log within the specified elapsed time 
frame).

Option Description

Occurrences
Number of times the point is found in the Trouble log (0=no filtering; default for 
pre-existing jobs upgraded to 12.06). Value is selectable from 0 and 2 to 10. 
By default, it is set to 3.

Elapsed Time
Number of minutes in which the Troubles must be found. Value is selectable 
from 1 to 1440 minutes. By default, it is set to 60.

Table 4-5. Addressable Appliances Preferred Default System Options

General Description: This option allows System Options to be selected for TrueAlert ES 
appliances that can be configured identically or independently through the ES Programmer 
software. 

To use the System Options to configure TrueAlert ES appliances:

• The appliance's jumpers and configuration switches must be set to the correct setting. For 
example, if a specific candela value is selected in the system options, the device should be 
set to FACP. On the other hand, if system option is set to “Hardware”, the candela flag at the 
device should be set to any other position than FACP.

• The appliance's candela and coding type in the power supply's Point Editing tab in the 
programmer must be set to "System Default".

When a specific candela value is selected, that value applies to all compatible appliances that 
have their configuration switches set to FACP*.

When Hardware Specified is selected, it is the appliance's locally configured candela value that 
is used.

Option System Options

Candela • 15 cd

• 20 cd

• 30 cd

• 75 cd

• 110 cd

• 135 cd

• 185 cd

• Weather Proof 75 cd 

• Weather Proof 185 cd

• Hardware 
Specified

*Note: When a specific candela value is selected, a warning window appears to notify the user that in the 
event that an appliance cannot be set to the selected Preferred Default System Option, a 
compatible default value is assigned to the device by the programmer.

For example: If the System Option is set to 20 cd and there is a UL Weatherproof device (that has 
no 20 cd setting), the Programmer assigns a value of WP75 cd to the UL weatherproof device.

Continued on next page
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Table 4-6. Compatible Alert Tone Value

User Access Level 
Configuration

User access levels can be configured on the programmer for display functions to determine 
their access level. 

Each access level automatically has access to the level below it. For example, a technician 
authorized for level 1 is only able to access functions that are tagged as level 1. A technician 
with a level 3 authorization level however, has access to functions tagged as levels 1, 2 and 3. 

Note: Passcodes can be attributed to user levels 2, 3, and 4 to restrict the access to certain functions. For 
more information consult the Passcode Configuration section. 

To associate user levels with a display function:

1. Click on the Panel tab and select the Access Levels sub-tab.

2. Double click on the table entry to open its Object Properties window.

3. Select one of four user levels for the display function. Basic display functions, such as 
System Reset and Change Time and Date, are usually assigned to user level 1. More 
sensitive display functions, such as Remote Download, are typically assigned to user level 2, 
3, or 4. 

4. Click on OK to confirm the selection. 

Table 4-5. Addressable Appliances Preferred Default System Options, Continued

Assigned Candela 
Value

Value for Indoor 
Appliances

Value for Weatherproof, 
UL

 Value for 
Weatherproof, 

ULC

15 cd 15 cd 15 cd 20 cd

20 cd 30 cd WP75 cd 20 cd

30 cd 30 cd WP75 cd 30 cd

75 cd 75 cd 75 cd 75 cd

110 cd 110 cd WP185 cd 75 cd

135 cd 135 cd WP185 cd 75 cd

185 cd 185 cd WP185 cd 75 cd

WP75 cd 75 cd WP75 cd 75 cd

WP185 cd 185 cd WP185 cd 75 cd

HARDWARE Device candela jumper setting determines the output.

Assigned Tone Compatible Tone for Appliances

Broadband / 520HZ / Slow Whoop / Bell / 
Siren / Hi / Lo / Chime / Hardware Specified

Temporal coding and Broadband tone.
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Passcode 
Configuration

Numeric passcodes can be created to grant specific access level to up to 20 different operators. 

Each access level automatically has access to the level below it. For example, a technician 
authorized for level 1 is only able to access functions that are tagged as level 1. A technician 
with a level 3 authorization level however, has access to functions tagged as levels 1, 2, and 3. 

To create a passcode:

1. Click on the Panel tab and select the Passcode Assignments sub-tab.

2. Double-click on a table entry to open Object Properties window.

3. Enter a passcode, composed of up to ten numbers.

4. Assign the access level to the passcode.

5. Click on OK to confirm the selection. 

Features 
Configuration

The Features sub-tab provides information on the functionalities of the ES Panel Programmer 
which can be used with the software key currently plugged into the Programmer PC.

To configure the functionalities:

1. Click on the Panel tab and select the Features sub-tab.The usable features are listed in the 
Programmer/Runtime Features window. 

2. To enable the options under Programmer and Runtime on the left panel, enter the software 
key provided by an authorized Simplex representative with the appropriate access codes.

3. Click on Update Access Codes to complete the action.

Note:  This sub-tab also prompts the user to enter the CPU Number. To get the CPU number, from the 
panel, press on Menu > System info > Panel Serial Number. Enter the number in the designated box.
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Chapter 5.
Specifying Hardware Components

Introduction The hardware components that are part of the FACP must be entered into the programmer so 
that the user can configure their properties according to the job requirements. 

This chapter explains how to add and remove the hardware elements that are entered into the 
programmer. 

 
In this chapter

Hardware Tab 
Overview

The Hardware Tab Window uses a drag and drop interface, consisting of a palette of available 
icons on the right-hand side of the screen and a work area on the left-hand side of the screen. 
There are two available views:

• Tree View: This view displays the hardware in a branch structure. The hardware 
appears linked to the bay into which it is installed. 

• Grid View: This view displays the hardware in a grid structure and groups the 
hardware by type. This view also features search and sorting options for elements 
already added to the FACP.

Hardware Tab Overview...........................5-1 Adding Hardware..................................... 5-2

Adding a City/Relay Card ........................5-3 Adding the Additional IDNet Loops ....... 5-3

Removing Hardware.................................5-3 Editing Properties .................................... 5-3

Annunciator Numbers...............................5-4 Annunciator Number Sharing Rules........ 5-4

Editing Basic Card Properties...................5-5
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Specifying Hardware Components

Hardware Tab 
Overview

Table 5-1 lists the available hardware icons and their descriptions.

Adding Hardware There are two ways to add a hardware component to the programmer:
• Drag and drop
• Right click + add
To add a hardware component to the programmer using drag and drop:
1. Locate the hardware component that you want to add from the Available Hardware window 

on the right of the programmer screen.
2. Click on the hardware and drag it into the Hardware Configuration window on the left of the 

programmer screen, into the proper directory:
• Units must be placed in panel icons.
• Boxes must be placed in units.
• Cards must be placed in boxes.

3. When the component is in the proper place, release the mouse. If the component was 
successfully added, it appears in the Hardware Configuration menu. If the component 
cannot be added to the configuration, an error message appears with the problem diagnosis. 

Table 5-1. Hardware Tab Icons

Icon Meaning

Panel Icon This icon permanently resides in the top left corner of the work area. The panel 
icon represents all of the non-networked, RUI-linked components controlled by 
a single CPU. A single panel may, for example, actually be multiple boxes, 
some residing at one location and some at another location. 

Highlighting this icon and hitting Shift-Right Arrow at the same time expands 
the entire hardware tree.

Unit Icon The unit icon does not represent actual equipment. It corresponds to a location 
at which the box resides. 

Click on the + sign to expand the contents of a unit and see the box.

Box Icon The box icon typically represents a standard bay box. There is also an option 
that represents a custom box. 

Click on the + sign to expand the contents of the box.

Logical Card 
Icon

Logical cards are not hardware; instead they represent all of the analog pseudo 
points, digital pseudo points, or lists used on the system.

Double click on the card to access its properties. 

Physical 
Card Icon

Physical cards are actual hardware, including: monitor, signal, relay, 
annunciator, display, interface, and power cards.

Double click on the card to access its properties. 

LED Module 
Icon

This icon represents the fixed-48 LED Module. The module is installed directly 
in a recess of the dress panel. 

Double click on the card to access its properties. 
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Adding Hardware To add a hardware component to the programmer using click + add:
1. Right click in the Hardware component window. An action list appears.
2. Select the type of hardware you want to add to the programmer from the action list: 

• Add Unit: The Unit Properties box automatically opens.
• Add Box: The Add Box window opens and displays the available boxes.
• Add Card: The Add Card window opens. Use the drop-down menus to select the card 

you want to add. If the card cannot be added to the configuration, an error message 
appears with the problem diagnosis.

To add multiple boxes or cards at one time, use the right-click method. Specify the number of 
boxes/cards to add in the Quantity field.

Adding a City/
Relay Card

To add a City/Relay card:
1. In the Hardware Configuration window, double click on the IDNAC or the NAC power 

supply component.

2. Click on the Data Entry tab.

3. Select the radio button that corresponds to the card you want to add (City connect or Relay).

Adding the 
Additional IDNet 
Loops

To add additional loops in the IDNet expansion loop card: 
1. In the Hardware Configuration window, double click on IDNAC power supply, then double 

click on IDNet+ Multiloop.

2. Click on the Loop Editing tab.

3. Select the first unused card 2: loop B isolator.

4. Change the device type to Isolator/Expanded point capacity.

5. Repeat steps 3 and 4 with the second unused card 2: loop C isolator.

Removing 
Hardware 

To remove hardware components from the programmer:
1. Locate the hardware component in the Hardware Configuration window.
2. Right click on the hardware to open the action list.
3. Select Delete. 
4. A warning message appears warning you that deleting a hardware component deletes all 

references to that component. Click Yes if you wish to continue. If the component cannot be 
deleted, a second warning appears with the specifics of why the component cannot be 
deleted. 

Note: Before deleting a hardware component, it is important to evaluate that component’s role in the 
programmer and make sure that all other elements attached to that component have been redirected. 

Editing Properties To access the Properties dialog, right 
click on a Unit icon in the work area and 
then click on Properties. For more 
information on the cards and modules’ 
Properties window, refer to Chapter 6. 
For the Box Properties window, refer to 
Figure 5-1.

• Description: Enter descriptive text 
for the unit.
• AC Breaker Location: Enter the 
location of the breaker to which the 
power supplies within the unit's boxes 
connect.

Figure 5-1. Box Properties Window
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Specifying Hardware Components, Continued

Annunciator 
Numbers

Every card in a 4007ES Panel job must have an associated annunciator number, whether it is an 
annunciator or not. Annunciator numbers are assigned in the following manner: when a new 
unit is added to a job, the unit is assigned the next available annunciator number. 

When the first annunciator card is added to such a unit, it also assumes the unit's annunciator 
number.

As additional annunciators are added to the unit, there are several cases where the annunciators 
share their annunciator numbers. Any additional annunciator cards of the same type added to 
the same unit also shares this number.
When an additional annunciator card of a different type is added to the unit, that annunciator 
card is given an annunciator number distinct from the number assigned to the earlier 
annunciator type. 
A card’s annunciator number is important for correct LED Switch operation. For example, a 
lamp test switch only lights lamps/LED on cards with the same annunciator number.
Exception to the rules above:

• Internal and external LCD Annunciators require their own annunciator number and do 
not share numbers even with their own kind.

Annunciator 
Number Sharing 
Rules

These rules apply to the annunciator sharing arrangement:
AN Rule 1 - The CPU is annunciator number 0.
AN Rule 2 - Annunciators of the same type in the same unit share annunciator numbers.
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Chapter 5 Specifying Hardware Components
Specifying Hardware Components, Continued

Editing Basic 
Card Properties

All cards, regardless of whether they are the standard system cards (such as the system power 
supply) or an option card, include the basic properties. The basic card properties are listed 
below.

• Card Address. A unique number used to identify the card within the system. This 
number must correspond to the card address dip switch settings on the card.

- Address 001 IDNAC/NAC power supply

- Address 002 IDNet and multiloop

- Address 003 Color user interface

Note: It is usually easier to first add the card to the job with the programmer and then set the dip switches 
with the address automatically assigned by the programmer.

• Card Custom Label. This field describes the card's function, location, or some other 
descriptive text.

• Unit, Box, Bay, and Block (location). The values shown in the fields reflect the 
location in which the card icon was placed when you added it with the programmer. It 
is possible to change these values; however, the new values must reflect the new 
physical location of the card.

To gain access to the Card Properties dialog, do either of the following:

• Double click on any card icon in the work area.

• Right click on any card in the work area. When the list of choices appears, click on 
Properties.

A window similar to Figure 5-2 appears.

Figure 5-2. Card Properties Window - Color User Interface shown as example

Edit these fields as follows:

• Enter a descriptive name in the Card Custom Label field.

• Use the Unit, Box, Bay, and Location (block) fields to change this information if 
necessary. If you specify invalid information (for example, attempt to assign a card to a 
fully populated bay), the programmer outputs an error message to indicate the 
problem.
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Chapter 6.
Editing Standard Component Properties

Introduction 4007ES panels come equipped with a standard set of hardware components. This chapter 
details the programming for those cards. 

 
In this chapter

Accessing 
Properties

1. Open the Hardware tab.
2. Select the hardware component from the Hardware Configuration window and double-click 

on it to open the editing window.

Editing the Unit 
Properties

Each 4007ES panel set-up automatically requires a unit in the programmer.
To edit the unit:

The Unit Window requests that the user enters the following information:

• Description: Enter a description that identifies the particular FACP. 

• AC Breaker Location: Enter the location of the breaker that powers the unit’s power 
supply.

Editing the CPU The 4007 CPU window has three main tabs to edit. The Card Properties tab, the Service Port 
tab, and the Ethernet tab.
To edit the Card Properties tab (Figure 6-1): 

Enter the card’s custom label. This label should make the card easily identifiable. 

The following fields in the tab are filled by the programmer and cannot be edited:

• Card address

• Card description

• Card default label

• Annunciator address

• Unit number

• Box number

• Bay number 
• Location

To edit the Service Port tab (used as an output for ExacTech and TrueInsight): 
1. Configure the communication settings by selecting the Baud Rate, Parity, Data Bits, and 

Stop Bits fields to the values required by the attached device. It is recommended that you 
use the following default settings whenever possible.

• Baud Rate: 115,200
• Data Bits: 8
• Stop Bits: 1
• Parity: None

2. Click on the Port Data button. The RS323 Port Data Entry window opens (Figure 6-1). 
Continued on next page
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Editing Standard Component Properties, Continued

Editing the CPU 3. Click the Gen. Info tab. Enter the 
information requested. Click on 
Apply and then OK to confirm the 
selection (Figure 6-1).
• Device Type: For a CPU card 

service port, this field is 
permanently set to 
COMMAND. 

• Header Label: This field 
specifies the first line of banner 
text that appears at the top of the 
CRT screen.

• Port ID Label: This field 
specifies the second line of 
banner text that appears at the 
top of the CRT screen. It is 
typically used to designate the 
port connection. For example, 
“Port 2, Command Center.”

Figure 6-1.  4007 CPU - Gen Info Tab

• Port Default SET Priority CPU Card Only: This is the system priority level assigned to 
commands issued from the service port. The range is 2 to 15 and the default is 9.

4. Click on the Access Level tab 
in the RS232 Port Data Entry 
window (Figure 6-2). This tab 
allows you to set the access 
level for the various system 
operations that can be carried 
out via the service port.To set 
an access level for one of the 
service port operations, scroll 
through the list of functions 
and highlight the function. Use 
this control to associate an 
access level with the function. 
Click on Apply and then OK 
to confirm the selection. 

Figure 6-2. 4007 CPU Access Levels and Port Options
Note: These access levels apply only to actions performed through the service port, not for operations 

made at the panel display.

5. Click on the Port Options tab in the RS232 Port Data Entry window. This tab contains 
options that apply to the way data appears on the display connected to the service port. 
These are read-only fields. Click OK to return to the Service Port tab.

6. Click in the TrueInsight Remote Service Gateway box to enable the use of the Remote 
Service Gateway. 

To edit the Ethernet tab: 

1. Click the Use Default box or enter the name that the building network has attributed to the 
FACP. 

2. Click on Apply to confirm the selection.
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Editing the Color 
User Interface

The Color User Interface window has five main tabs to edit. The Card Properties tab, 
Annunciator Settings tab, the Point Editing tab, the Display Options tab, and the Access Level 
tab.
To edit the Card Properties tab: 
1. Enter the card’s custom label. This label should make the card easily identifiable. 

2. If required, select a unit, a box, and a bay number.
The following fields in the tab are filled by the programmer and cannot be edited:

• Card address
• Card description
• Card default label
• Annunciator address
• Location

To edit the Annunciator Settings tab

The annunciator settings for a remote color touchscreen LCD annunciator determine the 
operation of the keyswitch. By default, the operations are disabled, except:

• Fire Alarm Display/scrolling

• Supervisory display/scrolling

• Disable display scrolling

To set the properties: 
1. Click on the Hardware tab.

2. Expand the unit, the box, and the bay combination in which the annunciator resides.

3. Double click on the annunciator's icon.

Figure 6-3. Color User Interface - Annunciator Settings Tab

4. Click on the Annunciator Setting tab (see Figure 6-3).

5. This sheet has a series of rows on the left, identifying the functions that can be performed 
from the annunciator. Each row has two checkboxes: Keyswitch Required and Override on 
Alarm. Check or uncheck these boxes, using the following guideline.

•  Keyswitch Required. A checkmark in the Keyswitch Required box to the right of a 
function's row indicates the function is ignored unless a key is inserted in the annunciator's 
key switch and the position of the key is on.

•  Override on Alarm. A checkmark in the Override on Alarm box to the right of a function's 
row indicates that if the Key Switch Required box is checked, the key switch is not 
required during an alarm situation.
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Editing the Color 
User Interface

To edit the Point Editing tab (Figure 6-4): 
For each control key:
1. Select a switch mode 

from the drop-down 
list.

2. Enter a reference 
address. Press F9 to 
access the TagList 
window.

3. Edit the point’s 
custom label if 
required. This label 
should make the 
point easily 
identifiable. 

4. Check the Invert 
Pushbutton State box 
to switch down the 
point. 

Figure 6-4. Color User Interface - Point Editing Tab

The following fields in the tab are filled by the programmer and cannot be edited:
• Reference Label
• Point
• Point Type

For each LED:
1. Select the appropriate mode from the drop-down list.
2. Enter a reference address.
Note: Depending on the switch mode, a LED can be associated to a control key. To do so, the reference 

address of the LED must be the same as the reference address of the control key.

3. Select the appropriate point type from the drop-down list. 
a. The default point type for the first two LED points are LEDRED
b. The default point type for the third LED point is LEDGREEN

4. Edit the point’s custom label if required. This label should make the point easily identifiable. 
The following fields in the tab are filled by the programmer and cannot be edited:

• Reference Label
• Point
• Invert Pushbutton State (grayed out)
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Editing the Color 
User Interface

To edit the Display Options tab (Figure 6-5): If 
needed, check the Reverse Display of custom label and 
status line. To use custom external files for the primary 
and/or the alternate MsgLib:
1. Click on Import.

2. Browse to import the appropriate MsgLib. 

3. Click on Open. 

4. Edit the Name and Date fields. 

By default, the System is Normal image is displayed. To 
edit this image:
1. Check the Enable Custom Image check box.

2. Click on Import Image... 

3. Browse to select the appropriate image. 

4. Click on Open > Apply.
Figure 6-5. Color User Interface - Display Options

To edit the Access Levels tab: 

 

The Access Level tab of the color 
user interface card cannot be edited. 
You can view the access level for the 
various functions in the system, but 
cannot change them.

Figure 6-6. Color User Interface - Access Levels
 

Editing the IDNAC 
Power Supply

The IDNAC Power Supply is part of the 4007ES Hardware Configuration. It has five main tabs 
to edit. The Card Properties tab, the Data Entry tab, the AuxNAC tab, the Aux Relay tab, and 
the Point Editing tab. For more information on the 4007ES Hybrid power supply, refer to the 
Editing the NAC Power Supply section.

To edit the Card Properties tab: 

1. Enter the card’s custom label. This label should make the card easily identifiable. 

The following fields in the tab are filled by the programmer and cannot be edited:
• Card address
• Card description
• Card default label
• Annunciator address
• Unit number
• Box number
• Bay number 
• Location
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Editing the IDNAC 
Power Supply

To edit the Data Entry tab (Figure 6-7): 
1. Configure the Depleted Battery Cutout 

option. If selected, the power supply card 
shuts itself off after detecting a depleted 
battery condition when no AC power is 
present. If this option is selected, a jumper 
must be installed on the power supply (on 
S527), for Canadian operation. It is 
unselected by default.

2. Select the optional cards that are 
connected to the power supply card. The 
choices are: 

• None
• City Connect
• Relay

Figure 6-7. IDNAC - Data Entry Tab

3. Click in the 25V Regulator box if a 25V regulator card, 4007-9802, is used with the FACP. 
4. Click OK to confirm the selection. 

 

To edit the AuxNAC tab 

(Figure 6-8):

1. Select a point type 
from the drop-down 
menu.

2. Edit the AuxNAC point 
type custom label. This 
label should make the 
point easily identifiable. 

3. Click on Apply > OK 
to confirm the edits. 

Figure 6-8. IDNAC - AuxNAC Tab

To Edit the Aux Relay tab 
(Figure 6-9):
1. Select a point type from the drop-

down menu.

2. Edit the Aux Relay point type 
custom labels. This label should 
make the point easily identifiable.

3. Click on Apply > OK to confirm 
the edits.

Figure 6-9. IDNAC - Aux Relay Tab
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Editing the IDNAC 
Power Supply

To edit the Point Editing tab (Figure 6-10): 
Select the card 
options you want to 
apply to the devices 
added to the 
IDNAC Power 
Supply.
1.  The choice are:

• Code Candela 
Rating on 
Magnet with 
Test Mode off 

• LEDs Blink 
when polled

2. Configure the 
devices that are 
attached to the 
IDNAC Power 
Supply.

Figure 6-10. IDNAC - Point Editing Tab

3.  Depending on the selected device, enter the required information in the Properties section. 
Consult Chapter 7 for the details on how to edit points for TrueAlert devices. 

• ISO: Custom label
• Repeater: Custom label, Depleted battery cutout, Repeater operation (Class B Spur, 

Class A Spur, Class A Loop)
• DCAI: Custom label, Loop 1 address (filled by the programmer)
• Loop 2 address: Unused, need to be assigned by the person programming the panel
• Custom Label
• TrueAlertES Appliances: AV (Audible/Visual), VO (Visual Only), AO (Audible Only)
• TrueAlert Appliances: STRB, Horn, A/V, ASTRB

Editing the IDNET 
Multiloop

The IDNet Multiloop can contain up to 250 points. The card has three main tabs to edit. The 
Card Properties tab, the Point Editing tab, and the Loop Editing tab. 

To edit the Card Properties tab: 
1. Enter the card’s custom label. This label should make the card easily identifiable. 
2. Click in the box beside the following functions to activate them:

• Only activate TrueAlarm device LEDs
• Activate Signal IAM LEDs

The following fields in the tab are filled by the programmer and cannot be edited:
• Card address
• Card description
• Card default label
• Annunciator address
• Unit number
• Box number
• Bay number 
• Location
• Total of configured points
• Total of available points
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Editing the IDNET 
Multiloop

To edit the IDNet Point Editing tab 
(Figure 6-11): 

The Point Editing tab is used to define 
the points on the IDNet loop. Once the 
Verification points are defined, they 
must be associated to a zone. The other 
types of points can also be associated to 
a zone, but it is not mandatory.
1. Select an IDNet point to configure in 

the table.
2. Assign a device type to the IDNet 

point.
3. Assign a point type to the IDNet 

point.
4. Enter a custom label. This label 

should make the IDNet point easily 
identifiable.

Figure 6-11. IDNet Multiloop - Point Editing Window

5. Tag the IDNet point to a Zone by clicking on Zone List. The TagList window is displayed 
(Figure 6-12).

a. Scroll through the list and select the zone to populate. 

b. Press the space key. A “>>” symbol appears to the left of each point to indicate that it is 
selected.

Figure 6-12. TagList Window
6. Click OK. If an error message is displayed, click OK and make the appropriate 

modifications.

7. Click Apply > OK to confirm the edits. 

To edit the Loop Editing tab 
(Figure 6-13)

The Loop Editing tab is used to define 
the loops on the IDNet Multiloop card. 
To edit the loops, follow the same steps 
as for the Point Editing tab, but skip 
step 3, since there is no point type for 
loops.

Figure 6-13. IDNet Multiloop - Loop Editing Window
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Editing the NAC 
Power Supply

The NAC Power Supply is part of the 4007ES Hybrid Hardware Configuration. The card has 
four main tabs to edit. The Card Properties tab, the Data Entry tab, the NACs tab, and the 
AuxNAC tab.

To edit the Card Properties tab: 

1. Enter the card’s custom label. This label should make the card easily identifiable. 
The following fields in the tab are filled by the programmer and cannot be edited:

• Card address
• Card description
• Card default label
• Annunciator address
• Unit number
• Box number
• Bay number 
• Location

To edit the Data Entry tab (Figure 6-14): 
1. Configure the Depleted Battery Cutout option. If selected, the power supply card shuts itself 

off after detecting a depleted battery condition when no AC power is present. If this option is 
selected, a jumper must be installed on the power supply (on S527), for Canadian operation. 
It is unselected by default.

2. Select the optional cards that are connected to the power supply card. The choices are: 
• None
• City Connect
• Relay

3. Select the NAC options for the wiring. The choices are: 
• 4 Class B
• 4 Class A

4. Click in the Wheelock Devices (Code 3) box if ONLY Wheelock device are used with the 
FACP. 

5. Click in the 25V Regulator box if a 25V regulator card is used with the FACP. 
6. Click Apply > OK to confirm the edits. 

.

Figure 6-14. NAC - Data Entry Tab
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Editing the NAC 
Power Supply

To edit the NACs tab (Figure 6-15): 

1. Select a circuit to configure in the table. 

Figure 6-15. NAC - NACs Tab

2. Select a point type from the Point Type drop-down list.

3. Enter a custom label.This label should make the point easily identifiable.

4. Select the EOL resistance from the EOL Resistance drop-down list.

5. Click Apply > OK to confirm the edits.

To edit the AuxNAC tab (Figure 6-16): 
1. Select a circuit to configure in the table.

Figure 6-16. NAC - AuxNAC Tab

2. Select a point type from the Point Type drop-down list.

3. Enter a custom label. This label should make the point easily identifiable.

4. Click Apply > OK to confirm the edits.
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Editing the Zone/
Relay Card

The 4007-9801 Zone/Relay card allows monitoring of up to eight Class B zones or four Class 
A zones, or control up to eight relay contacts. Up to four cards can be used. The card has two 
main tabs to edit. The Card Properties tab and the Point Editing tab. 

To edit the Card Properties tab: 

1. The panel assigns an address when a Zone/Relay card is added. Set the card address to match 
the programmer assigned address. 

2. Enter the card’s custom label. This label should make the card easily identifiable. 

3. Select the location for each Zone/Relay card. By default, the selected block is F (bottom left 
corner). The other choices are block E, block G, and block H. 

The following fields in the tab are filled by the programmer and cannot be edited:
• Card description
• Card default label
• Annunciator address
• Unit number
• Box number
• Bay number 

To edit the Point Editing tab (Figure 6-17): 

1. Select the device type. The choices are: 

• MONA Class A Monitoring Device
Note: If MONA is selected for a point, a confirmation window is displayed explaining that the next point is 

reserved for the system and the next point’s device type, point type, and labels change automatically 

change. These fields then become non-editable.

• MONB Class B 
Monitoring Device 

• Relay device 

2. Select the point type.

3. Enter the card’s custom 
label. This label should 
make the card easily 
identifiable.

4. Select the EOL resistance 
from the EOL Resistance 
drop-down list.

5. Click Apply > OK to 
confirm the edits. 

Figure 6-17. Zone / Relay Card / Point Editing Tab

6. Tag each point to a Zone by clicking on Zone List. The TagList window is displayed (Figure 
6-12).

a. Scroll through the list and select the zone to populate. 

b. Press the space key. A “>>” symbol appears to the left of the point to indicate that it is 
selected. Click OK. If an error message is displayed, click OK and make the 
appropriate modifications.

7. Click Apply > OK to confirm the edits. 
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Editing the Zone/
Relay Card

Auto Fill Window (Figure 6-18)

The auto fill function allows you to fill up the information for one point and then use this 
information to automatically fill the information for the other points. To invoke this function, 
select a point in the Point Editing tab grid and press F4. The Auto Fill window appears. 
The following fields in the Auto Fill window are pre-filled with the values from the highlighted 
point (from the Point Editing tab):

• All
• Point Forward
• Selected

1. Select to which point you want to apply the auto fill from the Auto Fill drop-down menu. 
The choices are:

• All (programmer changes all the points on the card to match the auto fill selection)

• Point Forward (programmer changes the highlighted point and all subsequent points on 
the card to match the auto fill selection)

• Selected (programmer changes the highlighted point to match the auto fill selection)

2. To apply the same 
custom label to other 
points, check the 
Custom Label check 
box.

3.  To add an 
identification number 
after the label, check 
the Automatically 
increment last number 
in custom labels check 
box.

4. The following fields 
are grayed out:

• Reference 
Address

• Coding Type

• Candela Rating

• Mode
Figure 6-18. Zone / Relay Point Editing - Auto Fill Window

5. Click on OK to confirm the edits.

Note: If the point selected is a MONA, the Auto Fill affects only the primary points (1, 3, 5, or 7) for the 
custom label since the second points (2, 4, 6, or 8) are reserved. However, if the Alt Custom Label is 
checked, both the first and the second point of a MONA are affected. 
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Editing the Serial 
DACT Card Per 
Point

The 4007-9806 serial DACT interface card can be programmed per point or by event. 
The 4007-9806 serial DACT per point has six main tabs to edit. The Card Properties tab, the 
Basics tab, the Event Codes tab, the Local Points tab, the Point Types tab, and the Points tab.

To edit the Card Properties tab per point: 

1. The panel assigns an address when a DACT card is added. Set the card address to match the 
programmer assigned address.

2. Enter the card’s custom label. This label should make the card easily identifiable. 
3. Select a card address, from 0 to 31.
The following fields in the tab are filled by the programmer and cannot be edited:

• Card description
• Card default label
• Annunciator address
• Box number
• Bay number 
• Location

To edit the Basics tab (Figure 6-19): 
The Basics tab can be used to set up the basic communication information of the DACT to 
DACR link. The following fields in the tab can be edited:

• Phone and Account Numbers

- Primary (1)#

- Secondary (2)#

- Account (1)#
- Account (2)#

• Central Station Line #
• Dial Mode

- Tone
- Pulse
- Tone else Pulse

• Miscellaneous
- Report AC Failure Delay
- Test Report Time
- Send Unmapped Points
- IP Communicator

Figure 6-19. DACT Card - Basics Tab

• Central Station Email Address. Check the box to enter an email address and the .CSV 
file is automatically sent to Central Station. Automatic email can only be used with Per 
Point DACTs and must be set up in advance with Central Station.

To edit the Event Codes tab (Figure 6-20):
The Event Codes tab allows you to edit the 
event codes associated with each of the 
4007ES Panel point types. 
1. Click on the Point Types drop-down list box 

and select the point type whose event codes 
needs to be changed. (The Next and 
Previous buttons allow you to scroll 
through the list without clicking on the 
drop-down list box.)

2. Click on the Enable Edit checkbox at the 
top left of the window.

3. A warning window appears. Click on Yes. 
Figure 6-20. DACT - Event Codes Tab

Note: Do not edit event codes without prior authorization and direction from the central station.

4. The non-editable fields remain grayed out. Define the appropriate event codes for both the 
Event and the Restoral columns.

5. Click Apply > OK to confirm the edits.
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Editing the Serial 
DACT Card

To edit the Local Points tab (Figure 6-21):

The Local Points tab allows you to edit the local points associated with each of the 4007ES 
Panel point types. 
1. Click on the Enable Edit checkbox at the 

top right of the window.

2. A warning window appears. Click on Yes. 

Note: Do not edit local points without prior 
authorization and direction from the central 
station.

3. The non-editable fields remain grayed out. 
Define the appropriate local points for 
both the Event and the Restoral columns.

4. Click Apply > OK to confirm the edits.

Figure 6-21. DACT - Local Point Tab

To edit the Point Types tab (Figure 6-22):

The Point types tab allows you to add new point types, delete, or edit existing point types. 

To edit an existing point:
1. Click on a point in the grid. 

2. Edit the appropriate fields for 
both the Event and the 
Restoral columns.

3. Edit the SDACT point type 
name and the SDACT point 
type description if necessary. 

4. Click Apply to confirm the 
edits

To delete an existing point:
1. Click on a point in the grid.

2. Click on Delete.

3. Click on Apply to confirm 
the edits.

Figure 6-22. DACT - Point Types Tab

To add a point:
1. Click on Add.

2. Edit the SDACT point type name and the SDACT point type description. These labels 
should make the points easily identifiable. 

3. Edit the appropriate fields for both the Event and the Restoral columns.

4. Click Apply > OK to confirm the edits.

Note: Do not edit local points without prior authorization and direction from the central station.
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Editing the Serial 
DACT Card

To edit the Points tab (Figure 6-23):
1. To edit a point, click on the point or use the up and down arrow with the <space bar> to 

toggle point selection.

2. Depending on the point, edit the fields as necessary. The non-editable fields remain grayed 
out.

Figure 6-23. DACT - Points Tab

Editing the Event 
DACT Card

The 4007-9806 DACT “per event” has five main tabs. To edit the Card Properties tab, the 
Basics tab, the Event Codes tab, the Local Points tab, and the Points tab.

To edit the Card Properties tab per event: 

1. The panel assigns an address when a DACT card is added. Set the card address to match the 
programmer assigned address.

2. Enter the card’s custom label. This label should make the card easily identifiable. 

3. Select a card address, from 0 to 31.

The following fields in the tab are filled by the programmer and cannot be edited:
• Card description
• Card default label
• Annunciator address
• Box number
• Bay number 
• Location
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Editing the Event 
DACT Card

To edit the Basics tab (Figure 6-24): 
The Basics tab can be used to set up the basic communication information of the DACT to 
DACR link. The following fields in the tab can be edited:

• Phone and Account Numbers
- Primary (1)#
- Secondary (2)#
- Account (1)#
- Account (2)#

• Central Station Line #
• Communications Format

- SIA
- 3/1
- 4/2
- BFSK

• Pulse Communication Format (available when 3/1, 4/2 or BFSK is selected)
- Format rate 10 PPS or 20 PPS
- Communication Format Frequency 1.9KHz Data/1.4KHz ACK or 1.8KHz Data/

2.3KHz ACK 
• Dual Mode

- Tone
- Pulse
- Tone else Pulse

• Miscellaneous
- Report AC Failure Delay
- Test Report Time
- Send Unmapped Points
- IP Communicator

:

Figure 6-24. DACT Event Reporting - Basics Tab

To edit the Event Codes tab (Figure 6-20):
1. Select the Enable Edit checkbox.

2. A warning window appears. Click on Yes. 

Note: Do not edit local points without prior authorization and direction from the central station.

3. Define the appropriate local points for both the Event and the Restoral columns.

4. Click Apply > OK to confirm the edits.
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Editing the Event 
DACT Card

The Local Points tab allows you to edit the local points associated with each of the 4007ES 
Panel point types. 

To edit the Local Points tab (Figure 6-21):
1. Select the Enable Edit checkbox at the top right of the window.

2. A warning window appears. Click on Yes. 

Note: Do not edit local points without prior authorization and direction from the central station.

3. Define the appropriate local points for both the Event and the Restoral columns.

4. Click Apply > OK to confirm the edits.

To edit the Points tab (Figure 6-23):
1. To edit a point, click on the point or use the up and down arrow with the <spacebar> to 

toggle point selection.

2. Depending on the point, edit the fields as necessary. The non-editable fields remain grayed 
out.

48-LED Module The 48-LED Module has two main tabs to configure. The Card Properties tab and the Point 
Editing tab.

To edit the Card Properties tab: 

1. Enter a card address for the 48-LED Module.

2. Enter the card’s custom label. This label should make the card easily identifiable. 

The following fields in the tab are filled by the programmer and cannot be edited:
• Card description
• Card default label
• Annunciator address
• Unit number
• Box number
• Bay number 
• Location
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48-LED Module To edit the Point Editing tab: 
From the Point Editing tab, two view choices are available.
High Level Modes: organizes the LEDs in pairs. Under this view, the Mode options are more 
limited:

• OO | On/Off
• TO | Trouble/On

Low Level Modes: shows each LED as individually configurable. 

Figure 6-25. 48-LED Module High Level

Figure 6-26. 48-LED Module Low Level
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48-LED Module In High Level Mode:
1. Select a column and then a point that needs to be edited. LED pairs are yellow and red. 

2. Select the Mode from the Mode drop-down list. Under this mode, only three options are 
available. If an error is detected, a red “X” is displayed in the HW Ref column. Pass the 
mouse over the row to display the tool tip describing the problem.

• OO : On/Off

• TO: Trouble On

3. Create Reference Address for the points by pressing F9. 

• Select an address from the table. Scroll through the list and press the space key to 
select an address. A “>>” symbol appears indicate that it is selected.

4. Enter a point custom label. This label should make the point easily identifiable.

5. When editing the 8 points of the Display Column 6, LED pairs can be either yellow/red or 
yellow/green. 

6. Repeat for each point that needs to be edited.

In Low Level Mode:
1. Select a column and then a point that needs to be edited. Point type: 

• For the even-numbered points 2 through 40, the default LED point type is LEDRED. 

• For the odd-numbered points 1 through 39, the default LED point type is 
LEDYELLOW.

2. Select the Mode from the Mode drop-down list.

3. Create Reference Address for the points by pressing F9. 

• Select an address from the table. Scroll through the list and press the space key to 
select an address. A “>>” symbol appears indicate that it is selected.

4. When editing the 8 points of the Display Column 6: 

• For the even-numbered points, the default LED point type is LEDRED. The address of 
the point depends on the LED point type selected. The point type can be changed to 
LED green.

• For the odd-numbered points, the default LED point type is LEDYELLOW. 
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Chapter 7.
Editing TrueAlert Devices Properties

Introduction  TrueAlert devices are edited through the Point Editing tab on the IDNAC Power Supply.

To access this tab:

1. Go to the Hardware Configuration window.

2. Double click on the IDNAC Power Supply icon.

3. Click on the Point Editing tab.
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Point Editing for TrueAlert Device

TrueAlert ES AO 
Appliance Point 
Editing

Use this device type to edit TrueAlert ES Audible Only (AO) appliances.

The following editing options are available for this appliance:
Table 7-1. TrueAlert ES AO Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming.

Available 
settings:

• Indoor

• Weatherproof UL

• Weatherproof ULC

Horn Type Broadband Multitone

Tone BROADBAND BROADBAND, 250 HZ, BELL, SLOW WHOOP, SIREN, HILO, 
CHIME, HARDWARE

Coding Type Select the Coding Type to set the cadence of the audible signal.

System 
Default

This sets the coding to the value determined in the System Option 
tab.

Temporal A three-pulse coding pattern consisting of three ½ second pulses, 
each separated by a ½ second silence. Each three pulse group is 
separated by 1 ½ seconds of silence. Pattern repeats until alarm 
silence.

March 20 A coded signal that uses 20 beats per minute. Each beat consists of 
1 ½ second pulse on, 1 ½ second off. Pattern repeats until alarm 
silence.

March 60 A coded signal that uses 60 beats per minute. Each beat consists of 
½ second pulse on, ½ second off. Pattern repeats until alarm 
silence.

March 120 A coded signal that uses 120 beats per minute. Each beat consists 
of ¼ second pulse on, ¼ second off. Pattern repeats until alarm 
silence.

On Steady On steadily.

Temporal 4 A CO gas warning that is a repeated sequence of four cycles of 100 
msec on with 100 msec off, followed by 5 seconds off.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must be set 
to Panel.

Low To use this option the appliance's configuration control must be set 
to Panel.

Hardware Selecting this option sets the appliance to the setting indicated on 
the appliance's configuration switch or jumper.

Note: The "Copy/Paste/ Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES VO 
Appliances Point 
Editing

Use this device type to edit TrueAlert ES Visual Only (VO) appliances.
The following editing options are available for this appliance:

Table 7-2. TrueAlert ES VO Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

Available candela 
options: 

System Default. Sets the candela value to the one selected in 
the System Option tab.

15 candela 

30 candela 

75 candela

110 candela

135 candela

185 candela

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

• Weatherproof UL. 

Available candela 
options: 

System Default. Sets the candela value to the one selected in 
the System Option tab.

15 candela 

75 candela 

WP 75 candela 

WP 185 candela 

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

• Weatherproof ULC. 

Available candela 
options: 

System Default. Sets the candela value to the one selected in 
the System Option tab.

20 candela 

30 candela 

75 candela 

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

Operation Select the type of operation the appliance will signal. 

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular VNAC 
and that the VNAC must be specified by the user. 

Mounting Select the mounting location of the appliance: wall-mounted or ceiling-mounted.

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style. 

Note: The "Copy/Paste/ Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES    
VO-H Appliances 
Point Editing

Use this device type to edit TrueAlert ES Visual Only High Candela (VO-H) appliances.
The following editing options are available for this appliance:

Table 7-3. TrueAlert ES VO-H Point Editing Options

Option Description

Custom Label This field is used to describe the appliance's function, location, or other descriptive 
information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

Available candela 
options: 

System Default. Selecting this option sets the candela value to 
the one selected in the System Option tab.

110 candela

135 candela

185 candela

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

Operation Select the type of operation the appliance will signal. 

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular VNAC 
and that the VNAC must be specified by the user. 

Mounting Only a ceiling-mounted appliance is allowed.

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style. 

Note: The "Copy/Paste/ Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES VO-L 
Appliances Point 
Editing

Use this device type to edit TrueAlert ES Visual Only LED Strobe (VO-L) appliances.
The following editing options are available for this appliance:

Table 7-4. TrueAlert ES VO-L Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

• Weatherproof UL/
ULC. 

Available candela 
options: 

System Default. Selecting this option sets the candela value to 
the one selected in the System Option tab.

15 candela

30 candela

75 candela

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

Operation Select the type of operation the appliance will signal. 

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular VNAC 
and that the VNAC must be specified by the user. 

Mounting Only a wall-mounted appliance is allowed.

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style. 

Note: The "Copy/Paste/ Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES    
VO-LH 
Appliances Point 
Editing

Use this device type to edit TrueAlert ES Visual Only LED Strobe High Candela (VO-LH) 
appliances. The following editing options are available for this appliance:

Table 7-5. TrueAlert ES VO-LH Point Editing Options

Option Description

Custom Label This field is used to describe the appliance's function, location, or other descriptive 
information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

• Weatherproof UL/
ULC. 

Available candela 
options: 

System Default. Selecting this option sets the candela value to 
the one selected in the System Option tab.

110 candela

135 candela

175 candela

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

Operation Select the type of operation the appliance will signal. 

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular VNAC 
and that the VNAC must be specified by the user. 

Mounting Only a wall-mounted appliance is allowed.

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style. 

Note: The "Copy/Paste/ Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES AV 
Appliance Point 
Editing

Use this device type to edit TrueAlert ES Audible/Visual (AV) appliances. The following 
editing options are available for this appliance:

Table 7-6.TrueAlert ES AV Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

• Available candela 
options: 

System Default. Selecting this option sets the candela value 
to the one selected in the System Option tab.

15 candela 

30 candela 

75 candela

110 candela

135 candela

185 candela

Hardware. Selecting this option sets the appliance to the 
setting indicated on the appliance's configuration switch or 
jumper. 

• Weatherproof UL. 

• Available candela 
options: 

System Default. Sets the candela value to the one selected in 
the System Option tab.

15 candela 

75 candela 

WP 75 candela 

WP 185 candela 

Hardware. Selecting this option sets the appliance to the 
setting indicated on the appliance's configuration switch or 
jumper. 

• Weatherproof 
ULC. 

• Available candela 
options: 

System Default. Selecting this option sets the candela value 
to the one selected in the System Option tab.

20 candela 

30 candela 

75 candela 

Hardware. Selecting this option sets the appliance to the 
setting indicated on the appliance's configuration switch or 
jumper. 

Continued on next page.
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TrueAlert ES AV 
Appliance Point 
Editing

Table 7-6. TrueAlert ES AV Point Editing Options, Continued

Option Description

Operation Select the type of operation the appliance will signal. 

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular 
VNAC and that the VNAC must be specified by the user. 

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style. 

Horn Type Broadband Multitone

Tone BROADBAND BROADBAND, 520 HZ, BELL, SLOW WHOOP, SIREN, 
HILO, CHIME, HARDWARE

Coding Type Select the Coding Type to set the cadence of the audible signal.

System Default This sets the coding to the value determined in the System 
Option tab.

Temporal A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three 
pulse group is separated by 1 ½ seconds of silence. Pattern 
repeats until alarm silence.

March 20 A coded signal that uses 20 beats per minute. Each beat 
consists of 1 ½ second pulse on, 1 ½ second off. Pattern 
repeats until alarm silence.

March 60 A coded signal that uses 60 beats per minute. Each beat 
consists of ½ second pulse on, ½ second off. Pattern repeats 
until alarm silence.

March 120 A coded signal that uses 120 beats per minute. Each beat 
consists of ¼ second pulse on, ¼ second off. Pattern repeats 
until alarm silence.

On Steady On steadily.

Temporal 4 A CO gas warning that is a repeated sequence of four cycles 
of 100 msec on with 100 msec off, followed by 5 seconds off.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must 
be set to Panel.

Low To use this option the appliance's configuration control must 
be set to Panel.

Hardware Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper.

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES AV-H 
Appliance Point 
Editing

Use this device type to edit TrueAlert ES Audible/Visual High Candela (AV-H) appliances. The 
following editing options are available for this appliance:

Table 7-7.TrueAlert ES AV-H Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

• Available candela 
options: 

System Default. Selecting this option sets the candela value 
to the one selected in the System Option tab.

110 candela

135 candela

185 candela

Hardware. Selecting this option sets the appliance to the 
setting indicated on the appliance's configuration switch or 
jumper.

Operation Select the type of operation the appliance will signal.

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular 
VNAC and that the VNAC must be specified by the user. 

Mounting Only a ceiling-mounted appliance is allowed

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style.

Horn Type Broadband Multitone

Tone BROADBAND BROADBAND, 520 HZ, BELL, SLOW WHOOP, SIREN, 
HILO, CHIME, HARDWARE

Continued on next page.
7-9



4007ES Panel Programmer Manual (579-1167)
Point Editing for TrueAlert Device, Continued

TrueAlert ES AV-H 
Appliance Point 
Editing

Table 7-7. TrueAlert ES AV-H Point Editing Options, Continued

Option Description

Coding Type Select the Coding Type to set the cadence of the audible signal.

System Default This sets the coding to the value determined in the System 
Option tab.

Temporal A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three 
pulse group is separated by 1 ½ seconds of silence. Pattern 
repeats until alarm silence.

March 20 A coded signal that uses 20 beats per minute. Each beat 
consists of 1 ½ second pulse on, 1 ½ second off. Pattern 
repeats until alarm silence.

March 60 A coded signal that uses 60 beats per minute. Each beat 
consists of ½ second pulse on, ½ second off. Pattern repeats 
until alarm silence.

March 120 A coded signal that uses 120 beats per minute. Each beat 
consists of ¼ second pulse on, ¼ second off. Pattern repeats 
until alarm silence.

On Steady On steadily.

Temporal 4 A CO gas warning that is a repeated sequence of four cycles 
of 100 msec on with 100 msec off, followed by 5 seconds off.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must 
be set to Panel.

Low To use this option the appliance's configuration control must 
be set to Panel.

Hardware Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper.

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES AV-L 
Appliance Point 
Editing

Use this device type to edit TrueAlert ES Audible/Visual LED Strobe (AV-L) appliances. The 
following editing options are available for this appliance:

Table 7-8.TrueAlert ES AV-L Point Editing Options

Option Description

Custom Label This field is used to describe the appliance's function, location, or other descriptive 
information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

• Weatherproof UL/
ULC

 Available candela 
options: 

System Default. Selecting this option sets the candela value 
to the one selected in the System Option tab.

15 candela

30 candela

75 candela

Hardware. Selecting this option sets the appliance to the 
setting indicated on the appliance's configuration switch or 
jumper.

Operation Select the type of operation the appliance will signal.

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular 
VNAC and that the VNAC must be specified by the user. 

Mounting Only a wall-mounted appliance is allowed.

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style.

Horn Type Broadband

Tone BROADBAND

Continued on next page.
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TrueAlert ES AV-L 
Appliance Point 
Editing

Table 7-8. TrueAlert ES AV-L Appliance Point Editing, Continued

Option Description

Coding Type Select the Coding Type to set the cadence of the audible signal.

System Default This sets the coding to the value determined in the System 
Option tab.

Temporal A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three 
pulse group is separated by 1 ½ seconds of silence. Pattern 
repeats until alarm silence.

March 20 A coded signal that uses 20 beats per minute. Each beat 
consists of 1 ½ second pulse on, 1 ½ second off. Pattern 
repeats until alarm silence.

March 60 A coded signal that uses 60 beats per minute. Each beat 
consists of ½ second pulse on, ½ second off. Pattern repeats 
until alarm silence.

March 120 A coded signal that uses 120 beats per minute. Each beat 
consists of ¼ second pulse on, ¼ second off. Pattern repeats 
until alarm silence.

On Steady On steadily.

Temporal 4 A CO gas warning that is a repeated sequence of four cycles 
of 100 msec on with 100 msec off, followed by 5 seconds off.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must 
be set to Panel.

Low To use this option the appliance's configuration control must 
be set to Panel.

Hardware Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper.

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert ES     
AV-LH Appliance 
Point Editing

Use this device type to edit TrueAlert ES Audible/Visual LED Strobe High Candela (AV-LH) 
appliances. The following editing options are available for this appliance:

Table 7-9.TrueAlert ES AV-LH Point Editing Options

Option Description

Custom Label This field is used to describe the appliance's function, location, or other descriptive 
information.

Alternate Label This field is used to enter an alternative description of the appliance.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

• Weatherproof UL/
ULC

 Available candela 
options: 

System Default. Selecting this option sets the candela value 
to the one selected in the System Option tab.

110 candela

135 candela

185 candela

Hardware. Selecting this option sets the appliance to the 
setting indicated on the appliance's configuration switch or 
jumper.

Operation Select the type of operation the appliance will signal.

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. The “alarm/alert” switch on the device must 
be set to "Alarm". 

Other When this mode is selected the user is confirming that the 
strobe does not have a default assignation to a particular 
VNAC and that the VNAC must be specified by the user. 

Mounting Only a wall-mounted appliance is allowed.

Candela Select the candela output of the appliance. The selection varies according to the 
appliance style.

Horn Type Broadband

Tone BROADBAND

Continued on next page.
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TrueAlert ES AV-
LH Appliance 
Point Editing

Table 7-9. TrueAlert ES AV-LH Appliance Point Editing, Continued

Option Description

Coding Type Select the Coding Type to set the cadence of the audible signal.

System Default This sets the coding to the value determined in the System 
Option tab.

Temporal A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three 
pulse group is separated by 1 ½ seconds of silence. Pattern 
repeats until alarm silence.

March 20 A coded signal that uses 20 beats per minute. Each beat 
consists of 1 ½ second pulse on, 1 ½ second off. Pattern 
repeats until alarm silence.

March 60 A coded signal that uses 60 beats per minute. Each beat 
consists of ½ second pulse on, ½ second off. Pattern repeats 
until alarm silence.

March 120 A coded signal that uses 120 beats per minute. Each beat 
consists of ¼ second pulse on, ¼ second off. Pattern repeats 
until alarm silence.

On Steady On steadily.

Temporal 4 A CO gas warning that is a repeated sequence of four cycles 
of 100 msec on with 100 msec off, followed by 5 seconds off.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must 
be set to Panel.

Low To use this option the appliance's configuration control must 
be set to Panel.

Hardware Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper.

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
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ISO Options Use this device type to edit TrueAlert Isolators. The following editing options are available for 
this device:

Repeater Options Use this device type to edit Repeaters.

The 4009 IDNAC Repeater is a TrueAlert ES Addressable device that extends the maximum 
wiring distance supported by the IDNAC Signaling Line Circuit (SLC). Consult the 4009 
IDNAC Repeater manual 579-1019 for more information. The following editing options are 
available for this device:

Table 7-10.TrueAlert Isolator Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Table 7-11. Repeater Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Current Draw 
(Amps)

This information is not available.

Depleted Battery 
Cutout

When this option is selected the Repeater shuts itself off after detecting a depleted 
battery condition when no AC power is present. This option is de-selected by default.

Repeater 
Operation

Select the option that corresponds to the Repeater’s wiring style.

• For local Class B Wiring select "Class B Spur" 

• For local Class A Loop Wiring select "Class A Spur" 

• For extended Class A Loop Wiring select "Class A Loop" 
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DCAI Options Use this device type to edit DCAI cards.

Note: A warning appears if the number of DCAI cards added to the Point Editing table does not correspond 
to the number of cards added to the job.

The 4100-6103 Dual Class A Isolator (DCAI) card converts the Class B output of an IDNAC 
into two isolated Class A outputs. Consult the DCAI manual 579-1029 for more information. 
The following editing options are available for this device:

TrueAlert STRB 
Appliances Point 
Editing

Use this device type to edit TrueAlert Strobe (STRB) appliances. The following editing options 
are available for this appliance:

Table 7-12. DCAI Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Loop 1 Address The Loop 1 Address is automatically set by the programmer. 

Loop 2 Address This virtual address does not need to be adjacent to the loop 1 hardware address. 

Table 7-13. TrueAlert STRB Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Style Select the Style that corresponds to the appliance or device you are programming. 

• Indoor. 

Available candela 
options: 

System Default. Sets the candela value to the one selected in 
the System Option tab.

15 candela 

30 candela 

75 candela

110 candela

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

Operation Select the type of operation the appliance will signal. 

General Evac. The strobe is automatically associated with the “ALL VISUAL” 
VNAC by default. 

Candela Select the candela output of the appliance. 

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
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TrueAlert Horn 
Appliance Point 
Editing

Use this device type to edit TrueAlert Horn appliances. The following editing options are 
available for this appliance:

Table 7-14. TrueAlert Horn Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Style Select the Indoor Style

Coding Type Select the Coding Type to set the cadence of the audible signal.

System 
Default

This sets the coding to the value determined in the System Option tab.

Temporal A three-pulse coding pattern consisting of three ½ second pulses, 
each separated by a ½ second silence. Each three pulse group is 
separated by 1 ½ seconds of silence. Pattern repeats until alarm 
silence.

March 60 A coded signal that uses 60 beats per minute. Each beat consists of ½ 
second pulse on, ½ second off. Pattern repeats until alarm silence.

March 120 A coded signal that uses 120 beats per minute. Each beat consists of 
¼ second pulse on, ¼ second off. Pattern repeats until alarm silence.

On Steady On steadily.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must be set to 
Panel.

Low To use this option the appliance's configuration control must be set to 
Panel.

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
7-17



4007ES Panel Programmer Manual (579-1167)
Point Editing for TrueAlert Device, Continued

TrueAlert A/V 
Appliances Point 
Editing

Use this device type to edit TrueAlert Strobe Audible/Visual (A/V) appliances. The following 
editing options are available for this appliance:

Table 7-15. TrueAlert AV Point Editing Options

Option Description

Custom Label This field can be used to describe the appliance's function, location, or other 
descriptive information.

Style Select the Style that corresponds to the appliance or device you are programming. 

Indoor. 

Available candela 
options: 

System Default. Sets the candela value to the one selected in 
the System Option tab.

15 candela 

30 candela 

75 candela

110 candela

Hardware. Selecting this option sets the appliance to the setting 
indicated on the appliance's configuration switch or jumper. 

Operation The strobe and horn appliances is automatically associated respectively with the “ALL 
VISUAL” and "ALL AUDIBLE" VNAC by default. 

Candela Select the candela output of the appliance. 

Coding Type Select the Coding Type to set the cadence of the audible signal.

System Default This sets the coding to the value determined in the System 
Option tab.

Temporal A three-pulse coding pattern consisting of three ½ second 
pulses, each separated by a ½ second silence. Each three 
pulse group is separated by 1 ½ seconds of silence. Pattern 
repeats until alarm silence.

March 60 A coded signal that uses 60 beats per minute. Each beat 
consists of ½ second pulse on, ½ second off. Pattern repeats 
until alarm silence.

March 120 A coded signal that uses 120 beats per minute. Each beat 
consists of ¼ second pulse on, ¼ second off. Pattern repeats 
until alarm silence.

On Steady On steadily.

Volume Set the appliance volume:

High To use this option the appliance's configuration control must be 
set to Panel.

Low To use this option the appliance's configuration control must be 
set to Panel.

Note: The "Copy/Paste/Special Paste" feature can be used to configure multiple devices identically. 
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Chapter 8.
Viewing, Adding, and Editing Lists

Introduction A list is a group of similar points, sharing a common name, that can be monitored or 
controlled as if they were a single point. For example, when you use a switch to turn on a list 
populated with control points, all of the points in the list turn on. 
The 4007ES FACP includes the following types of lists.

• Automatically Generated, Read-Only System Lists. These lists are created based 
on the point type assigned to the point. Points cannot be manually added or deleted 
from these lists. 

• Automatically Generated, Editable System Lists. These are lists created based on 
the point types you assign to the point. These lists are only editable after the automatic 
list generation property is turned off for the list.

• User-Defined Lists. Switches, LEDs, and Custom Control equations all make use of 
these types of lists. Switches typically control lists made up of control points (relays), 
or standard NACs (horns/strobes). LEDs can be programmed to monitor a list and 
turn ON when any point in the list activates. Custom Control equations typically use 
lists of monitor points to indicate when a specific output action should occur, and the 
points affected by the output action are typically specified in a user-defined list of 
control points.

• Zone Lists. This option allows you to create up to 512 lists grouping together points 
in one defined zone.

This chapter describes the programming of the four list categories, General Lists, WalkTest 
Lists, Latching Supv Verification Lists, and Elevator Recall Lists, used by the Panel FACP.
Note: The Alarm Verification Tab can still be accessed through the List Tab, but it cannot be used. 

For information on using lists for the Install Mode feature, consult the 4007ES Operator’s 
Manual (579-1165).
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List Tab Select the List Tab to display the List Tab window. By default when you select the List Tab, the 
General List subtab, located on the bottom left of the window, is selected. This window 
contains an entry for every list in the system. 
The subtabs running across the bottom of the window allow you to display only the lists 
associated with a specific system category. For example, clicking on the alarm verification 
subtab displays only the lists associated with alarm verification.

Sort Function The Sort function allows you to sort and display lists in ascending or descending order based 
on list-specific criteria (the criteria shown in the Sort Dialog is different for each type of list). 
To sort lists, do one of the following:

Figure 8-1. Sort Window

• Press F5 function key. When the Sort Dialog (shown above) appears, click on the 
Column drop-down list box to select the criteria to use for the sort operation. Next, 
select whether the sort should be in Ascending or Descending order and click on OK.

• Click on a column title. Clicking on one of the column titles in the List Tab window 
automatically sorts the list in descending order. Clicking on the same column title 
again sorts the lists in ascending order. 

• Right click in the list window. Right Click in the list window. When the list of options 
appears, select Sort. Click on the Column drop-down list box to select the criteria to 
use for the sort. Next, select whether the sort should be in Ascending or Descending 
order and click on OK.

Custom Label 
Spell Check

Spell Check allows you to validate the spelling of custom labels. Using Spell Check, 
incorrectly spelled words can be automatically corrected or suggested alternatives can be 
substituted.
1. Position the pointer in the point list and press the F7 button. (Alternatively, you can right-

click in the List window and select Spell Check when the list of options appears.)

2. Correct the misspelled word in any of the following ways. (Use the Ignore and Ignore All 
buttons to ignore the misspelled word.)

• Click on the Change or Change All button to accept the suggested spelling in the 
“Change to” field.

• Type the correct spelling in the “Change to” field and press the Change or Change All 
button. 

• Scroll through the Suggestions drop-down list, click on one of the entries, and then 
click on the Change or Change All field.

The Search and Find functions allow you to specify a specific search criteria (such as a specific 
custom label) and then search the List Window for the selected data. 
1. Position the pointer in the List Window and press the CTRL + F key combination. 

(Alternatively, you can right click in the List Window and select Search or Find from the list 
that appears.)

2. Enter the Search text in the Search What field. Click on the Search in Column field and 
select the column in which to search. Click on Search Next to start the search. 

3. Press the F3 key to continue searching the List Window for another occurrence of the item 
you are searching.
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Managing Points Default custom control programming within the system automatically adds points to system 
lists based on their point type, a process known as auto list generation, or autogen. For 
example, adding a signal point with the SSIGNAL point type automatically adds the point to 
system list L8, Fire Alarm Points Off on Silence.
In some applications, however, you need to turn a system list's autogen property off, so that you 
can manually move points into or out of the system list. This is particularly true when editing 
WalkTest, Latching Supv Verification, and Elevator Recall groups. 

Be aware that when working with the system lists, four icons are used to indicate the status of 
the system list.

 This symbol represents an auto-generated list with the autogen property turned on. When 
autogen is turned on, points cannot be manually moved into or out of the list.

 This symbol represents an auto-generated list whose autogen property cannot be altered. 
The list is permanently set to autogen on and cannot be edited.

 This symbol represents an auto-generated list with the autogen property turned off.

 Indicates that the list is not automatically generated.

A system list's autogen property can be turned on and off in one of two places:

• General List Tab. Clicking on the General List tab displays all lists (system and user) 
currently defined on the panel. Refer to “Turning Autogen Off and On from the 
General List Tab” for specific information on doing this.

• WalkTest, Latching Supv Verification, Elevator Recall Tabs. Each of these tabs 
displays a window that allows you to move points into the appropriate lists. Within 
each window, you can toggle the autogen property to allow points to be moved into 
and out of the lists. Refer to the specific section for information on turning off autogen 
for Latching Supv Verification, WalkTest, or elevator recall.

Turning Autogen 
Off and On from 
the General List 
Tab

1. Click on the List tab at the top of the programmer. 

2. Click on the General List subtab at the bottom of the window. 
3. Right click on the list whose autogen property you want to change. Select Properties from 

the list that appears. A dialog similar to Figure 8-2 appears.

Figure 8-2. List Properties Window
4. Click on the AutoGen field and change the setting.
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Basic Operations User-defined lists allow a range of points to be controlled (turned on or off, for example) by 
turning a switch on, or via a Custom Control command. Lists associated with LEDs allow the 
status of system attributes or components to be monitored. 

Adding a User-
Defined List

To add a general-purpose list and populate it with points:
1. Open the List Window by selecting the List Tab at the top of the Programmer. 

2. Open the TagList window by either pressing the Insert key or right clicking in the List 
Window and selecting Add List. 

3. You can select points for the list using a combination of the following three methods. When 
you select points, the TagList window adds the “>>” character to the left of the point to 
indicate that the point is tagged.

• Use the spacebar to select/deselect specific points. Click on the point you want to 
select and then press the spacebar once to tag the point; press it again to deselect the 
point.

• Click on the Tag All icon, located at the top of the TagList window. This selects every 
point in the Taglist. 

• Click on the Tag by Type dialog to tag points based on their point type or device type.

• Click on Clear All Tags (eraser) to erase all the tags.

• Click on Tags Up to sort the tagged points to the top of the list.

• Click on Sort to sort either HW Ref, Point Name, Device Type, Point Type or Custom 
Label columns in the TagList window in ascending or descending order

• Click on Filter to sort points according to predefined criteria, such as: Device Type, 
Point Type and Custom Label.

• Click on Search to look for a point in one of the five columns in the TagList window.

• Click on Help to open the ES Panel Online Help.
4. Click on the OK button in the TagList window. A dialog box appears, prompting you to 

name the list. Enter descriptive text and click on OK. 

Editing an 
Existing User-
Defined List

To edit an existing list (i.e., add additional points or delete points from the list):
1. Open the list's Tag List by either right clicking on the list and selecting Tag List from the 

menu that appears, or click on the list and press the F9 key.

2. When the tag list appears, click on the points you want to add or delete. Press the spacebar to 
toggle whether the point is tagged (included in the list) or not. Tagged points are identified 
by the “>>” to the left of the point name.

3. Click on OK to accept the changes. 
4. Edit the List Label and the Alternate List Label.
5. Press OK.
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Latching Supv 
Verification

The ES Panel's Latching Supv Verification (LVS DUCT and LVSUPV) feature activates a 
supervisory condition when a device crosses the threshold. This means that the supervisory 
condition on the panel does not clear until the point restores to normal and a system reset is 
performed. 
The ES Panel FACP supports both Domestic (United States) and Canadian versions of 
supervisory verification. Refer to “Selecting Canadian or Domestic (US) Operation” for 
information on enabling the Canadian or domestic version of alarm verification. 

Moving Points between Groups

By default, initiating devices with a latching verification point type are initially put in Supv 
Verification Group 0. 
To put points into other Supv Verification groups:
1. Open the List Window by selecting the List Tab at the top of the Programmer.
2. Click on the Latching Supv Verification tab at the bottom of the List Window.
3. Click on the Supv Verification group into which you want to move points. Right click and 

select Tag List. 
4. Use the mouse or arrow keys to highlight each point you want to move into the group. A 

point is selected when a “>>” appears to the left of the point. Repeat this step to select other 
points.

Selecting Canadian or Domestic (US) Operation

Canadian alarm verification works somewhat differently from the domestic (US) version. 
Table 8-1 shows Canadian and domestic (US) operation for the alarm verification feature.

To select Canadian or Domestic (US) operation (Figure 8-3), follow these steps:
1. Right click on one of the groups and select 

Properties. The Alarm Verification Properties 
dialog appears.

2. Click on the Alarm Verification tab.
3. Click on the drop-down list box and select 

Canadian or Domestic operation.
Note: You only need to set the Verification Timer field 

for one of the alarm verification groups. The 
programmer sets this field to the same value for 
all other groups.

Figure 8-3. Alarm Verification Properties Dialog

Table 8-1. Canadian/Domestic Operation

Type Operation

Canadian 
Operation

Retard Stage. If a point specified within one of the alarm verification lists 
enters an alarm state, the system delays the annunciation of the alarm for 15 
seconds
Reset Stage. When the 15 second timer expires, the system attempts to reset 
the initiating device for five seconds. 
Confirmation Stage. After the five second timer expires, the system 
evaluates the state of the initiating device for 10 additional seconds. After 10 
seconds, if the device is still in alarm, the system immediately annunciates the 
alarm.

Domestic 
(US) 

Operation

Retard Stage. If a point specified within one of the alarm verification lists 
enters an alarm state, the system delays the annunciation of the alarm for 30 
seconds
Reset Stage. When the timer expires, the system attempts to reset the 
initiating device for five seconds. 
Confirmation Stage. After the timer expires, the system evaluates the state 
of the initiating device for up to 120 additional seconds. After this duration, if 
the device is still in alarm, the system immediately annunciates the alarm.
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Latching Supv 
Verification

Renaming a Group

The default names for the groups are Supv Verification Group 0 through Supv Verification 
Group 7. 
To add a more descriptive name to the group, follow these steps.
1. Right click on the group whose name you want to change and select Properties. The Alarm 

Verification Properties dialog appears.

2. Click on the List tab in the dialog. 
3. Enter a name for the group in the Description field. 
4. Click the Apply button, followed by the OK button to close the dialog.

WalkTest™ WalkTest allows the function of the system's initiating devices and signals to be tested by a 
single person. Conducting a WalkTest requires you to perform the following general steps.

• Step 1. Create WalkTest Groups. The ES Panel supports up to eight WalkTest groups. 
This allows the building to be divided into small portions for the WalkTest, and allows 
the rest of the building to be protected by the fire alarm panel. Each group has a list of 
monitor points (initiating devices) and a list of the signal circuits that activate when 
one of the monitor points within the group activates.

• Step 2. Enable WalkTest Options from Front Panel. These options include the 
following: 
-  Which WalkTest Group is enabled.
-  Whether the group's signals turn on when a monitor point in the same group 

activates. Turn this option off to perform a silent WalkTest on the system.
-  Whether logging of WalkTest information is enabled or not. (Enable this option to 

perform a silent WalkTest. Refer to the 4007ES Operator's Manual (579-1165) for 
information on setting these options.)

• Step 3. Manually Activate Initiating Devices in Each Group and Interpret Signals. 
Individually activate each initiating device in the group, using the manufacturer’s 
recommended test equipment. Make sure to proceed in a logical manner (i.e., start with 
the lowest IDNet address and work toward the highest). Each time you activate an 
initiating device, the system’s signals pulse a code that allows you to verify exactly 
which initiating device triggered the signals. For hardwired monitor zones, the signal 
code corresponds to the number of the zone. (For example, if the zone number is eight, 
the signals pulse eight times to indicate zone eight.) For IDNet devices, the first set of 
pulses from the signals correspond to the channel. The signals then pause momentarily 
and the next set of pulses corresponds to the number of the device on the channel. For 
example, if you activate an IDNet smoke detector with an address of M1-25, the 
signals would sound once to indicate channel one, pause for a short duration, and then 
sound two pulses followed by a pause and then five pulses to indicate device 25. In 
some cases, immediately after verifying the function of an initiating device, you may 
also want to verify its ability to generate a trouble condition. To do this, cause a trouble 
on the device and then listen to the signals. The signals sound steady for 4 seconds to 
indicate trouble conditions, and then reset. 
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WalkTest Moving Points between Groups
The WalkTest list consists of eight groups. The purpose of these groups is to allow a technician 
to conduct a WalkTest in a specific area of a building (or different buildings), and limit the 
activation of the building signals to only the intended area. 
WalkTest Group 0 initially contains all of the monitor points and all of the signal points wired 
to the panel. Each WalkTest group consists of two lines: one for monitor zones and one for 
signal/relays. 
Follow these steps to move points from WalkTest Group 0 (where they are initially placed) into 
other WalkTest groups. Signal/relay points can exist in multiple groups, but monitor points can 
be in only one group at a time. 
1. Open the List Window by selecting the List Tab at the top of the Programmer. 
2. Click on the WalkTest tab at the bottom of the List Window. A screen similar to the one 

shown in Figure 8-4 appears.

Figure 8-4. WalkTest Tab
3. Right click on WalkTest Group 0 and select Properties. A properties dialog appears. Click on 

the WalkTest tab in the dialog. Remove the checkmarks from the Monitor and Control 
checkboxes. Click the Apply button, followed by the OK button to close the dialog. 

4. Select the monitor points to move as follows:
a. Right click on the WalkTest group into which you want to move the points (for exam-

ple, using Figure 8-4, right click on the line called LST WALKTEST GROUPX). 
When the list of options appears, select Tag List.

b. In the Tag List, use the mouse or arrow keys to highlight each monitor point you want 
to move into the group. Press the space bar to tag or un-tag points to be added or 
deleted. A point is selected when a “>>” symbol appears to the left of the point.

c. Repeat these steps to move other monitor points into the group. When you move 
points, the points are automatically unselected in WalkTest Group 0 - Monitor Points 
and moved into the group you chose.

5. Select the signal/relay points to move as follows:
a. Right click on the WalkTest group into which you want to move the signal/relay points 

(for example, using Figure 8-4, right click on the line called LST WALKTEST 
GROUPX - SIGNALS/RELAYS). When the list of options appears, select Tag List.

b. In the Tag List, use the mouse or arrow keys to highlight each signal/relay point you 
want to move into the group. Press the spacebar to tag or un-tag points to be added or 
deleted. A point is selected when a “>>” symbol appears to the left of the point.

c. Repeat these steps to move other signal/relay points into the group.
d. The points that you selected in Step b above are not automatically deleted from 

WalkTest Group 0 - Signals/Relays list. If you do not want these points to be in both 
groups, you need to open up the WalkTest Group 0 - Signals/Relays list and delete the 
points. To do this, right click on WalkTest Group 0 - Signals/Relays list. Select Tag 
List. When the list of points appears, use the mouse or arrow keys to highlight each 
point you want to unselect from WalkTest Group 0. Press the spacebar to deselect the 
highlighted point. Points do not have the “>>” symbol to their left when they are 
unselected.
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WalkTest Editing Group Properties

Each WalkTest group includes a set of properties that allow you to control the way in which 
points within the group operate. 
To edit the properties for a group:

1. Click on the WalkTest tab at the bottom of the List Window. 
2. Double click on one of the WalkTest groups to view its properties window. (Alternatively, 

you can right click on the group and select Properties from the menu that appears.)
3. Use the guidelines listed below to set the properties for the WalkTest group.

4. After making changes to the WalkTest Group properties, click on the Apply button to apply 
the changes and then click on OK to close the window. 

Table 8-2. WalkTest Group Property Guidelines

Tab Properties

WalkTest

Setting the properties in this tab affects all WalkTest groups.

Monitor. A check in this box means monitor points are automatically inserted in 
Group 1 - Monitor Zones. If you uncheck this box, you can move points from 
one group to another. However, at a later point, if you recheck this box, the 
points you previously moved to other groups will be moved back to Group 1.

Control. A check in this box means control points (signals/relays) are 
automatically inserted in Group 0 - Signals/Relays. If you uncheck this box, you 
can move points from one group to another. However, at a later point, if you 
recheck this box, the points you previously moved to other groups will be 
moved back to Group 1.

On. Allows you to set the duration of each tone within the PNIS code.
Off. Allows you to set the duration of silence between tones of the PNIS code.

Group

Setting the properties in this tab affects only the selected group.

Monitor. A counter that tracks the number of devices in the group.

Control. A counter that tracks the number of devices in the group.

Reset Delay. Allows you to shorten or lengthen the reset time used by the 
monitor device. For example, increase the delay in cases where canned smoke 
does not clear from a smoke detector quickly enough. 

List
Description. Allows you to change the description of the group’s monitor or 
control lists. For example, you can change the name of the WalkTest Group 0 - 
Signals/Relays to a more descriptive name, if necessary. 
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Elevator Recall 
List

The Elevator Recall list is made up of five groups, each corresponding to an elevator shaft 
numbered from one to five. Each shaft group contains three lists - one for the primary recall 
points, one for the alternate recall points, and one for the shutdown points. 
The Elevator Shaft 1 group initially contains all of the system's monitor points and all relays 
with the following point types - PRIMARY, ALTERN, and SHAFT (shutdown). 

Figure 8-5. Elevator Recall Tab

Moving Between Points:
Follow these steps to move points from Elevator Shaft 1 group (where they are initially placed) 
into other elevator shaft groups. Signal/relay points and monitor points can exist in multiple 
groups at the same time. 
1. Open the List Window by selecting the List Tab at the top of the Programmer. 
2. Click on the Elevator Recall tab at the bottom of the List Window.
3. Select the monitor points to move:

a. Right click on the Elevator Shaft group into which you want to move monitor points 
(for example, using Figure 8-5, right click on the line called LST ELEVATOR 
SHAFTX PRIMARY MONITOR ZONES). When the list of options appears, select 
Tag List.

b. In the Tag List, use the mouse or arrow keys to highlight each monitor point you want 
to move into the group. Press the spacebar to tag or un-tag points to be added or 
deleted. A point is selected when a “>>” symbol appears to the left of the point.

c. Repeat these steps to move other monitor points into the group.
d. Points that you move from Elevator Shaft 1 Primary Monitor Zones list to another 

group are not automatically deleted from Elevator Shaft 1 Primary Monitor Zones list. 
To delete points from this list, you need to highlight the Elevator Shaft 1 Primary 
Monitor Zones list, press F9 to see the tag list, and then highlight the point you want to 
delete and hit the space bar.

4. Select the signal/relay points to move as follows:
a. Right click on the Elevator Shaft group into which you want to move the signal/relay 

points (for example, using Figure 8-5, right-click on the line called LST ELEVATOR 
SHAFTX PRIMARY RELAY). When the list of options appears, select Tag List. When 
the list of options appears, select Tag List. 

b. In the Tag List, use the mouse or arrow keys to highlight each signal/relay point you 
want to move into the group. Press the space bar to tag or un-tag points to be added or 
deleted. A point is selected when a “>>” symbol appears to the left of the point.

c. Repeat these steps for the Alternate and Shaft lists within the selected group.
d. If you want to delete relay points from the Elevator Shaft 1 Primary Relay list, you 

need to first right click on the Elevator Shaft 1 Primary Relay list, select Properties, 
and set the AutoGen field to No. Next, press F9 to see the tag list, and then highlight 
the point you want to delete and hit the space bar.
8-9



4007ES Panel Programmer Manual (579-1167)
Viewing, Adding, and Editing Lists, Continued

Elevator Recall 
List

Editing Group Descriptions

Each Elevator Recall group includes a description property that allows you to change the label 
of the group. To edit the group's description:
1. Click on the Elevator Recall tab at the bottom of the List Window. Double click on the 

appropriate Elevator Recall list. 
2. Edit the description field and click on the Apply button. Click OK to close the screen.

Zone Lists The Zone List tab provides a way to group alarm conditions into zones (up to 512 zones). 
When grouped into zones, when an alarm occurs, a list of affected zones is displayed on the 
panel's touchscreen. It is then possible to touch the zone in alarm to display all the points that 
are in alarm in that particular zone. 

To create a Zone List:
1. Open the Zone List tab in the programmer.
2. Double click on an empty Zone List. The Zone List Properties window opens.
3. Enter a custom label to describe the Zone List.
4. Enter an alternate custom label to describe the Zone List.
5. Click on the Select Point button; the Tag List window opens.
6. Select the points that you want to include in the list.
7. Click on OK to confirm the selection.
8-10



Chapter 9.
Custom Control

Introduction With Custom control the components of the ES Panel FACP—hardware points, pseudo points, 
and lists—can be controlled with user-definable custom control “equations.” 

This chapter describes using Custom Control to create custom programming applications for 
the ES Panel FACP.

In this chapter

Custom Control 
Overview

ES Panel Custom Control — which is a wizard-based application used to create Custom 
Control Equations — provides a way to override the ES Panel’s default operation and for the 
ES Panel to function in a facility-specific way. Each Custom Control equation has a similar 
form: one half of the equation, called the input side, is used to monitor the state of specific 
system inputs (initiating devices, for example). The other half of the equation, called the 
output side, is used to control specific system outputs (such as relays, notification appliances). 
The output side executes only when the state of the input side is true. Another way to think 
about Custom Control equations is to consider them as If/Then commands. If the input side of 
the equation is true, then execute the output side.

The following examples help explain the way custom control is typically used with a ES Panel 
FACP.

• Selective Signaling. Selective signaling replaces the system's general alarm NAC 
operation — which activates all NACs in response to any alarm condition — with 
selective NAC control. With this type of control you can program the system so that 
only specific NACs respond to specific initiating devices.

• Fan and Damper Control following an Alarm. Controlling a building's HVAC 
system following an alarm condition prevents supply fans from feeding a potential 
fire and makes it possible for the HVAC system to exhaust smoke from the area in 
alarm. In this case, custom control equations are used to monitor the initiating devices 
in a given area and control the HVAC system’s dampers and air handling units to 
provide the correct supply and exhaust pressurization.
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Role of Lists and 
Pseudo Points

Using lists and pseudo points (both user-defined and system) improves the efficiency of 
Custom Control equations and makes it possible for a range of facility-specific operations to be 
programmed. 

• Digital Pseudo Points. Digital pseudo points store a value of ON or OFF.

• System Digital Pseudo Points, with these you can track when common actions (such as 
a system reset) have occurred and activate facility-specific outputs as necessary. 

• User-defined digital pseudo points can be used to signal that a specific event has 
occurred. (For example, turn on a user-defined pseudo point to indicate when a water 
tank is full.)

• Analog Pseudo Points. Analog Pseudo Points store analog values that can be used in 
Custom Control equations. 

• System Analog Pseudo Points store analog values (the number 128, for example), and 
can be used as a threshold value within a Custom Control equation. (For example, 
perform some output action when the value of the Number of System Troubles analog 
pseudo point (A2) reaches a specific value.)

• User Analog Pseudo Points store user-defined analog values. The exact function of an 
analog user pseudo depends on its point type—counter, timer, or analog value.

• List Pseudo Points. With User-Defined Lists you can refer to a specific group of 
devices using a single reference. For example, creating a user-defined list called “Floor 
1 Pull Stations,” and populating it with only the pull stations from floor 1 provides a 
way to monitor all of the pull stations on the floor without writing an equation for each 
pull station. 

Anatomy of a 
Custom Control 
Equation

As mentioned above, every Custom Control equation has an input side, consisting of input 
statements, and an output side, consisting of output statements. 

Input Statements are typically used to monitor the status of a point or list, or perform an 
action such as delay, cycle, compare two values, or save/recall values. Every input statement 
begins with an Opcode, which is the action that the input is performing (for example, monitor 
point status, recall memory register). The Custom Control wizard then displays a series of 
opcode-specific dialogs. For example if the Opcode is Point Status, the dialogs prompt the user 
for Qualifier about the condition (such as, alarm, trouble) and point being monitored.

Figure 9-1. Input Statement Example

Output Statements are the actions that occur only when the input side of the equation is true. 
Every output statement begins with an Opcode, which is the general action that occurs when 
the input side is true. The opcode is followed by a series of opcode-specific dialogs, with which  
you can specify exactly how the selected opcode functions. For example, if you are using the 
Set Opcode, the wizard displays a series of dialogs, with which you can specify a qualifier (for 
example, on, off) and the point (a signal, for example) on which you want the output action to 
execute. 

Figure 9-2. Output Statement Example

Continued on next page
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Anatomy of a 
Custom Control 
Equation

Using Logical Operators (AND, OR, NOT) you can link multiple input statements to form 
logical expressions. Logical operators are only used with input statements and are not used 
with Output statements. ES Panel Custom Control uses the following logical operators.

• AND Operator. With the AND logical operator you can put a group of points in series 
so that only the activation of all points at the same time causes the Output side of the 
equation to occur. In the following example, Zone1 and Zone2 must both be in alarm 
(FIRE) before the output (Hold ON SIG3) executes.

Figure 9-3. Logical Operator: AND

• OR Operator. With the OR operator you can put a group of points in parallel, meaning 
the activation of any one of the points causes the output side of the equation to execute. 
In the following example, if either Zone1 or Zone2 enters an alarm state, the output 
(Hold ON SIG3) executes.

Figure 9-4. Logical Operator: OR

• NOT Operator. Use the NOT Operator to specify that a condition must not be true in 
order for the output to execute. In the following example, the output side of the 
equation (print message “Smoke not dirty” executes only if the condition of M1-1 is 
NOT dirty.

Figure 9-5. Logical Operator: NOT

Using a Ladder 
Logic Diagram to 
Evaluate an 
Equation

A ladder logic diagram is a “sketch” of the equation used to evaluate (predict the outcome) of a 
custom control equation before it is entered into the programmer. Use the following 
conventions when creating ladder logic diagrams:

• Draw a solid, vertical line on the left side of the sketch to represent the starting point 
for the equation. Use a vertical dashed line to divide the sketch into an input side and 
an output side. 

• Use two vertical, parallel lines to represent each input statement. Add text between the 
lines to describe the input statement. 

Continued on next page
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Using a Ladder 
Logic Diagram to 
Evaluate an 
Equation

• Use a circle to represent each output statement. Add text within or beside the circle to 
describe the output statement. In the following example, the output side of the equation 
contains a single output statement, HOLD ON SIG 1. This action only occurs if the 
input side of the equation, which monitors point M 2-1 for the presence of a fire 
condition, is true.

• Represent the OR logical operator by positioning inputs on top of one another as 
shown in the example below. Represent the AND logical operator by positioning the 
inputs beside one another. 

Figure 9-6. Logic Diagram

The example shown above can be interpreted as: If point M2-1 or M2-2 or M2-3 and M2-4 are 
in a trouble state, hold on Relay 1. M2-4 is the key here. At least one of the three on the left 
(M2-1, M2-2, and M2-3) must be in a trouble state AND M2-4 must also be in a trouble state. 

Solid line
represents the 
start of the 
equation

Vertical, parallel 
lines represent input

Dashed line
separates input side
from output side

Circles represents outputs
Hold ON 
   SIG1

Point Status
  M 2-1 for 
     FIRE

Position the
inputs on
top of one 
another to 
represent 
the OR
logical operator

Point Status
M 2-1 for TBL
Point Status
M 2-2 for TBL

Point Status 
M 2-3 for TBL

Position the inputs beside 
one another to represent AND
logical operator

RelayPoint Status
M 2-4 for TBL
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Custom Control 
Window

Selecting the Custom Control tab from the main programmer window displays the Custom 
Control Window shown in Figure 9-7. This window contains two halves.

• The left half lists user-defined and system-only (non-editable) programs. Click on the 
+ sign to the left of an entry to expand the contents of that entry. 

• The right half of the window is used for creating user-defined Custom Control 
equations. With the Equation Comment text entry box you can enter descriptive text 
explaining the operation of the equation. The Equations Area contains a text entry box 
for creating and editing an equation’s input and output statements. The Add button 
starts the Custom Control Wizard and is used to create new equations. The Edit button 
is used to edit existing equations. The Taglist button starts a taglist that can be used for 
selecting/deselecting points in an existing equation.

Figure 9-7. Custom Control Window
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Selecting User 
Program

Note: You cannot write custom control on InfoAlarm switches and LEDs.

The first step in defining a new custom control equation is to add the equation to a User 
Programs. 

To add a new custom control equation: 
1. Right click on one of the user programs, located at the bottom of the program list, and select 

Add Equation from the list of options.

Figure 9-8. Add Equation
2. The Custom Control Program Properties dialog (Figure 9-9) appears. Enter a name for the 

equation in the Label field and click on OK. 

Figure 9-9. Equation Properties

The Equations section of the Custom Control window updates to include the [INPUTS], 
[END INPUTS] etc, entries. 
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Adding Input 
Statements

The second step in creating a new Custom Control equation is to add input statements to the 
equation. Repeat the steps in this section until all input statements in the equation have been 
defined.
1. In the Equations box, position the cursor just to the right of [INPUTS].

Figure 9-10. Positioning the Cursor
2. Click Add. The dialog shown in Figure 9-11 appears. 

Figure 9-11. Select Input Opcode Dialog

3. Click on the drop-down list box, select one of the Opcodes, and click Next. Opcodes 
available: Select Opcode, Select Input Qualifier, Select Item, Select Point.

4. The next dialogs displayed by the wizard depend on the Opcode you selected in Step 3. 
Follow the Wizard’s windows to create input for the equation. 

5. The Finish button becomes available when all dialogs related to the input Opcode have 
appeared. Click it to finish defining the input statement. 
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Adding Output 
Statements

The third step in creating a new Custom Control equation is to add output statements to the new 
equation. Repeat the steps in this section until all output statements in the equation have been 
defined.
1. In the Equations box, position the cursor just to the right of [OUTPUTS].

2. Click on the Add button. The dialog shown in Figure 9-11 appears. 
3. Click on the drop-down list box, select one of the output Opcodes, and click the Next button. 

Opcode available: Select Item, Set/Reset Priority, Select Point.
4. The next dialogs displayed by the wizard depend on the Opcode you selected in Step 3. 

Follow the Wizard’s windows to create the output for the equation. 
5. The Finish button becomes available when all dialogs related to the output Opcode have 

appeared. Click it to finish defining the output statement. 

Floor Above/Floor 
Below Wizard

This application limits the activation of NACs to the floor on which the activated initiating 
device is located, referred to as the fire floor, and the floors immediately above and below the 
fire floor. 

Figure 9-12. Floor Above/Below

In Figure 9-12, an activated smoke detector or pull station on Floor 3 activates the NACs on 
Floors 2, 3, and 4. 
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Selecting Floor 
Tab

1. Start the Floor Above/Below Wizard by clicking on the Floor Above/Floor Below Wizard 
tab, which is located along the bottom left part of the Custom Control window.

2. Right click in the blank area above the tab. When the list of options appears, select Create 
Floor Group. (The ES Panel refers to each set of floor above/below equations as a Floor 
Group. This is the name of the group or area that the floor above/below program has control 
over.) Enter a name for the Floor Group in the dialog that appears. 

. 

Figure 9-13. Create Floor Group

. 

Figure 9-14. Select Group
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General 
Information

After you enter a name for the floor group, click Next. A dialog appears, with this dialog you 
can specify general information about the application. 

. 

Figure 9-15. Floor Above/Below Data

Specify this information as follows:

• Program #. Use this entry to specify the Custom Control user program in which this 
application is to be stored. Three programs are available for user programs.

• Number of Floors. This specifies the total number of floors controlled by the floor 
above/below equations.

• Control # of Floors Above. When a fire occurs, this setting determines how many 
floors above the fire floor are notified.

• Control # of Floors Below. When a fire occurs, this setting determines how many 
floors below the fire floor are notified.

• Type (select all that apply)
-    Non-Audio. Select if using non-audio notification appliances
-    Smoke. Select this option to control smoke control (damper/AHU) points

Click Next when you are finished.
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Specifying Floor 
Names

The Floor drop-down list box contains an entry for all floors (i.e., if you set number of floors to 
10 in the previous screen, there are 10 entries). To enter a floor's name, first click on the     
drop-down list box to select the floor and then enter a descriptive label in the Floor Label text 
box. Enter any comments in the Comment box at the bottom of the dialog.

. 

Figure 9-16. Specify Floor Names

Specifying Input 
and Static Points

Enter information for the other fields in this screen as follows:

• Alarm Points. Identifies the floor's input points (such as, detectors, pull stations). 

• Non-Audio Points. Identifies the floor's non-audio (horns, strobes) notification points. 

• Air ON Points. Identifies the pressurization fan and damper ON points. 

• Exhaust ON Points. Identifies the exhaust fan and damper ON points. 

• Air OFF Points. Identifies the pressurization fan and damper OFF points. 

• Exhaust OFF Points. Identifies the exhaust fan and damper OFF points. 

For each of these selections, when you click on the button, a taglist appears, with which you 
can select specific points. Press the space bar to select a point. A “>>” symbol appears to the 
left of the point to indicate that it is selected. 

. 

Figure 9-17. Input and Static Points
Note: The user list is created starting from the first available user list and the number of list used depends 

on the chosen configuration.

Click Next. A dialog containing the Custom Control equations generated by the wizard 
appears. Click Finish. 
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Using the 
Selective 
Signaling Wizard

Selective Signaling is typically used to limit the activation of NACs to the area or floor on 
which an activated initiating devices is located. In the following example, an activated 
initiating device on Floor 2 triggers only the NACs located on Floor 2. 

Figure 9-18. Selective Signaling

Selecting 
Selective 
Signaling Wizard 
Tab

Start the Selective Signaling Wizard by clicking on the Selective Signaling Wizard tab, which 
is located along the bottom left part of the Custom Control window.

Right click in the blank area above the tabs. When the list of options appears, select Create 
Group. (See Figure 9-19.)

Figure 9-19. Create Selective Signaling Group

The dialog shown in  appears, prompting you for the name of the area/group. Enter a name for 
the group in the dialog and click Next. 

. 

Figure 9-20. Naming Group
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Setting General 
Options

After you enter a name for the group, click the Next button. A dialog appears, with this dialog 
you can specify general information about the application.

. 

Figure 9-21. General Information

Specify the following:

• Program #. If necessary, specify an alternate program number for the selective 
signaling application. 

• Number of Signal Zones. Enter the total number of signal zones affected by the 
application.

-    Type (select all that apply).
-    Visual. Select to use visual notification appliances in the application.
-    Audible. Select to use audible notification appliances in the application.
-    TrueAlert Zones (Addressable). Select to use addressable TrueAlert zones (wired 

to 4009T or TrueAlert Power Supply) in the application.
-    TrueAlert Zones (Non-Addressable). Select to use non-addressable TrueAlert 

appliances (2-wire with independent control of audibles and visuals) in the 
application.

Setting Zone 
Names

Click on the Zone drop-down list box and select the zone number. Enter a label for the zone in 
the Signal Zone Label box. Click on Next to continue.

.

Figure 9-22. Zone Names
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Linking Initiating 
and Notification 
Points

Using the screen shown below you can link initiating and notification points to one another. If 
one of the specified initiating devices activates, only the notification appliances linked to the 
initiating device activates. 

. 

Figure 9-23. Linking Initiating and Notification Devices

Note: The user list is created starting from the first available user list and the number of list used depends 
on the chosen configuration.

1. Click on the button labeled Alarm Points. A tag list appears. Use the up and down arrow 
keys to move through the list. Use the spacebar to tag (select) a point. A “>>” symbol 
appears to the left of the point when it is selected. Click OK to continue. The previous 
screen appears.

2. In Notification Points in this Signal Zone, click the notification appliance you want to turn 
on when the tagged initiating devices activate. The choices are: Visual Points, Audible 
Points, TrueAlert Zones (Addressable), and TrueAlert Zones (Non-Addressable). A tag 
list appears. Use the up and down arrow keys to move through the list. Use the spacebar to 
tag (select) a point. A“>>” symbol appears to the left of the point when it is selected. Click 
OK to continue. The previous screen appears.

3. You can also activate other notification signal zones when a tagged initiating device 
activates. To do this, click on the Notification Zones button to the right of the Other Signal 
Zones Notified label. A tag list appears. Use the up and down arrow keys to move through 
the list. Use the spacebar to tag (select) a point. A “>>” symbol appears to the left of the 
point when it is selected. Click OK to continue. The previous screen appears.

4. Click Next to continue. A screen showing the equations created by the wizard appears. Click 
Finish.
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Using the 
Sounder/Relay 
Base Wizard

Using the Sounder/Relay Base Wizard you can change the default operation of single station 
smoke detectors. Note that the default operation—sounder activates when the alarm threshold 
is passed and deactivates when the smoke level drops back below the threshold—is 
programmed using the TPHOTO device type. To use the wizard to change the default 
operation, you must assign a device type of SPHOTO or RPHOTO to the device.

1. Start the Sounder/Relay Base Wizard by clicking on the Sounder/Relay Base Operation Wiz-
ard tab, which is located along the bottom left part of the Custom Control window.

2. Right click in the blank area above the tabs. When the list of options appears, select Create 
Point Group. A figure similar to  appears.

. 

Figure 9-24. Creating Point Group
3. Enter a Name for the group in the Point Group field and enter any comments in the 

Comments box. Click Next to continue. Refer to the appropriate section below for specific 
information. 

Activating Base 
on Alarm

Activate base on Alarm configures the single station detectors to activate when the alarm 
threshold is reached and to turn off on either reset or silence. 
1. To select this option, select the radio button labeled “Alarm—Activate Base on Alarm.” 

2. If necessary, you can select a different Custom Control user program. To do this, click on the 
control to the right of Program # and select the appropriate program number. Click Next to 
continue.

. 

Figure 9-25. Sounder/Relay Base Information

Continued on next page
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Activating Base 
on Alarm

3. A dialog similar to the following appears. Select the operation for the device as either “Hold 
Device ON until Reset” (sounder or relay remains activated until reset) or “Hold Device on 
until Silence” (sounder or relay remains activated until signal silence). 

. 

Figure 9-26. Specifying Device Operation
Note: List number L256 is the next available list. It is not specifically L256.

4. Click on the Group Points button. A tag list, containing single station points appears. Use 
the up and down arrow keys to move through the list. Use the spacebar to tag (select) a 
point. A “>>” symbol appears to the left of the point when it is selected. 

Figure 9-27. Tagging Points
5. Click OK to continue. The previous screen appears. Press Next to continue. A screen 

showing the Custom Control statements appears. Click Finish.
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Common Ground 
Fault LED Control

Select and utilize the LED Yellow point type for custom control ground fault LED trouble 
indications:

Program the Color User Interface, Point Editing Tab as follows:

Add the following custom control equation to the 4007ES IDNAC Addressable Panel:

[INPUTS]
STATUS ON

1-0-9 | CARDSTAT | CSP | POSTIVE EARTH
OR STATUS ON

1-0-10 | CARDSTAT | CSP | NEGATIVE EARTH
OR STATUS ON

1-0-27 | CARDSTAT | CSP | POSITIVE EARTH ON RUI
OR STATUS ON

1-0-28 | CARDSTAT | CSP | NEGATIVE EARTH ON RUI
OR STATUS ON

2-0-8 | CARDSTAT | CSP | IDNET+ EARTH TROUBLE
[END INPUTS]
[OUTPUTS]

TRACK ON PRI=9,9
P535 | DIGITAL | UTILITY | COMMON GROUND FAULT LED

[END OUTPUTS]

Add the following custom control equation to the 4007ES Hybrid Panel:

[INPUTS]
STATUS ON

1-0-3 | CARDSTAT | CSP | POSITIVE EARTH GROUND
OR STATUS ON

1-0-4 | CARDSTAT | CSP | NEGATIVE EARTH GROUND
OR STATUS ON

2-0-8 | CARDSTAT | CSP | IDNET+ EARTH TROUBLE
[END INPUTS]
[OUTPUTS]

TRACK ON PRI=9,9
P535 | DIGITAL | UTILITY | COMMON GROUND FAULT LED

[END OUTPUTS]

HW Ref. Switch Mode Ref. Address Ref. Label HW Ref. LED Mode

3-1-1 SMPL 3-2-1 ON P535 Ground Fault

3-1-2 SMPL 3-2-2 SMPL

3-1-3 SMPL 3-2-3 SMPL
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Suppression 
Release 
Introduction

This section describes how to configure Suppression Release Hazard Areas using the 
programmer. 

Suppression Release refers to the release of water or chemical agents in response to alarm 
conditions. Suppression Release operation is limited to hazard areas, which are collections of 
initiating devices, signaling appliances, and releasing peripherals, powered by NACs, that are 
set up to respond to alarm conditions.

Suppression 
Release General 
Capabilities

The 4007ES panel is capable of controlling either a preaction/deluge sprinkler system or an 
agent release extinguishing system.

• The number of hazard areas that the 4007ES panel is capable of monitoring is restricted by 
the hardware and point capacity of the panel. Each hazard is defined as a separate area 
containing its own 4090-9005 or -9006 releasing peripheral and solenoid.

• Table 9-1 lists the number of Notification Appliance Circuits required by each hazard area of 
the 4007ES FACP.

• The releasing peripheral activates its output, which attaches to the solenoid, only when the 
designated initiating devices and the NAC connected to the release peripheral are active at 
the same time. This prevents a malfunctioning input from triggering a release. 

• Releasing signaling patterns are as follows:

• Dual Detector Application. Temporal on first alarm (can also be configured as 20 beats 
per minute). Signal changes to 120 BPM on second alarm. When the releasing 
appliances activate, the tone changes to Steady.

• Single Detector Application. When an initiating device in the hazard area activates, the 
system does one of two things: If a delay timer is used, the NACs play a 120 BPM 
signal as the timer counts down. This changes to a Steady pattern when release occurs. 
If no delay timer is used, the releasing appliances activate as soon as a single detector 
enters an alarm state. In this case, the NACs sound a Steady tone pattern and no 
distinct pre-discharge tone pattern plays.

• Alarm Triggered by Activation of Manual Release Station. If a delay timer is used, the 
system plays a 120 BPM signal on the NACs as the timer counts down. When the 
delay timer reaches zero, the releasing outputs activate and the signal changes to a 
steady tone.

Table 9-1. Number of NACs for Hazard Area

Each hazard area requires three to five conventional or virtual NACs, depending on the use case and options selected. One 
conventional NAC is required to power the Suppression Release Peripheral (SRP). The other outputs can either use conventional 
NACs or Virtual Notification Appliance Circuits (VNACs). The information below describes the operation associated with the available 
suppression release NAC/VNAC point types.

• The RELSIG circuit for audible notification typically consists of a horn and provides escalating cadence patterns to identify the 
stage of events (i.e., first alarm, confirmed alarm, release).

• The RELWVIS circuit for visual notification is used to alert when the first stage of a cross-zoned releasing sequence occurs or when 
a delayed action is used.

• The RELVIS circuit for visual notification is activated when the releasing output activates and remains on until System Reset. It can 
be used in systems without cross-zoning and without a delay timer to indicate the release output activation. It can also be used in 
systems with cross-zoning or a delay timer to provide a separate indication that the release output activation has occurred outside 
entrances of the hazard area. 

• The SUPRELS circuit controls the power to the SRP. This circuit must be a conventional NAC, not an addressable VNAC. 
• The RELISIG circuit controls audible and visual notification appliances when the system is configured to have a NYC Abort 

Investigation timer. Although an audible signal type, this NAC can connect sounders and strobes to the same circuit as required by 
NYC requirements. The audible portion of these appliances activates on steady when the NYC investigation timer activates and 
turn off when the investigation timer reaches zero. The NYC Abort option does not comply with UL 864. 

Continued on next page
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Suppression 
Release General 
Capabilities

Figure 9-28. Suppression Release Overview

Applying 
Appliqué

A self-adhesive appliqué (4010-9830 English or 4010-9830CAF French) must be ordered 
separately and applied to the front door of the unit when it is used as a suppression release 
system. This appliqué is used to indicate that the 4007ES panel is programmed to work as a 
releasing panel and all releasing circuits must be disabled prior to servicing. Apply the label to 
any area on the front door.
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Suppression 
Release Device 
and Point Types

Suppression release device and point types are shown in the table below. Assign the applicable 
device and point types to the suppression points before programming hazard area information.

Refer to section Programming Points inside the Online Help of the 4007ES Panel Programmer 
for information on programming the points.

Continued on next page

Table 9-2. Valid Device and Point Types

Point Type Description Valid Device Types AutoGenerates to Following Lists: 

RELSIG Releasing 
audible circuit

SIGA, SIGB, CHAN2A, CHAN2B, CHAN4A, 
CHAN4B, PCHAN4A, PCHAN4B, SIGIAM, 
NULLSIG, PS_SIGA, PS_SIGB, 
MFIO_SIGA, MFIO_SIGB, MSOUND, 
MSIGA, MSIGB, VNAC

L0    - Coding Group 0 
L1    - Coding Group 1 
L50  - Walk Test Group 0 - signals/relays
L139- Local Mode Operation Points

RELISIG NYC 
investigation 
bell/strobe 
circuit

SIGA, SIGB, CHAN2A, CHAN2B, CHAN4A, 
CHAN4B, PCHAN4A, PCHAN4B, SBZAM, 
SAZAM, NULLSIG, PS_SIGA, PS_SIGB, 
MFIO_SIGA, MFIO_SIGB, MSOUND, 
MSIGA, MSIGB, VNAC

L0    - Coding Group 0
L1    - Coding Group 1
L48  - TrueAlert Zone OFF on SILENCE
L50  - Walk Test Group 0 - signals/relays
L139- Local Mode Operation Points

RELVIS Release visual 
circuit

SIGA, SIGB, CHAN2A, CHAN2B, CHAN4A, 
CHAN4B, PCHAN4A, PCHAN4B, SBZAM, 
SAZAM, SIGIAM, NULLSIG, PS_SIGA, 
PS_SIGB, MFIO_SIGA, MFIO_SIGB, 
MSOUND, MSIGA, MSIGB, VNAC

L0    - Coding Group 0
L13  - Fire Alarm Visuals OFF on RESET
L49  - TrueAlert Zone OFF on RESET
L50  - Walk Test Group 0 - signals/relays
L139- Local Mode Operation Points

RELWVIS Releasing 
warning visual 
signal

SIGA, SIGB, CHAN2A, CHAN2B, CHAN4A, 
CHAN4B, PCHAN4A, PCHAN4B, SBZAM, 
SAZAM, SIGIAM, NULLSIG, PS_SIGA, 
PS_SIGB, MFIO_SIGA, MFIO_SIGB, 
MSOUND, MSIGA, MSIGB, VNAC

L0    - Coding Group 0
L13  - Fire Alarm Visuals OFF on RESET
L49  - TrueAlert Zone OFF on RESET
L50  - Walk Test Group 0 - signals/relays
L139- Local Mode Operation Points

SSABRT Shorted 
Suppression 
Agent Abort 
Zone

MONA, MONB, SMONA, SMONB, 
SCAN50, 4002MA, 4002MB, IAM, SECIAM, 
MAZAM, MBZAM

SSDUMP Shorted 
Suppression 
Agent Manual 
Dump

MONA, MONB, SMONA, SMONB, 
SCAN50, 4002MA, 4002MB, IAM, SECIAM, 
MAZAM, MBZAM, ADRPUL, CANPUL

L18  - General Fire Alarm Monitor Zones
L30  - Alarm Verification Group 0
L61  - Coding Group 1 - Monitor Zones
L139- Local Mode Operation Points

SUPRELS Suppression 
Release Output

RELEASE, SIGA, SIGB, CHAN2A, 
CHAN2B, CHAN4A, CHAN4B, PCHAN4A, 
PCHAN4B, SBZAM, SIGIAM, SAZAM, 
NULLSIG, PS_SIGA, PS_SIGB, 
MFIO_SIGA, MFIO_SIGB

SUPRELS 
(Graphic24)

Suppression 
(Agent 
Discharge) 
Release Output

OUTPUT
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Suppression 
Release Device 
and Point Types

Table 9-2. Valid Device and Point Types, continued

Point Type Description Valid Device Types AutoGenerates to Following Lists: 

SUPDET Suppression Agent 
Monitor Zone

MONA, MONB, SMONA, SMONB, 
SCAN50, 4002MA, 4002MB, IAM, 
SECIAM, MAZAM, MBZAM, ADRDET, 
GENIAM, NULLMON,500PSM, 
APM500, CM520, DM520, DMC520, 
IHN135, IHN200, 500CMB, 500CMC, 
500CMAB, 500CMAC, 500CMAD, 
500CMAE, TFXCDM, 501CMB, 
LPBD520, MD501, MD501EX, MD901, 
MDR901,MDS901, MF401, 
MF501,MF501HA, MF501EX, MF901, 
MF901HA, MFR901HA, 
MFS901HA,MER901, MFS901, 
MR501, MR501EX, MR501T, 
MR501TEX, MR901, MRR901, 
MRS901, MS502EX, MU901, MU912, 
S251, S252PLUS, All PHOTO Device 
types, All ION Device types, all HEAT 
Device types

L18  - General Fire Alarm Monitor Zones
L30  - Alarm Verification Group 0
L61  - Coding Group 1 - Monitor Zones
L139- Local Mode Operation Points

SUPDUMP Suppression Agent 
Manual Dump

MONA, MONB, SMONA, SMONB, 
SCAN50, 4002MA, 4002MB, IAM, 
SECIAM, MAZAM, MBZAM, ADRPUL, 
CANPUL

L18  - General Fire Alarm Monitor Zones
L30  - Alarm Verification Group 0
L61  - Coding Group 1 - Monitor Zones
L139- Local Mode Operation Points

SUPABRT Suppression Agent 
Abort Zone

MONA, MONB, SMONA, SMONB, 
SCAN50, 4002MA, 4002MB, IAM, 
SECIAM, MAZAM, MBZAM

SUPPRES Suppression Agent 
Pressure Mon

MONA, MONB, SMONA, SMONB, 
SCAN50, 4002MA, 4002MB, IAM, 
SECIAM, MAZAM, MBZAM

L18  - General Fire Alarm Monitor Zones
L30  - Alarm Verification Group 0
L61  - Coding Group 1 - Monitor Zones
L139- Local Mode Operation Points
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Suppression 
Release Signal 
Responses

This section describes the responses of the suppression release signals.

1. Alarm Silence/System Reset

• RELSIG, RELISIG turn off on alarm silence.

• RELSIG, RELISIG resounds after alarm silence when there is a state change on those 
signals (for example, 2nd detector activates in a cross-zone, delay expires, abort activated).

• RELVIS, RELWVIS turn off on system reset.

• If not already silenced, RELSIG, RELISIG will turn off on system reset.

• SRP output stays on until system reset.

Suppression 
Release Use 
Cases 

Use Case: Common Configuration

The following use cases share some common configuration, listed in this section. Specific 
configuration is listed under each use case.

Panel: A 4007ES IDNAC with the following points. 

IDNet points:
• Manual release point: MBZAM with SSDUMP point type at address M1-11-0.

• Automatic Release Points: Two Smoke detector devices with SUPDET point types at 
addresses at M1-18-0 and M1-19-0.

• Abort Switches: One IAM with point type SUPABRT at address M1-35-0.

• SRP: One SRP (RELEASE) with point type SUPRELS at address M1-36-0.

True Alert Zone

• SIG913 is configured as RELSIG (Releasing horn circuit) and has at least one audible 
device from the IDNAC channel.

• SIG914 is configured as RELWVIS (Releasing Warning Visual Signal) and has at least 
one visual device from the IDNAC channel.

AuxNAC 

• SIG3 set as SUPRELS point type.

Create a Hazard Area in Custom Control, Suppression Release Wizard

•  Create Hazard Area window
1. Hazard Area Name: Area 1

2. Comments: n/a

Continued on next page
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Suppression 
Release Use 
Cases 

Initial data window

• Program#: 3.
Note: It is always 3 for a 4007ES FACP.

• Check Enhanced Power Supply because we have an IDNAC channel.

• Check Cross Zone (Dual Detector).

• Set First Stage Audible Notification to Temporal. 
Note: The other options are Slow March Time (March20) and Fast March Time (March120). Fast 

March Time should not be used because the Second Stage Audible Notification is fixed at 
Fast March Time.

Timer Configurations

• Set Manual Release at 30 seconds and check the box.

• Set Detector Release Delay at 60 seconds and check box.

Hazard Area Lists window

• Press Manual Release Points and select the manual release point at M1-11-0.

• Press Automatic Release Points and select Automatic Release Points at M1-18-0 
and M1-19-0.

• Press Abort Switches and select Abort Point at address M1-35.

• Press Release Warning Points and select SIG914.

• Press Suppression Dump Points and select SIG3 and M1-36-0.

• Press Release Notification Audible NACs and select SIG913.

Use Case #1: 10 Second Delay Abort

Specific Configuration

Abort Logic Window

•  Set System Release after GREATER of Remaining Time Delay or 10 seconds.

Table 9-3 describes actions and their corresponding responses.

                

Table 9-3. 10 Second Delay Abort, Actions and Responses 

Action Response

First detector is triggered.
RELSIG turns on at low cadence (Temporal). 
RELWVIS turns on.

Manual device or second detector is triggered.
RELSIG turns on at high cadence (March120). 
RELWVIS stays on.

Abort switch is pressed and maintained for 
approximately 60 seconds after the RELSIG is in 
high cadence.

While the abort switch is pressed the RELSIG stays 
in high cadence and RELWVIS stays on.

Release the Abort Switch 

RELSIG stays on in high cadence. RELWVIS stays 
on for 10 seconds or for the remainder of the 
automatic release timer, whichever is greater. When 
the timer expires RELSIG and SUPRELS turn on 
steady and RELWVIS remains on. 

Continued on next page
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Suppression 
Release Use 
Cases 

Use Case #2:NYC Abort

Specific Configuration

True Alert Zone

• SIG912 is configured as RELISIG (Releasing Investigation Circuit) and has at least 
one audible device from the IDNAC channel.

Abort Logic Window

• Set NYC

Hazard Area Lists Window

• Press Release Investigation Points and select SIG912.

Table 9-4 describes actions and their corresponding responses. 

Use Case #3: IRI Abort

Specific Configuration
True Alert Zone

• SIG915 is configured as RELVIS (Releasing Visual Signal) and has at least one visual 
device from the IDNAC channel.

Abort Logic window

• Set IRI Abort.

Hazard Area Lists window

• Press Release Notification Visible NACs and select SIG915.

Table 9-4. NYC Abort, Actions and Responses

Action Response

First detector is 
triggered. 

RELISIG turns on steady. 

Second detector is 
triggered.

• RELISIG turns off.
• RELWVIS turns on.
• RELSIG turns on at high cadence (March120).

Press and release the 

abort switch. 

• Automatic Release Timer countdown is reset to the original value.
• RELISIG turns on steady for 90 seconds.
• RELWVIS turns off.
• RELSIG turns off.
Note: If the abort switch is pressed and released after the second alarm while the 

investigation timer is running, the investigation timer will not be reset and 
will continue to countdown until it reaches zero. When the investigation 
timer reaches zero, RELSIG and RELWVIS will turn back on and the 
automatic release timer will begin to countdown. If the abort switch is 
pressed and released again while the automatic release timer is running, a 
new full cycle of investigation and automatic release delay will start.

Investigation Timer 
expires

• RELISIG turns off.
• RELWVIS turns on.
• RELSIG turns on at high cadence (March120) for the full period of the Automatic 

Release Timer.
• RELSIG turns on steady, RELWVIS stays on, SUPRELS NAC turns on steady 

and SRP output turns on steady after the full Automatic Release Timer expires.

Continued on next page
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Suppression 
Release Use 
Cases 

Table 9-5 describes actions and their corresponding responses.

Use Case #4: Immediate Release
This use case is the simplest case. No abort switch, no release timers and no cross zone 
verification. 

Specific Configuration
IDNET points

• Manual release point: MBZAM with SSDUMP point type at address M1-11-0. 

• Automatic Release Points: One Smoke detector devices with SUPDET point types at 
address at M1-18-0.

• SRP: One SRP (RELEASE) with point type SUPRELS at address M1-36-0.

True Alert Zone

• SIG913 is configured as RELSIG (Releasing horn circuit) and has at least one audible 
device from the IDNAC channel.

• SIG915 is configured as RELVIS (Releasing Visual Signal) and has at least one visual 
device from the IDNAC channel.

AuxNAC 

• SIG3 set as SUPRELS point type.

Create a Hazard Area in Custom Control, Suppression Release Wizard, 

• Create Hazard Area window.

1. Hazard Area Name: Area 1

2. Comments: n/a

Continued on next page

Table 9-5. IRI Abort, Actions and Releases

Action Response

First detector is 
triggered.

RELSIG turns on low cadence (Temporal). RELWVIS turns on.

Abort switch is 
pressed and held.

No change.

Second detector is 
triggered while abort 
switch is still pressed. 
Keep the abort switch 
pressed for more than 
one minute.

• RELSIG goes on high cadence (March120). RELWVIS stays on.
• SRP output does not turn on including after Automatic Release Timer expires.

Abort switch is 
released

After 10 seconds or the remaining value of the release timer, whichever is greater, 
RELSIG goes on steady. RELWVIS stays on. RELVIS goes on. SUPRELS NAC 
goes on steady and SRP output goes on steady.
Notes:
• If a second alarm condition occurs while the Abort switch is still pressed, the 

automatic release timer resets to the value that has been configured for it. It 
begins to count down and will stop at 10 seconds. When the abort switch is 
released, the panel starts the release timer countdown at the value of the 
countdown timer or at 10 seconds, whichever is greater.

• Pressing the abort switch again and releasing it, when a second alarm is 
triggered, has no effect.
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Suppression 
Release Use 
Cases 

Initial data window

• Program#: 3 
Note: It is always 3 on a 4007ES.

• Check Enhanced Power Supply because we have an IDNAC channel.

• Uncheck Cross Zone (Dual Detector).
Note: Without cross zone the audible notification automatically defaults to Fast March Time 

(March120).

Abort Logic Window

• Set Immediate Release (No Delay).

Timer Configurations

• Uncheck Manual Release to set it a 0.

• Uncheck Detector Release Delay to set it at 0.

Hazard Area Lists window

• Press Manual Release Points and select the manual release point at M1-11-0.

• Press Automatic Release Points and select Automatic Release Points at M1-18-0.

• Do not add any devices to Abort Switches.

• Do not add any devices to Release Warning Points.

• Press Suppression Dump Points and select SIG3 and M1-36-0.

• Press Release Notification Audible NACs and select SIG913.

• Press Release Notification Visible NACs and select SIG915.

Table 9-6 describes actions and their corresponding responses.

Table 9-6. Immediate Release, Actions and Responses

Action Response

First detector is 
triggered 

RELSIG turns on steady. RELVIS turns on. SUPRELS NAC turns on steady and 
SRP output turns on steady.
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Step 1. Defining 
Hazard Area

1. Click the Custom Control tab.

2. Click the Suppression Release Wizard subtab. A screen similar to the one shown in Figure 
9-29 appears.

Figure 9-29. Create Hazard Area Menu Choice

3. Right click on the blank area of the screen labeled Hazard Area. 
4. Click on Create Hazard Area from the menu that appears. A screen similar to the one 

shown below appears.
5. Enter a name for the hazard area in the Hazard Area Name field and enter any applicable 

comments. Click Next to continue.

Figure 9-30. Naming Hazard Area
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Step 2. Specifying 
Initial Data and 
Options

The next screen, shown in Figure 9-31, prompts you to specify the following information.

• Custom Control Program Number. This is the program number under which the 
suppression release custom control equations created by the wizard are stored. In the case of 
a 4007ES FACP, Program # 3 is the only one that can be used.

• Cross Zone (Dual Detector). Check this box to enable cross-zoned (dual detector) 
operation. Cross-zoned applications require that two automatic initiating devices in different 
areas enter an alarm state before the releasing appliance can activate.

Note: To achieve true cross zoning, the initiating devices must be wired to either Monitor cards or ZAMs. 
Dual detector operation, which requires two detectors to activate, can use TrueAlarm initiating 
devices.

• First Stage Audible Notification. Click on the drop down list box and set the audible 
notification appliance pattern used for the first stage of a cross-zone (dual detector) alarm. 
Choices include Slow March Time, Temporal, or Fast March time*. When cross-zoned 
(dual detector) is enabled, this is the audible NAC tone pattern plays following activation of 
the first detector. When the second detector activates, the pattern is always Fast March. This 
option is not applicable if Cross Zone (Dual Detector) check box is not selected.
* Note:  Fast March time is not recommended, for example, there would be no change in pattern when 

transitioning from the first stage alarm to the second stage alarm.

Figure 9-31. Cross Zone (Dual Detector) Options

Click Next to continue programming when you have set these options to the appropriate 
values.
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Step 3. Specifying 
Abort Switch 
Operation

Using the next screen you can specify the action that occurs when the abort switch is released. 

IMPORTANT: For all choices except the International Risk Insurers (IRI) Abort method, 
pressing and holding the abort switch prevents agent release for as long as 
the switch is held in, unless a Manual Release switch is operated, which 
overrides the Abort Switch operation. For IRI Abort, the abort switch must 
be pressed and held before the second alarm activation occurs to prevent 
release.

Figure 9-32. Abort Switch Options

Set this option to one of the following choices:

• Immediate. If a confirmed alarm exists, for example, two detectors on separate zones for a 
cross zoned system or a single detector in a single alarm system and the release timer equals 
zero, the Suppression Release peripheral activates its output immediately upon release of the 
abort switch. 

• 10 Second Delay. If a confirmed alarm exists (for example two detectors on separate zones 
for a cross zoned system or a single detector in a single alarm system), the Suppression 
Release peripheral activates its output after a 10 second delay.

• 10s/Remaining. Similar to the 10 Second Delay except when the abort switch is released, 
the delay used is the remaining time left on Automatic Release Delay Timer or 10 seconds, 
whichever is greater. 

• IRI Abort -- Cross Zoned System Only (Does not comply with UL 864). When a single 
alarm is present, pressing the abort switch prevents the output on the Suppression Release 
Peripheral from activating. If a second alarm condition occurs while the Abort switch is still 
pressed, the investigation timer continues to countdown and the automatic release timer 
resets to its configured value. When the investigation timer reaches zero, the automatic 
release delay timer will begin to countdown. When the abort switch is released, the panel 
starts the release timer countdown at the value of the release timer or at 10 seconds, 
whichever is greater. 

• Original Delay (Does not comply with UL 864). If a confirmed alarm exists, such as two 
detectors on a cross-zoned system or a single detector in a single alarm system, releasing the 
abort switch resets the delay timer interval to the value set for the Automatic Release Delay 
Timer. Continued on next page
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Step 3. Specifying 
Abort Switch 
Operation

• NYC Abort (Does not comply with UL 864). Pressing the Abort switch does the 
following:

• Warning bell and strobe turn on (NAC associated with RELISIG point type).

• Evacuation visuals turn off (NAC associated with RELWVIS point type).

• Evacuation audibles turn off (NAC associated with RELSIG point type).

• Automatic Release Timer countdown stops at its current value.

Releasing the Abort switch starts the 90-second Investigate Timer. When the 
Investigative Timer expires, the following occurs:

• Warning bell and strobe turns off 

• Evacuation visuals turn on

• Evacuation audibles turn on at 120 BPM 

• Reload the Automatic Release Timer with the programmed value

If the abort switch is pressed and released after the second alarm while the investigation 
timer is running, the investigation timer does not reset and continues to countdown until 
it reaches zero. When the investigation timer reaches zero, the evacuation visuals and 
audibles turn back on and the automatic release timer begins to countdown. If the abort 
switch is pressed and released again while the automatic release timer is running, a new 
full cycle of investigation and automatic release delay starts. 

Click Next to continue.

Step 4. Setting 
Timer Options

Using the next screen you can set values for the Manual Release, Detector Release, and the 
Releasing Cutout.

Figure 9-33. Timer Configuration Options

Continued on next page
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Step 4. Setting 
Timer Options

Use the following guidelines when setting these values:

• Manual Release. The Manual Release Time Delay is a programmable timer that specifies 
the delay between the activation of a manual release switch and the activation of releasing 
appliances. The default setting for this timer is 10 seconds. A setting of 0 causes the 
releasing appliances to immediately activate after a manual release switch activates. This 
delay is programmable from 0-30 seconds.

• Detector Release Delay. The Automatic Release Time Delay is a programmable timer that 
delays the activation of the releasing appliance circuits. This timer starts immediately after 
receiving a confirming alarm (cross zoned system) or a first alarm (single alarm system). 
When the timer expires, the releasing appliances activate (assuming the abort switch is not 
active). This delay is programmable from 0-60 seconds.This delay makes evacuation of the 
protected space possible before the agent is released. Consider a delay timer when occupants 
could be present in the protected space. 

• Cross-Zoned System. The occupants receive a warning signal of the first alarm and 
receive an evacuation signal on the second alarm. Implementing a warning signal 
makes it possible to investigate the alarm before the second (confirmed) alarm. 
Implementing a delay on the second alarm gives time for occupants to evacuate, and 
where required, for the ventilation fans and dampers to shut down prior to the release 
activation.

• Single Alarm System. A selection of “0” seconds activates the releasing circuit at the 
same time as when the NACs signal an initial warning. A delay provides time for 
occupants to evacuate, and where required, for the ventilation fans and dampers to shut 
down prior to the release activation.

• Releasing Cutout. The Releasing Cutout Timer is a programmable timer that specifies the 
length of time the output on the Suppression Release Peripheral is held on. When the timer 
expires, the solenoid turns off (or cuts out), which stops the water flow or release of the 
extinguishing agent. This option is typically used on Deluge systems and is not intended for 
use with all releasing systems and releasing devices. A selection of “0” means the solenoid 
does not “cut out” and remains on until the system is reset. The Countdown Timer is 
programmable from 0-30 minutes. 

Step 5. Specifying 
Hazard Area 
Points

The next screen, shown in Figure 9-34, contains seven buttons, each corresponding to one of 
the suppression-release system lists. Points are automatically assigned to the appropriate list 
based on the suppression release point type assigned to the point. 

Figure 9-34. Tag List Buttons

Note: List numbers L256 through L262 are the next available lists. They are not specifically L256 through 
L262. Continued on next page
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Step 5. Specifying 
Hazard Area 
Points

Each button accesses a tag list, with this you can select (tag) the specific points to associate 
with the hazard. Follow these steps to tag points:

1. Click on the button corresponding to the type of suppression points you want to select. The 
TagList screen shown in Figure 9-35 appears.

2. The TagList screen displays all points with the relevant suppression release point type. To 
select a specific point for inclusion in the hazard area being programmed, click on the point 
to highlight it and then press the space bar. 

Figure 9-35. Tagging Points

3. Click OK when you are finished selecting points. The screen containing the Tag List buttons 
(Figure 9-34) reappears. Click Next when all points associated with this hazard area have 
been chosen. 

Continued on next page
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Step 5. Specifying 
Hazard Area 
Points

Review the options selected for the hazard area using the screen shown in Figure 9-36. Use the 
scroll bar to check the selections for all options. If necessary, click Back to return to one of the 
option selection screens to change a choice. When all of the options are set correctly, click 
Finish.

Figure 9-36. Reviewing Options

When you click Finish, an icon and label appear in the list of hazard areas shown in Figure 9-
37. 

Figure 9-37. Icon Added Following Programming
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Deleting Hazard 
Area

To delete an existing Hazard Area:

1. Right click the name of the hazard area (see Figure 9-37) and select the Delete Hazard Area 
option. A dialog appears warning you that all Custom Control equations associated with the 
hazard area will be deleted.

2. Click Delete associated list and pseudo points 
3. Click Yes

Figure 9-38. Deleting Hazard Areas

Editing Existing 
Hazard Area

Existing hazard areas can be edited in the following ways:

• Using the Wizard. Right-click the name of an existing equation (see Figure 9-37) and select 
Edit Hazard Area. The wizard screens reappear in sequence. Reselect the options for the 
hazard area as necessary.

• Properties. Right click on the name of an existing equation and select Properties. A 
properties sheet, containing a series of tabs across the top, appears. Each tab corresponds to 
one of the groups of suppression options. Click on each tab and reselect the options for the 
hazard area as necessary.

• Custom Control Equations. Right click on the name of an existing equation and select 
Manual Edit. Edit the Custom Control equations using Manual Edit, this eliminates the 
ability to use the wizard to edit the equations. After selecting this option, click on Custom 
Control subtab on the far left at the bottom of the Custom Control window. Select the 
program containing the hazard area's equations.

. 

Figure 9-39. Manual Edit
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Scheduling 
Options for     
Self-Test Wizard

Select the following options in the Self-Test Wizard to set up one or more schedules to run the 
scheduled self-tests:

• Frequency

• Day

• Time

• Triggering pseudo point 

Note: An automatic self-test can be launched from the TSW instead of the FACP. The pseudo point is a 
trigger to execute the scheduled self-test. The triggering point is optional. The purpose is to select a 
digital pseudo point to launch a scheduled self-test by overriding the usual date and time condition. 
For example, a public TSW digital point can be added to the job as external point and used to trigger 
a self-test. The user can run an automatic self-test at any time and on multiple panels at the same 
time.

Important:  The system pseudo point P503 RUN SCHEDULED SELF-TEST cannot be used 
as a triggering point. Doing so will lead to unpredictable behavior.

After configuring the date and time select the following options:

• List of SIGs

• Volume

• Trouble on fault

Step 1. Creating a 
New Self-Test

1. Click on the Custom Control tab.

2. Click on the Scheduled Self-Test Wizard subtab, right click inside the blank area of the 
Scheduled Tests and select the Create Self-Test option. A screen similar to the one shown 
in Figure 9-40 appears.

3. Complete the Self-Test Name and Comments fields

4. Click Next.

Figure 9-40. Wizard entry screen

Continued on next page
9-35



4007ES Panel Programmer Manual (579-1167)
Custom Control, Continued

Step 1. Creating a 
New Self-Test

5. The next screen, shown in Figure 9-41, specifies the Custom Control Program Number. 
This is the program number under which the self-test custom control equations created by 
the wizard are stored. No specific program number is reserved for use by Self-Test 
equations. Click Next.

Figure 9-41. Initial Data Screen

Step 2. Selecting 
Start Time and 
Frequency of the 
Self-Test

To select time and frequency of the Self-Test:

1. In the Self-Test Start Time area select the time to run the Self-Test.

2. In Recurrence Pattern, click the frequency and the day that the self-test is going to run.
3. Click Next.

Figure 9-42. Self-Test Time and Recurrence (Weekly Configuration Shown as an Example)
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Step 3. Selecting 
Self-Test 
Triggering Point 
and Point List

1. In Self-Test Triggering Point, click Select Pseudo Point to choose a pseudo point that will 
be used to activate Self-Test (Figure 9-43).

2. Inside Self-Test Options, click Select Point List to choose the points list for Self-Test. 

In Volume select whether horns on sounder devices will be disabled during Self-Test. 

In Trouble on Fail select yes or no to choose if a trouble will be generated if self-test fails.

Click Next.

3. In the summary screen that appears, ensure that all of the settings are configured correctly 
and click Finish to complete the Self-Test Wizard. Table 9-7 lists all the default values for 
the Scheduled Self-Test Wizard.

Figure 9-43. Self-Test Triggering Point and Point List

Table 9-7. Default Values for the Self-Test Wizard Settings

Setting Value User Options Input Validation

Self-Test Time 2:00 am User can edit hour and minute

Weekly No day selected
User cannot continue to next page 
while no day is checked. User can 
select more than one day.

Monthly
Two options:

• Day 1 of each month
• First Sunday of each month

By choosing the second option, the 
user can configure the test not to 
execute every month; quarterly or 
biannual execution.

Input validation required as the 
number of days varies from 28 to 31.

Yearly
Two options:

• First of January
• First Sunday of January

Two options for the user to select 
between the date or day of the 
week.

Input validation required. A Self-Test 
schedule with the wizard will be 
executed at least once a year.

Triggering Point and 
Self-Test Options

Triggering or point list not 
selected by default

User cannot continue to next page if 
a point list is not selected.

Volume NORMAL

Trouble on Fail NO
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Chapter 10.
File Transfer

Introduction There are two methods of performing file transfer in the 4007ES. The preferred method is to 
use a USB portable storage device (also called thumb drive, key, memory stick, etc.) to 
transfer files between the 4007ES USB port and the service PC. The secondary method is by 
connecting a cable between the Ethernet port and the service PC. Both methods are explained 
in this chapter.

For the 4606-Series Color Touchscreen LCD Annunciator, the preferred file transfer method is 
also to use USB portable storage device. Partial file transfer can also be performed using the 
RUI addressable connection to the panel, but the transfer speed is slower.

 
In this chapter USB File Transfer...................................10-2 Files Transferred .................................... 10-3

IP File Transfer .......................................10-4 File Transfer Connection to the PC ....... 10-4

Starting the IP File Transfer Utility ........10-4 IP Communication Parameter Settings .. 10-5

Downloadable Files ................................10-5 Download Tab........................................ 10-6

Upload/Reports Tab................................10-8 Type of Transfer..................................... 10-9
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USB File Transfer To Upgrade Software using a USB Storage Device:

1. Insert the USB storage device into the 4007ES Panel and upload the job currently running on 
the panel. The job is uploaded into a zip folder. The USB storage device must be formatted 
with FAT32 file system.

2. Take the USB storage device out of the panel and insert it in the PC.

3. Unzip the job and open it using the same version of the Programmer as the Master .BIN file 
running in the panel. For example, if 4007_3.02.03.bin is the file in the panel, then 
Programmer version 3.02.04 must be used.

Note: To check which Master BIN file is running in the panel, press the Menu button on the panel, then 
browse to System Info and then to Software Revisions. The Master BIN file version appears on 
the 4007ES panel display and it is different from the 4100ES and 4010ES.BIN files.

4. Save the job, build it, and then re-open it using the most recent version of the Programmer.

5. Click on the Transfer menu option and then on USB.

6. In the USB Transfer window (Figure 10-1), click CFIG, Panel Exec and Include Binary 
Files checkboxes and make sure the files are attached.

Note: Selecting the Panel Exec and Include Binary Files makes it possible for the USB transfer to 
select the correct panel bootloader, kernel, file system, panel UI slave and other listed slaves in the 
compatibility file (on the USB key /bins/compatibility.xml).

Figure 10-1. USB Transfer Window

7. Select the appropriate mass storage device and click on the Download button to download 
the files to the USB storage device. If older files are detected, the Overwrite Files dialog 
box appears. Click on the Yes button to replace the old files with the new ones.

Continued on next page
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USB File Transfer 8. Disconnect the USB storage device from the PC and insert it into the USB port located on 
the CPU board that is mounted on the inner door panel of the 4007ES. Files that need to be 
updated are flagged for an upgrade on the panel display (Figure 10-2).

Figure 10-2. System Upgrade Window

9. Press the Process Upgrade button on the touchscreen and confirm the selections.

10. When prompted, press the  button to take a snapshot of the existing panel software to 
be able to go back to the original files, if necessary.

11. After the panel reboot, press on the System Upgrade button to verify that no software is 
marked for an upgrade and disconnect the USB storage device by pressing the Eject USB 
button located under the Mass Storage.

The panel has now been upgraded with a new job and the latest software.

Files Transferred The following is an example of the files that can be transferred using a USB storage device:

File Description

4007_3.02.03.bin Master Controller file

bootloader_1.01_cpu801-4007es.bin File to update/boot Linux and file system

filesystem_1.01.01_cpu801-4007es.bin Root file system for the 4007ES FACP

IDNACPS_1.01.bin Addressable panel power supply file

IDNet2_1.01.03.bin IDNet file

kernel_1.01_cpu801-4007es.bin Linux kernel with modifications for the 4007ES FACP

MsgLib_UTF8_3.01.bin English display message library file

MsgLibF_UTF8_3.01.bin French display message library file

NACPS_1.01.01.bin Hybrid panel power supply file

panelui_1.01.02_cpu801.bin Panel user interface file

userfilesystem_4007es.bin System file (Manufacturing use only)

zonerelay_1.01.01.bin Zone/Relay card file
10-3



4007ES Panel Programmer Manual (579-1167)
IP File Transfer

IP File Transfer IP file transfer operates over the Ethernet service port, with files directly copied to the file 
system and activated. New Slave Exec data is then downloaded by the master once it is 
running.

File Transfer 
Connection to the 
PC

The Ethernet service port is located on the CPU board behind the inner door assembly 
(see Figure 10-3) and connects to the Service PC using a standard straight (non-crossover) 
Ethernet Patch Cable. Service Mode Jumper P7 must be connected for this operation which 
causes a Service Trouble condition. After, move the jumper to only one pin to disconnect and 
retain the jumper for future use.

Figure 10-3. Front Panel Ethernet Service Port

Starting the IP 
File Transfer 
Utility

This feature enables a download of the Fire Alarm Control Panel (FACP) software features 
(Panel Exec, Slave Exec, etc.). This provides a means for recovering previous configurations 
(via the File Transfer “History/Undo” tab). This also makes it possible for the FACP to 
continue operating during file download operation. FACP down-time is minimal.

The ES Panel IP File Transfer utility can be started from within the ES Panel Programmer or 
from the Windows Start menu. To start the File Transfer:

• From within the Programmer. While the programmer is running, click on the 
Transfer icon, located along the menu bar at the top of the programmer window. When 
the options appear, click on Local Panel.

Figure 10-4. Transfer Icon

• From the Start Menu. Click the Start button. Move the pointer to the Programs 
option. When the list of choices appears, move the pointer to the Simplex option and 
click on the option containing the programmer. A list of options appears. Click on IP 
File Transfer.

When start-up procedure has been completed, the File Transfer Utility appears. 

  Ethernet Service Port

Service Mode
Jumper P7
10-4



4007ES Panel Programmer Manual (579-1167)
IP File Transfer, Continued

IP Communication 
Parameter 
Settings

Click on the Settings button near the top of the IP File Transfer Window to access the Settings 
Window. The settings window shows you the IP address the program is currently using, you to 
change it if necessary.

Figure 10-5. File Transfer Settings Window
Click on OK to confirm your selection or Cancel to erase any modification you made. 

Downloadable 
Files

The following types of files can be downloaded to the ES Panel FACP through its file transfer 
utility.

• CFIG File. This is the built job file, consisting of all programming definitions in a 
binary format, that the panel's CPU can execute. 

• Slave Exec. Module-specific slave Exec files execute on intelligent slave modules 
(listed below) and define the way in which the slave module operates. Occasionally, 
changes to the functionality of a slave module may require you to download a new 
slave Exec file. (For example, a change to the IDNet Slave Exec file may be necessary 
to provide support for new, additional device types.) The following 4007ES modules 
are “intelligent” slave devices that use a module-specific Slave Exec file.

• CFIG Text File. A panel with a missing or corrupt CFIG file can be restored to proper 
operation by downloading a CFIG text file to the panel. The CFIG text file is 
automatically built and placed in the same job directory as the “executable” CFIG file 
(file ending in .CFG extension). 

• Panel Exec (Master). The Panel Exec file is the “operating system” that runs on the 
panel’s CPU module. It manages interactions between system components. 
Occasionally, changes to the functionality of the operating system may require that a 
new Panel Exec file be downloaded.

-  25 Volt Regulator -  IDNet+ Expansion Card

-  Zone/Relay Card -  CPU Bootloader Files.

-  SCU/RCU -  LED Module

-  SDACT -  Remote UI
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Download Tab By default, the IP File Transfer window opens to the Download tab. 

Figure 10-6. IP File Transfer Download Tab
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Download Tab 1. To download a software feature, make sure the Service Mode (Jumper 7) is enabled. 
Select the type of file you want to download by clicking on the radio button next to the file 
you want to download. The options are: 

• CFIG and all Execs

• CFIG 

• Slave Exec

• Panel Exec

• CPU Bootloader 

• Primary Msglib

• Alternate Msglib

2. Once the selection has been made, use the checkboxes to select the download options:

• Download to a running panel: Select this option to download the file to a running 
panel. Once this option is selected, there are 3 ways in which the changes can be 
applied:

-    Automatically after the download. Select the "Apply download changes after 
download" box to have the downloaded changes applied immediately after the 
download. This is the program’s default setting.

-    When the system reboots: If the "Apply download changes after download" button is 
not selected, the downloaded changes will be saved and applied once the system is 
rebooted.

• Exclude the recovery file. This box option can be used when downloading a CFIG, it 
will result in a faster download.

• Preserve current Install mode list: Select this box to keep all the points you have 
placed in install mode in install mode once downloaded changes have been applied. 
This is highly recommended. 

3. Use the File name box to select the file you want to download to the panel. 
4. Click on the Download button to start the process. 

The following are additional functions accessible from the Download tab:

• View Final Status of Last Panel Update: Click on this button to bring up the final status of 
the last panel update.

IMPORTANT: Selecting the CFIG and All Execs option makes it possible for the 
IP Transfer to download the correct panel bootloader, panel UI slave 
and other slaves to the panel, in addition to the job.
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Upload/Reports 
Tab

The default option for this feature is to upload the job that is currently running in the FACP. 
The file that is uploaded is a compressed image of the programmer job file. Therefore, there is 
no need for an “unbuild.” The file is uploaded to its default location. 
(C:\4100UJOBS\JobName). This tab also has options for uploading all FACP reports. The 
reports are uploaded to the “reports” subdirectory of the current job directory. The report file is 
given a descriptive name, appended with the current date (e.g., AlarmLog_2010_3_11.txt).

Figure 10-7.Upload/Reports Tab 
To upload a file or a report:
1. Click on the Upload/Reports tab near the top of the IP File Transfer window. See Figure 10-7.

2. Select the type of file you want to upload by clicking on the radio button next to the item.
3. Chose one of the following:

4. Use the File name box to select the directory on your PC you want to upload the report to. 
5. Click on the Upload button to start the upload.

Panel Configuration/Job TrueNAC Reports

• Job Associated with CFIG (SDB4100U) All Last

Panel Logs Self-Test

• Alarm Log • Trouble Log All Last

Reports

• TrueAlert Report • TrueAlarm Status • TrueAlarm 
Service

• TrueAlarm CO 
Service
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Type of Transfer In addition to the upload of the CFIG file, other types of information from the Panel can also be 
uploaded to the ES Panel Programmer.

• TrueAlert Report: It is a report generated by the panel. It provides information such 
as Point ID, Device Type, and Candela rating for all TrueAlert devices.

• TrueNAC Report: It is a report generated by the panel following the completion of a 
TrueNAC diagnostic test. The report indicates all devices’ pass or fail status along 
with nominal current, predicted worst case current and predicted worst case voltage 
threshold at the minimum TPS operating voltage. By selecting this option you can 
choose between downloading the report for All TrueAlert devices on all TPSs or only 
for the Last TrueNAC diagnostics performed on a specific TPS and SLC.

• Panel Logs: With this selection you can select between uploading an Alarm Log or the 
Trouble Log, produced as a result of Alarm or Trouble conditions reported to the 
Control Panel, onto the ES Panel Programmer.

• TrueAlarm Status Report: A report providing the following information for each 
point:

-    Device Number
-    Custom Label
-    Current Sensitivity of the Point
-    Point Status: Normal, Trouble, Alarm
-    Almost Dirty Status: Points that are almost dirty have an asterisk in this field to 
denote this status.

• TrueAlarm Service Report: A report providing the following information for each 
point:

-    Device Number
-    Custom Label
-    Alarm Level (sensitivity level of the device)
-    Average Value
-    Current Value
-    Percent of Alarm: Shows the current value for the sensor. Value is shown as a 

percentage of 100 percent (alarm). For example, if the value shown is 9%, it 
means that the sensor is currently at 9% of the value required to trigger an alarm.

-    Peak Value: Shows the highest value that the sensor has reached. Value is shown 
as a percentage of 100 percent (alarm). For example, if the value shown is 9%, it 
means that the peak value experienced by the sensor was 9% of the value 
required to trigger an alarm.

-    Current State: Possible values include Normal, Trouble, Dirty, Excessively Dirty, 
and Almost Dirty.

• TrueAlarm CO Service Report: This report provides the following information 
regarding the CO devices:

-    Custom Label (custom description of device)
-    Current Device Value (PPM)
-    End-of-Life Date

• Device Status (Normal, Trouble)

IMPORTANT: The following reports can also be transferred to the USB 
storage device.
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Chapter 11.
Port Vectoring

Introduction The term port vectoring refers to the way in which certain cards can be programmed to output 
only specific groups of events. This section describes programming the ES Panel's port 
vectoring option.
Note: User editing of the DACT port vectoring is not permitted in UL 864.

 
In this chapter

Choosing Event 
Groups to Route

To choose event groups to route: 

1. Click on the Port Vectoring tab, located just beneath the row of icons, to view the window 
used to route events to the RS-232 port or the DACTs. A window similar to the one shown 
in Figure 11-1 appears.

Figure 11-1. Port Vectoring Tab
2. In the Available Ports list, located on the left side of the window, click on the line contain-

ing the port you want to program. If you choose RS-232, all of the event types shown in the 
figure are available for routing. If you choose one of the DACTs, the following event types 
are not available:

• System Reset

• Alarm Silence

• SMPL Print Statements

• Walk Test Events

• ACTIVE State Events

• Time/Date Updates

3. In the Event Types list, located on the right side of the window, select the checkboxes 
corresponding to the event types that you want to route to the device selected in Step 1.

Choosing Event Groups to Route .. 11-1
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Chapter 12.
AMON Point Type

Introduction This chapter describes creating custom point types (referred to as AMON point types) for use 
with analog monitor ZAMs. These point types allow descriptive text and device-specific 
settings to be associated with a point name.

 
In this chapter

AMON Pt Type 
Tab

The AMON Pt Type tab (Figure 12-1) is for use only with IDNET analog monitor ZAMs. It 
allows you to create a custom point type that specifies how the ES Panel system should 
interpret (i.e., react to) incoming analog data from the device attached to the ZAM. This point 
type can then be assigned to the ZAM using the IDNET point editing screen, which is 
accessible through either the Hardware or Point tab. For example, if you have an analog 
device that measures the amount of liquid within a tank, you can use this tab to create a point 
type that specifies what the unit of measurement is (gallons, for example) and what the 
threshold values for an alarm should be (generate an alarm when the tank is half empty, for 
example).

Figure 12-1. AMON Point Type Tab

AMON Pt Type Tab.......................12-1 Adding a Point Type ......................12-2

Editing a Point ...............................12-4 Deleting a Point .............................12-4
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Adding a Point 
Type

The AMON Point Type Tab uses a wizard-style interface that guides you through the process 
of creating an AMON point type.
1. To start this wizard, right click in the blank space just below the Point. When the menu 

appears, click on Add. A dialog similar to the one shown in Figure 12-3 appears.

Figure 12-2. Initial AMON Point Type Dialog
2. Enter data in the initial dialog’s fields, as follows:

• Point Type Name. Enter a seven-character name for the point in this text entry field. 
This point name can then be assigned to the analog ZAM point editing screen. The 
point editing screen is accessible through either the Hardware Tab or the Point Tab.

• Alarm Type. The alarm type you choose determines how the ES Panel reacts when the 
device attached to the ZAM crosses the threshold that you define for it. (The threshold 
is defined in a step below.) Choices for this field are as follows:

• Decimal Display. This field specifies the degree of precision for the device reporting 
data (how many digits after the decimal place the device reports). If the device reports 
data one unit at a time, choose the XXXX. option. If the device reports data in 10ths of 
a unit, choose the XXXX.X option. If the device reports data in 100ths of a unit, 
choose the XXXX.XX option.

Table 12-1. Alarm Type

Alarm Type Description

FIRE Causes the system to generate a fire alarm when the device crosses the 
threshold.

LATSUPV

Creates a latching supervisory condition when the device crosses the 
threshold. This means that the supervisory condition on the panel does 
not clear until the point restores to normal and a system reset is 
performed.

MPR12 Generates a priority 2 alarm when the device crosses the threshold.

SUPERV Generates a supervisory condition when the device crosses the 
threshold.

TROUBLE Generates a trouble condition when the device crosses the threshold.

UTIL
Defines the point to be a pseudo point, having a value of either ON or 
OFF. Typically used as a trigger for custom control (i.e., perform some 
action if the point turns ON).
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Adding a Point 
Type

3. Click the Next button to view the dialog shown in Figure 12-3.

Figure 12-3. 4mA and 20mA Values Dialog 
4. Enter data in the 4mA and 20mA Values dialog (refer to Table 12-2).

5. Click the Next button. A dialog similar to the one shown in Figure 12-4 appears.

Figure 12-4. Threshold Unit Values Dialog
6. In the Threshold Unit Values Dialog, you can specify up to three thresholds.

• Threshold Checkbox. Select this box if you want the system to generate an event (the 
specific type of event depends on what you chose for Alarm Type in Step 2) when the 
device being measured goes above the value that you specify in the Unit field.

• Unit Field. This is the value that the device must pass to trigger the alarm condition.
7. Click Finish.

Table 12-2. 4mA and 20mA Values

Field Description

Eng Unit Text

The “unit” (ppm, gal, psi, etc.) text that appears on the front panel display 
when you display the current value of the device via the front panel. For 
example, if a monitor device with a monitoring capability of parts per 
million is attached to the ZAM, you might put ppm in this field.

4mA Value This is the lowest value that the device reports. When the device is at this 
value, it draws 4mA of current from the ZAM.

20mA Value This is the highest value that the device reports. When the device is at 
this value, it draws 20mA of current from the ZAM.
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Editing a Point To edit an existing point:
1. Right click on the point you want to modify.

2. Click on Properties.
3. Modify the AMON Properties as required.

Figure 12-5. Editing an AMON Point Type
4. Click Apply > OK.

Deleting a Point To delete an existing point:
1. Right click on the point you want to delete.

2. Click on Delete.
3. Click on Yes to confirm. 
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Chapter 13.
Adding or Editing Network Information

Introduction This chapter describes the following network-related procedures. 

• Defining the panel's Public and External points.

• Setting the Network Information fields for the panel.

 
In this chapter

Role of the 
Network 
Programmer

Programming a network of 4007ES FACPs requires the use of two programmers, as follows.

• Simplex New Network Programmer. Use this programmer to create a new network or edit 
an existing network. Opening an existing network job with the network programmer 
spawns the ES Panel programmer, which can then be used to declare the public and external 
points for that node.

• ES Panel Programmer. The ES Panel programmer works along with the Simplex Network 
Programmer. It allows you to specify the panel's public points, external points, and Node 
numbers.

Public Versus 
External Points

A public point is a point connected to this panel that you want to be visible to other nodes on 
the network. In other words, when the status of the point changes, you want it to annunciate its 
status on the other node. There is no limit to the quantity of public points for 4007ES network 
panels.

An external point is a point on another node. Declaring it to be an external point allows its 
status to be annunciated on this panel. The 4007ES supports up to 100 external points.

For example, when you want changes to the status of the panel’s points to report to a central 
annunciator, such as a TSW, you would use the ES Panel programmer to declare the panel’s 
points (or a subset of its points) public. Likewise, on the TSW, you would declare the panel’s 
points as external.

General Network 
Programming 
Guidelines

Use the following guidelines when programming 

• All nodes must have the same version or a compatible version of software and firmware.

• All nodes must use the same baud rate.

• To reduce Net activity and increase efficiency, it is recommended that you do the following:

- Avoid making control points Public.

- Program all control functions in the node that contains the control points.

- Use Lists to minimize the network traffic. (Nest only one list within a main list.) Do not 
make a list Public that already contains External Points. 

- Do not use the SET command when writing Custom Control for a Network node unless 
absolutely necessary. It acts on every poll cycle and slows down the network response 
time. Use TRACK rather than SET whenever possible.

Continued on next page

Role of the Network Programmer .................. 13-1 Public Versus External Points ........................ 13-1

General Network Programming Guidelines... 13-1 4007ES Programmer Network tab................. 13-2

Gaining Access to the Network Information . 13-3 Editing the Network Name and Node Number13-4

Procedure to Declare Public Points................ 13-5 Procedure to Declare External Points ............ 13-5

Programming Network Alarm Silence........... 13-6 Programming Central Network Silence......... 13-7

Programming Distributed Network Silence ... 13-8 Programming Central Network Reset............ 13-9

Programming Distributed Network Reset.... 13-10 Distributed Configuration ............................ 13-11
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General Network 
Programming 
Guidelines

• Do not make an NDU point Public above offset 1535. This only applies to the 4100+.

• Never set the value of an External Analog Pseudo Point through the Network.

• Do not use P210, P211 or P212 at the same time for Network System Reset. 

• Use P217 for Network Signal Silence. 

• Avoid Version Mismatch. If you change a label or device type or point type on a point that is 
EXTERNAL to other nodes, you must build and download all nodes that have an external 
copy of the point. If you change the Job Title in the General Info screen, or the Network 
Prefix in the Network Points in the Info Screen, you must build all nodes and download all 
nodes.

4007ES 
Programmer 
Network tab

The Network Tab provides access to the dialogs used to add and edit the lists of public and 
external points. Click on the Network Tab to see the screen shown in Figure 13-1.

Figure 13-1. Network Tab
13-2



4007ES Panel Programmer Manual (579-1167)
Adding or Editing Network Information, Continued

Gaining Access 
to the Network 
Information

The network information fields are contained within the Panel tab. To access these fields, do 
the following:

1. Click on the Network tab, shown in the upper right corner of Figure 13-2.

2. Click on the Network Information subtab on the bottom left of the window.

Figure 13-2. Network Tab, Showing Network Information
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Editing the 
Network Name 
and Node Number

The Network Information tab includes the following fields. Use the guidelines outlined in the 
table when setting these fields.

 

Field Guidelines

Advanced 
Network 
Information

Network Click on the Advanced button and use the dialog that appears to change the network 
to which the 4007ES panel is assigned.

Node Click on the Advanced button and use the dialog that appears to change the node 
number of the 4007ES panel.

Master 
Timekeeper

Select to use this panel as the network’s master timekeeper. Only one master 
timekeeper per network.

Annunciate 
Common Troubles

Select if you wish to have other panel’s common trouble messages annunciated on 
this panel.

Annunciate Network 
Troubles

Select if you wish to have this panel’s Network messages sent to the system’s 
annunciators.

Annunciate Extra 
Node Troubles

The Annunciate Extra Node Option prevents a node from annunciating an Extra 
Node Trouble following the addition of a new node. Guidelines for setting this option 
are as follows: 

• Unselect this option on nodes without a need to annunciate events from the new 
node. 

• Select this option on the node that functions as the network's central annunciator.

Auto Gen List 
Externals

When selected, this option adds the external points from other nodes to the system 
lists on this node. When it does this, it adds the points to the list based on the point 
type of the point. 

Miscellaneous 
Network 
Information

Network Prefix Enter descriptive text in this field. This text appears when the more info. field is 
selected on a TSW. 

Special Analog 
Initialization

Checking this option prevents analog detectors from sending status on initialization if 
the value is not an alarm or trouble condition. However, if the analog value indicates 
an alarm or trouble condition exists, the detector will send its state.
If you select this option and you have Custom Control equations that contain the 
Compare Opcode and Current Value qualifier, be aware that the equation will not 
trigger on network initialization, but will trigger on subsequent value changes. Also, if 
analog detectors have a numeric value on a GCC screen, the screen will not update 
until the point's value changes after network initialization.
Note: To avoid Network Initialization troubles, all network nodes must be set the same 

way.

Inhibit Priority-Only 
EQBs

This option prevents network EQBs from being generated for status changes that 
only affect priority and not the status of the point. For example, a Custom Control 
equation triggers that modifies the priority of a public control point, putting the point to 
the reset priority but not changing its state. If this option is selected, no EQB will be 
generated. The side effect of choosing this option is that there will be a display 
mismatch of the priority between the owner and the external node. 

Note: Select this option only if required to reduce network traffic.

Inhibit Sounder-
EQBs 

This option prevents TrueAlarm sounder/relay base (non-combo points) from 
generating network EQBs when only the status of the sounder/relay changes. If the 
sounder/relay is turned on or off without a threshold or logical state change on the 
sensor portion of the device, no EQB will be generated to external nodes. Status 
changes to the device that involve a logical status change (e.g. alarm, trouble), or a 
sensor threshold level change will still report.

Note: Select this option only if required to reduce network traffic.
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Procedure to 
Declare Public 
Points

Use the following procedure to define the panel’s public points.

1. Click on the Network tab shown in the upper right corner of Figure 13-1.

2. Right click on the Public Points folder and select the Edit Public choice. The tag list is 
shown in Figure 13-3.

3. Position the highlight on a point and press the space bar to tag the point. A >> symbol is 
shown to the left of the point to indicate that it is selected. (To remove this symbol and 
deselect a point, highlight the point and press the space bar again.)

To select a contiguous group of points, click on the first point in the group, press the SHIFT 
key and click on the last point in the group you want to select.

Figure 13-3. Public Points Tag List

Procedure to 
Declare External 
Points

Use the following procedure to define the panel’s external points.

1. Right click on the External Points folder and select the Edit Externals choice. The dialog 
shown below appears. Click on the drop down list box and select the number of the node 
containing the points you want to declare external.

Figure 13-4. Select Network Node
Continued on next page
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Procedure to 
Declare External 
Points

2. Click OK. The tag list shown in Figure 13-5 appears. This taglist contains all of the points 
that are currently declared public on the node selected in Step 1 above.

Figure 13-5. Tag List for External Points

3. Position the highlight on a point and press the space bar to tag the point. A >> symbol is 
shown to the left of the point to indicate that it is selected. (To remove this symbol and 
deselect a point, highlight the point and press the space bar again.)

To select a contiguous group of points, click on the first point in the group, press the SHIFT 
key and click on the last point in the group you want to select.

Programming 
Network Alarm 
Silence

The sections below describe programming Network Silence and Network Reset. These options 
can be configured to work in either of the following ways:

• Central Network Silence and Reset. With this type of configuration, only one node 
(known as the Central Network Silence/Reset Node) is capable of initiating a Network 
Silence or Network Reset. 

• Distributed Network Silence and Reset. This setup allows a Network Silence or Network 
Reset to be initiated from any node on the network.
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Programming 
Central Network 
Silence

Any 4007ES node can be configured as the Central Network Silence Node. Programming 
Central Network Silence does not invalidate inhibit and cutout timers on each node. Each node 
handles these functions locally. The figure below provides an overview of Central Network 
Silence. In this figure, Node 1 serves as the Central Network Silence Node. Each node’s P217 
pseudo has been declared external on Node 1 and L106 on this node has been edited to include 
the external points.

Figure 13-6. Central Network Silence

Follow these steps to program Central Network Silence.

1. Open the network job, using the network programmer. Open the job for the node you have 
designated as the Central Network Silence Node.

2. When the ES Panel programmer appears, click on the Network tab at the top of the 
programmer. When the Network window appears, click on the Network Points subtab at the 
bottom of the Network window.

3. Right click in the Network window. When the choices appear, click on Edit Externals. A 
dialog similar to the following appears. Click on the drop down list box and choose one of 
the nodes on the network.

Figure 13-7. Select Network Node

Continued on next page

Node 4
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Programming 
Central Network 
Silence

4. Click OK to close the dialog. When you do this, a tag list containing the public points from 
the selected node appears. Click on P217 Network Signal Silence and press the space bar to 
select the point. Click OK to close the taglist.

5. Repeat Steps 3 and 4 for every node on the network.

6. Click on the List tab at the top of the programmer. When the List window appears, click on 
the General List subtab at the bottom of the window. Scroll through the list, right click on 
L106 - External Alarm Silence Points and select Tag List.

7. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click on 
the Network Externals check box. Click on the OK button. All of the External Points 
appear.

8. Click on each entry for P217 - Network Signal Silence (each node on the network should 
have an entry) and press the space bar to add the entry to L106. N:P217 represents the Node 
Number.

Programming 
Distributed 
Network Silence

This setup allows a Network Silence to be initiated from any node on the network. The figure 
below provides an overview of Distributed Network Silence. In this figure, each node's P217 
pseudo has been declared external on the other nodes and L106 on each node has been edited to 
include the external points.

Figure 13-8. Distributed Network Silence

To configure Distributed Network Silence, follow the steps in section “Programming Central 
Network Silence” of this chapter for each node. Repeat Steps 3 through 7 for every node on the 
network.
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Programming 
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Note: 1. Do not reset a Node using Central Network Reset if you cannot see all the alarms associated to 
that node. When reset is pressed, P210 goes ON in every node it can reset. If the node where 
reset is activated has no alarms, it immediately turns ON the P211 pseudos on all nodes. However 
the system in alarm is not ready for this and latches.

          2. If a TSW has a UT connected to it, put P210 of the UT into L0 to reset the UT.

Any 4007ES node can be configured as the Central Network Reset Node. Keep the following 
in mind when programming Central Network Reset.

• This application performs separate internal Detector Reset and System Reset.

• All General Alarm Points must be monitored and SMPL-controlled by the Central Node.

• System Points involved:

- P210 Network Detector Reset/L103 External Detector Reset Points

- P211 Network System Reset/L104 External Control Reset Points

Figure 13-9. Central Network Reset

1. Open the network job, using the network programmer. Open the job for the node that will 
serve as the Central Reset Node. 

2. When the ES Panel programmer appears, click on the Network tab at the top of the 
programmer. When the Network window appears, click on the Network Points subtab at the 
bottom of the Network window.

3. Right click in the Network window. When the choices appear, click on Edit Externals. A 
dialog appears. Click on the drop down list box and choose one of the nodes on the network.

4. Click OK to close the dialog. When you do this, a tag list containing the public points from 
the selected node appears. Click on P210 and press the space bar to select the point. Click 
P211 and press the space bar to select the point. Click OK to close the taglist.

5. Repeat Steps 3 and 4 for every node on the network.
6. Click on the List tab at the top of the programmer. When the List window appears, click the 

General List subtab at the bottom of the window. Scroll through the list, right click on L103 
and select Tag List. 

7. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click the 
Network Externals check box. All of the External Points appear. 

8. Click on the entry for P210 and press the space bar.
9. Repeat Steps 6 through 8 for every node on the network.
10. Click on the List Tab at the top of the programmer. When the List window appears, click 

the General List subtab at the bottom of the window. Scroll through the list, right click 
L104 and select Tag List.

Continued on next page
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Programming 
Central Network 
Reset

11. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click on 
the Network Externals check box. All of the External Points appear.

12. Click on the entry for P211 and press the space bar.
13. Repeat Steps 10 through 12 for every node on the network.

Programming 
Distributed 
Network Reset

With Distributed Network Reset, the following occurs:

• Each node controls its own General Alarm Points.

• System Reset can be initiated from any node and all other nodes may also experience the 
reset operation.

• System Points involved: P212 Detector/System Reset, and 105 External Entire System Reset 
Points.

Figure 13-10. Distributed Network Reset

To configure Distributed Network Silence, do the following on each node.

1. Open the network job, using the network programmer.Open the job for one of the nodes. 

2. When the ES Panel programmer appears, click on the Network tab at the top of the 
programmer. When the Network window appears, click on the Network Points subtab at the 
bottom of the Network window.

3. Right click in the Network window. When the choices appear, click on Edit Externals. A 
dialog similar to the following appears. Click on the drop down list box and choose one of 
the nodes on the network.

Figure 13-11. Choose Node

4. Click OK to close the dialog. When you do this, a tag list containing the public points from 
the selected node appears. Click on P212 and press the space bar to select the point. Click 
OK to close the taglist.

Continued on next page
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5. Click on the List tab at the top of the programmer. When the List window appears, click on 
the General List subtab at the bottom of the window. Scroll through the list, right click on 
L105 and select Tag List. 

6. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click on 
the Network Externals check box. All of the External Points appear.

7. Click on every entry for P212 and press the space bar to add the entry to L106.
8. Repeat Steps 3 through 7 for every node on the network.

Distributed 
Configuration

The digital pseudo points P463 and P464 are used to raise a trouble when a CO sensor is within 
6 or 12 month of its expiration date. A transition from off to on of the digital pseudo point will 
trigger a check on all CO sensors within the local panel. On site, where multiple panels are 
linked together over the network, it is possible to synchronize the 2 digital pseudo points on 
every node. To do so, the remote node must declare the local node’s P463 as External, since 
P463 and P464 are always public by default. Once P463 is imported to the remote node’s job, 
its L170 is automatically updated to include the imported digital pseudo point. The same 
applies to P464 and L171. So when the remote node P463 is turned on, default SMPL equation 
0-164 will turn the local node’s P463 to on. To declare an external point, refer to the section 
“Procedure to Declare External Points” in this chapter.

Figure 13-12. Distributed Configuration

1. Open the network job by using the network programmer. 

2. Open the job for the node that will serve as the central reset node.
3. When the ES Panel programmer appears, click the Network tab at the top of the 

programmer. 
4. When the Network window appears, click the Network Points subtab at the bottom of the 

Network window.
5. Right click in the Network window. 
6. When the choices appear, click on Edit Externals. A dialog box appears.
7. Click on the drop-down list box and choose one of the nodes on the network.
8. Click on OK to close the dialog. A tag list containing the public points from the selected 

node appears.
9. Click on P463 and press the space bar to select the point.
10. Click on P464 and press the spacebar to select the point.
11. Click OK to close the taglist.
12. Repeat Steps 5 to 11 for every node on the network.

Node 4
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3:P463
L171
1:P464
2:P464
3:P464

Node 1
L170
2:P463
3:P463
4:P463
L171
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3:P464
4:P464

Node 2
L170
1:P463
3:P463
4:P463
L171
1:P464
3:P464
4:P464

Node 3
L170
1:P463
2:P463
4:P463
L171
1:P464
2:P464
4:P464
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Required Operations

Introduction To comply with ULC standards, there are indicators and a key that must be programmed and 
labeled, as outlined in this section. The LED indicators required are for Manual Evacuation, 
Ground Fault, and AC Power On. User Button 1 is designated as the Manual Evacuation key.

Procedure For ease of programming, there is a check box in the Card Properties section of the Color 
User Interface properties. Follow the steps outlined below to program the ULC required 
items.

1. Click the Hardware tab and expand the Unit 0, Box 1, Bay 1, and Block A icons to display 
the Color User Interface icon, see Figure A-1. Click the + signs to the left of the Unit 0, Box 
1, Bay 1, and Block A icons to expand them.)

2. Right click the Color User Interface icon (highlighted in Figure A-1) and select Properties.
3. Click check box S527 Operation, as shown in Figure A- 2.
4. Click OK to close the dialog box.

Figure A-1. Expanded View of Hardware Configuration

Continued on next page
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Procedure

Figure A- 2. Color User Interface Properties with S527 Operation Check Box

Note: In compliance with ULC requirements, the slide-in label for LEDs on the user interface must be 
labeled as shown in Figure A- 3.

Figure A- 3. ULC Labeling Requirements for LEDs
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Introduction To comply with ULC standards when using the Alarm Cutout Timer feature, there must be a 
yellow LED dedicated to indicate when the timer has expired. 

Note: The LEDs adjacent to the LCD must be used for other ULC indication requirements, therefore the 
inclusion of the Alarm Cutout Timer feature will require the additional LED Module (4007-9805).

Enabling Alarm 
Cutout Timer

To enable the Alarm Cutout Timer, do the following:
1. Click the Panel tab.

2. Click the Systems Options subtab located at the bottom of the programmer.
3. Click the Alarm Cutout Timer checkbox. Specify the timer value on the Seconds box to the 

right of the checkbox.

Programming the 
LED

Step 1: Assigning a digital pseudo point for the LED.

1. Click the Point tab.

2. Scroll until the points with the Digital device type are visible. Select a point which has an 
empty custom label field. (For purposes of demonstration, pseudo point P700 has been 
selected.)

3. Right click on the point selected and select Properties.
4. Enter the description in the custom label field, as shown in Figure A- 4.
5. Click OK.

Figure A- 4. Pseudo Point Properties

Step 2: Create Custom Control equations for pseudo point operation.

1. Review Chapter 8 of this manual for the process of creating Custom Control equations. 

2. Create the equation shown below in Figure A-5, which turns the assigned pseudo point 
ON when the Alarm Cutout Timer expires.

3. Create a second equation, shown in Figure A-6, which turns the assigned pseudo point 
OFF when a subsequent alarm resounds the signaling devices and when the system is 
reset.

Continued on next page
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Programming the 
LED

Figure A- 5. Custom Control Equation to Turn ON Pseudo Point

Figure A- 6. Custom Control Equation to Turn OFF Pseudo Point

Step 3: Program the LED to reference the assigned pseudo point.

1. Review the section detailing how to program the LED module, see Chapter 6.

2. Select a YELLOW LED to program. Set the Mode to ON and set the Reference Address to 
the pseudo assigned in Step 1, as shown in Figure A-7.

3. Click OK.
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Figure A- 7. LED Module Properties 
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Introduction To comply with ULC standards when using the 4007ES for releasing service, program a Pre-
Discharge red LED, a Discharge red LED, and the abort switches to cause a system trouble 
when activated (UL864 requires a system supervisory which is default). You may need to 
program a Releasing Service Signal Silence button with yellow LED. If your releasing job 
includes abort switches, you are required to program an abort trouble LED. 
Notes: 1. Since the LEDs adjacent to the LCD must be used for other ULC indication requirements, the 

inclusion of releasing service in the panel requires the additional LED Module (4007-9805).

2. If you have multiple Hazard Areas, repeat the steps below for each Hazard area as required. 
Label the insert for the LEDs appropriately to identify the function and the hazard zone that is 
being referred to.

Pre-Discharge 
LED 
Programming 
(Red LED)

A Pre-Discharge LED Programming (Red LED) is required for every Hazard Area.
The Pre-Discharge LED activates whenever the system is in the Pre-Discharge State. The LED 
will be off when the system has discharged. 
An example program follows.

1. Open the suppression releasing wizard for that hazard and write down the list number 
created for Manual Release Points and Automatic Release Points (L268 and L269 in this 
example).

2. Pick any available digital pseudo point (P720 in this example) and program it to turn ON 
whenever a point in the lists from step 1 are detected going active.

Continued on next page
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Pre-Discharge 
LED 
Programming 
(Red LED)

3. Write an equation to turn off the LED when the zone releases.

4. Write (or add to an existing equation) the equation to turn off the digital pseudo during 
system startup or upon system reset.

5. Choose an available RED LED on the LED Module (under the Hardware tab in the 
programmer) and set its mode as "ON" and set the reference address to the list that was 
assigned.
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Discharge LED 
Programming 
(RED LED)

Discharge LED Programming (RED LED) is required for every Hazard Area.
The Discharge LED activates when the suppression release device is in the released state 
(solenoid is activated). The LED clears upon system reset or when the solenoid is deactivated. 
Below is an example program.

1. Click the Custom Control tab. 

2. Click the Suppression Release Wizard subtab.
3.  Right-click the title (next to the wizard graphic) and select Properties to open the Hazard 

Area. 
4. Select the Points tab and write down the List assigned to Suppression Dump Points.

5. Choose an available RED LED on the LED Module located under the Hardware tab. Set its 
mode as "ON" and set the reference address to the list that was assigned.
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Abort Switch 
Active

 Program a LED to display that an abort switch is active in a hazard area. The LED will be on 
whenever an abort is activated in during a releasing service alarm. It will not turn on during 
normal supervisory conditions.

1. Open the digital Pseudo Point list and look for a digital pseudo point created by the 
Suppression Release Wizard called SupRel Abort Switch Activate- yourhazardname. It 
should be towards the end of the list as the wizard just selects the next available digital 
pseudo point.

2. Choose an available Yellow LED on the LED Module located under the Hardware tab. Set 
its mode as "ON" and set the reference address to the digital pseudo point that was assigned.

Abort Switch 
Trouble during 
Normal 
Supervisory 
Conditions

This programs the panel such that an abort switch causes a trouble when activated during 
normal supervisory conditions. If the hazard area enters alarm while the abort switch is 
pressed, or the abort switch is activated while the hazard area is in alarm the abort switch will 
behave normally.

1. Change / Program the abort IAMs type from SUPABRT to a UTILITY point type in the 
Hardware tab for the IDNet devices. These IAMs should have already been assigned to the 
Hazard Area in the Suppression Release Wizard. If not, assign them now.

Continued on next page

IMPORTANT:

In order to program the Abort Switch Trouble During Normal Supervisory 
Conditions function, disable the Suppression Release Wizard in custom 
control. The equations stay in custom control but you are not able to edit them 
through the wizard. Any future changes to the hazard area will need to be 
manual.
A-10



4007ES Panel Programmer Manual (579-1167)
Releasing Specific Controls and Indications, Continued

Abort Switch 
Trouble during 
Normal 
Supervisory 
Conditions

2.  Configure three unused digital pseudo points to be used as two new troubles and a 
supervisory point. Label them as follows (change HAZNAME to the appropriate label for 
your hazard area):

3.  In the Suppression Release Wizard that you are working on, right click the title (next to 
the wizard graphic) and select Properties to open the Hazard Area. 

4. Select the points tab and write down the lists assigned to Abort Switches and Automatic 
Release Points.

5. Enable Manual Editing of the suppression release wizard equations. 
 

Right click the wizard for that hazard and select Enable Manual Edit. Click Yes in the 
confirmation box.

Continued on next page

IMPORTANT: When you enable manual edit the Suppression Release Wizard cannot be 
used to modify this hazard area.
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Abort Switch 
Trouble during 
Normal 
Supervisory 
Conditions

6. Click the List tab in the Programmer and right click the list for the abort switches made 
during step 3 and select where used to show all the custom control equations this list is 
referenced in.

Find these equations in the custom control user equations and whenever the abort switches 
list is referenced for status SUPV, change it to ABNORM. For example:

7. Add a HAZNAME - Abort Switch Trouble equation to annunciate troubles from this abort 
switch as shown below when the hazard area is not in alarm. Use the lists you wrote down 
from above as the input lists and the trouble digital pseudo point you created with the Abort 
Active - No Alarm as the output.

8. Add a HAZNAME - Abort Switch Short Circuit equation to annunciate short troubles 
from this abort switch as shown below. Use the abort list you wrote down from above as the 
input lists and the trouble digital pseudo point you created the Abort Switch Short as the 
output.

Continued on next page
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Abort Switch 
Trouble during 
Normal 
Supervisory 
Conditions

9. Add a HAZNAME - Abort Switch Supervisory equation to annunciate a supervisory when 
the abort switch is activated in alarm as shown below. Use the lists you wrote down from 
above as the input lists and the supervisory digital pseudo point you created the Abort 
Switch Active as the output.

Releasing Service 
Signal Silence 
Programming - 
Optional 
(Pushbutton and 
Yellow LED)

The Releasing Service Signal Silence button (and Yellow LED indicator) is used instead of a 
silence for all systems that contain releasing and standard evacuation zones. The separate 
silence LED is used to ensure that someone trying to silence the evac zone does not 
inadvertently silence a releasing zone thereby disabling the warning of a possible toxic release. 
When this feature is used, the normal signal silence will not silence the special service NACs 
(such as, releasing warning NACs). The Releasing Service Signal Silence button should not 
prevent the release, it only silences the warning NACs. Note that an escalation of the releasing 
sequence (going from warning to released) will not re-sound the warning NACs. 
An example program follows. In this example both the visual and audible Release Notification 
NACs are silenced.
See the following for a program example:

1. Program a button and a LED for Releasing Service Signal Silence (RSSS). 

a. Move the power LED function to the 4010-9805 LED module because the panel defaults to the 
bottom LED programmed as power when configured for ULC operation. This vacates a LED next 
to the silence button. 

b. If a second Hazard Zone is required, do the same for the ground fault trouble. To move the 
functionality of the LED mimic the mode, reference address, point type and any custom labels to 
an available LED.

c. Configure the switch as Mode PBT* and select an available digital pseudo point as a reference 
address. The Custom Label appears on the display for the switch.
*Note: In this example, the lowest switch, next to the ground fault LED, is chosen.

d. Label it appropriately for the hazard area you are silencing. 

e. Configure the LED to as Mode ON and have it track another available digital Pseudo.

Continued on next page

IMPORTANT:

In order to program the Releasing Service Signal Silence function, disable the 
Suppression Release Wizard in Custom Control. The equations will stay in 
Custom Control but you will not be able to edit them through the wizard. Any 
future changes to the hazard area will need to be manual.
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Signal Silence 
Programming - 
Optional 
(Pushbutton and 
Yellow LED)

2. Check if there are any manual or automatic alarms in the system and if someone is 
requesting to silence the NACs. The equation below checks this. 

•If there is an alarm in the system AND someone is pressing the RSSS button (indicated by 
the pseudo chosen for the button) the output holds the NACs off at a higher priority than 
releasing would normally turn them on. 

•If your job specific requirements specify that the releasing NACs turn on at a higher 
priority you may need to adjust these numbers. The pseudo for the LED is also held on 
indicating the releasing NACs are silenced. 

3. Add to the reset equation for the pre-discharge LED above to reset the NACs and the LED 
during a system reset or startup.

Continued on next page
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Releasing Service 
Signal Silence 
Programming - 
Optional 
(Pushbutton and 
Yellow LED)

4. Disable the Suppression Release Wizard to delete the default equation written by the 
Suppression Release Wizard to silence the NACs on system silence. If it is not deleted it 
will still silence the hazard area.

a. Right click the wizard for that hazard and select enable Manual Edit. 

b. Click Yes in the confirmation box that follows.

c. Return to your custom control equations and find the equation that the Suppression Release 
Wizard labeled On System Silence - yourhazardname

d. Right click and select Delete.
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	4. Once in the Software Download area, click the 4007ES Hybrid. This should be the latest revision of the ES Programmer for the 4007ES panel.
	5. Once the file is loaded a security warning will ask you if you wish to proceed. Click Run.
	6. An authorization request to copy the file to your computer’s C Drive appears. Click OK. The file 4100ESProg will then start to download to the C directory of your computer.



	Getting Started
	Installing the Software
	1. Go to the computer C Drive and open the 4100ESProg folder.
	2. Double click on the ES programmer executable file (.exe).
	3. The Software Licensing agreement appears. Read the agreement and click Next to continue the installation.
	4. A prompt window requesting the user to specify the destination folder for the programmer files appears.
	5. Progress indicators appear, displaying the progress of the file copy operations.
	6. The next prompt requests that the user restart the computer.
	7. Click on Finish to restart and complete the installation.

	Starting the Programmer
	1. Open the Windows Start menu.
	2. Click on the All Programs menu.
	3. Click on the Simplex menu item.
	4. Click on the version of the ES Panel Programmer you want to open and a menu appears.
	5. To start the Programmer select ES Panel Programmer from the menu.
	Figure 1-1 . Starting the ES Panel Programmer
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	Creating Jobs
	1. Start the ES Panel Programmer:
	2. In the New Job window, select the job type:
	3. Enter the job number. The job name should be 8 characters long and start with a number.
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	Table 3-1 . Job Naming Convention
	4. Select the path to the file in which the job will be stored.

	Opening Existing Jobs
	1. Start the ES Panel Programmer.
	2. Click on the Open icon or select Open from the File menu to access the Open window.
	3. Open the job’s folder. It will have the same name as the job.
	4. Once in the folder, open the “.SDB4100U” file.

	Setting Job Preferences
	1. Once in the job, open the Edit menu and select Preferences.
	2. Preference allows the user to configure the following options:
	3. Click on OK once all the options are set.


	Working with Jobs, Continued
	Job Notes
	1. Once in the job, either click on the Notes icon or open the Tool menu and select Notes.
	2. The Notes window opens and the user can type in relevant job notes. These notes are saved with the job for future reference.

	Saving Jobs
	1. Open the File menu and click on the Save As option.
	2. Select either the Copy option or the Rename option:

	Building a Job
	1. Open the job.
	2. Make the programming changes.
	3. Start the build by either clicking on the Build icon or by selecting the Build item from the Build menu.
	4. The Revision History window appears and the user must enter:
	5. The Job Builder window then appears and displays all the elements in the job and their build status. Once the compilation is complete, the final dialogue in the window will read either:


	System Requirements
	Archiving a Job
	1. Save the job.
	2. Open the Edit menu and click on the Archive menu item.
	3. The Programmer Archive Utility window opens and requests that the user name the file and select the directory to which the file will be saved.
	4. Click on Archive. A progress meter appears, showing the progress of the operation. When this bar disappears, the archive operation is complete. The archived file is saved as .SDA4100U.
	1. Open the File menu and click on the Restore menu item.
	2. The Programmer Restore Utility window opens. Use the Look In search box to locate the archived file.
	3. Once the file is located, click on it so that its name appears in the File Name box.
	4. Click on Continue.
	5. The Browse for Folder window appears and requires that the user select the directory and file to which the file will be restored. It is recommended to use the 4100UJOB Folder.
	6. If a file with that name already exists, the user will be prompted to:
	7. The archived file will then open as a read-only job. To save the job as a different version in the 4100U folder, the user must use the Save As function.

	Backing Up a Job
	1. Open the File menu and select the Backup menu item.
	2. The Programmer Backup Utility window opens and requests that the user name the file and select the directory to which the file will be saved.
	3. Click on Backup. A progress meter appears, showing the progress of the operation. When this bar disappears, the backup is complete.
	1. Open the File menu and click on the Restore menu item.
	2. The Programmer Restore Utility window opens. Use the Look In search box to locate the backup file.
	3. Once the file is located, click on it so that its name appears in the File Name box.
	4. Click on Continue.
	5. The Browse for Folder window appears and requires that the user select the directory and file to which the file will be restored.
	6. If a file with that name already exists, the user will be prompted to:
	7. The backup file will then open as normal job.
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	Notice to users, Installers, AHJ, and other Involved Parties
	Table 4-1 . Programming Features and Options

	Panel Information
	1. Click on the Panel tab and select the General Information sub-tab.
	2. Fill out the information requested on the page:

	Panel Information
	System Options
	1. Click on the Panel tab and select the System Options sub-tab.
	2. Configure the options that appear on the page. The following tables list and define the different options.
	Table 4-2 . General System Options (Continued)
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	System Options
	Table 4-3 . Active Status Reminder System Options
	1. Make sure the box labeled Enabled is checked.
	2. Set the interval at which the piezo should sound. The range is from 0 to 18 hours. The default is 8 hours.

	1. Make sure the box labeled Enabled is checked.
	2. Set the interval at which the piezo should sound. The range is from 0 to 18 hours. The default is 8 hours.

	1. Make sure the box labeled Enabled is checked.
	2. Set the interval at which the piezo should sound. The range is from 0 to 18 hours. The default is 8 hours.

	1. Make sure the box labeled Enabled is checked.
	2. Set the interval at which the piezo should sound. The range is from 0 to 18 hours. The default is 8 hours.
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	System Options
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	Table 4-6 . Compatible Alert Tone Value

	User Access Level Configuration
	1. Click on the Panel tab and select the Access Levels sub-tab.
	2. Double click on the table entry to open its Object Properties window.
	3. Select one of four user levels for the display function. Basic display functions, such as System Reset and Change Time and Date, are usually assigned to user level 1. More sensitive display functions, such as Remote Download, are typically assigne...
	4. Click on OK to confirm the selection.

	Passcode Configuration
	1. Click on the Panel tab and select the Passcode Assignments sub-tab.
	2. Double-click on a table entry to open Object Properties window.
	3. Enter a passcode, composed of up to ten numbers.
	4. Assign the access level to the passcode.
	5. Click on OK to confirm the selection.

	Features Configuration
	1. Click on the Panel tab and select the Features sub-tab.The usable features are listed in the Programmer/Runtime Features window.
	2. To enable the options under Programmer and Runtime on the left panel, enter the software key provided by an authorized Simplex representative with the appropriate access codes.
	3. Click on Update Access Codes to complete the action.

	System Options
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	Specifying Hardware Components
	Hardware Tab Overview
	Table 5-1 . Hardware Tab Icons

	Adding Hardware
	1. Locate the hardware component that you want to add from the Available Hardware window on the right of the programmer screen.
	2. Click on the hardware and drag it into the Hardware Configuration window on the left of the programmer screen, into the proper directory:
	3. When the component is in the proper place, release the mouse. If the component was successfully added, it appears in the Hardware Configuration menu. If the component cannot be added to the configuration, an error message appears with the problem ...


	Specifying Hardware Components, Continued
	Adding Hardware
	1. Right click in the Hardware component window. An action list appears.
	2. Select the type of hardware you want to add to the programmer from the action list:

	Adding a City/ Relay Card
	1. In the Hardware Configuration window, double click on the IDNAC or the NAC power supply component.
	2. Click on the Data Entry tab.
	3. Select the radio button that corresponds to the card you want to add (City connect or Relay).

	Adding the Additional IDNet Loops
	1. In the Hardware Configuration window, double click on IDNAC power supply, then double click on IDNet+ Multiloop.
	2. Click on the Loop Editing tab.
	3. Select the first unused card 2: loop B isolator.
	4. Change the device type to Isolator/Expanded point capacity.
	5. Repeat steps 3 and 4 with the second unused card 2: loop C isolator.

	Removing Hardware
	1. Locate the hardware component in the Hardware Configuration window.
	2. Right click on the hardware to open the action list.
	3. Select Delete.
	4. A warning message appears warning you that deleting a hardware component deletes all references to that component. Click Yes if you wish to continue. If the component cannot be deleted, a second warning appears with the specifics of why the compon...

	Editing Properties
	Figure 5-1 . Box Properties Window
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	Annunciator Numbers
	Annunciator Number Sharing Rules

	Specifying Hardware Components, Continued
	Editing Basic Card Properties
	Figure 5-2 . Card Properties Window - Color User Interface shown as example
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	Editing Standard Component Properties
	Introduction
	Accessing Properties
	1. Open the Hardware tab.
	2. Select the hardware component from the Hardware Configuration window and double-click on it to open the editing window.

	Editing the Unit Properties
	Editing the CPU
	1. Configure the communication settings by selecting the Baud Rate, Parity, Data Bits, and Stop Bits fields to the values required by the attached device. It is recommended that you use the following default settings whenever possible.
	2. Click on the Port Data button. The RS323 Port Data Entry window opens (Figure 6-1).



	Editing Standard Component Properties, Continued
	Editing the CPU
	3. Click the Gen. Info tab. Enter the information requested. Click on Apply and then OK to confirm the selection (Figure 6-1).
	Figure 6-1 . 4007 CPU - Gen Info Tab

	4. Click on the Access Level tab in the RS232 Port Data Entry window (Figure 6-2). This tab allows you to set the access level for the various system operations that can be carried out via the service port.To set an access level for one of the servic...
	Figure 6-2 . 4007 CPU Access Levels and Port Options

	5. Click on the Port Options tab in the RS232 Port Data Entry window. This tab contains options that apply to the way data appears on the display connected to the service port. These are read-only fields. Click OK to return to the Service Port tab.
	6. Click in the TrueInsight Remote Service Gateway box to enable the use of the Remote Service Gateway.
	1. Click the Use Default box or enter the name that the building network has attributed to the FACP.
	2. Click on Apply to confirm the selection.


	Editing Standard Component Properties, Continued
	Editing the Color User Interface
	1. Enter the card’s custom label. This label should make the card easily identifiable.
	2. If required, select a unit, a box, and a bay number.
	1. Click on the Hardware tab.
	2. Expand the unit, the box, and the bay combination in which the annunciator resides.
	3. Double click on the annunciator's icon.
	Figure 6-3 . Color User Interface - Annunciator Settings Tab

	4. Click on the Annunciator Setting tab (see Figure 6-3).
	5. This sheet has a series of rows on the left, identifying the functions that can be performed from the annunciator. Each row has two checkboxes: Keyswitch Required and Override on Alarm. Check or uncheck these boxes, using the following guideline.


	Editing Standard Component Properties, Continued
	Editing the Color User Interface
	1. Select a switch mode from the drop-down list.
	2. Enter a reference address. Press F9 to access the TagList window.
	3. Edit the point’s custom label if required. This label should make the point easily identifiable.
	4. Check the Invert Pushbutton State box to switch down the point.
	Figure 6-4 . Color User Interface - Point Editing Tab

	1. Select the appropriate mode from the drop-down list.
	2. Enter a reference address.
	3. Select the appropriate point type from the drop-down list.
	a. The default point type for the first two LED points are LEDRED
	b. The default point type for the third LED point is LEDGREEN

	4. Edit the point’s custom label if required. This label should make the point easily identifiable.


	Editing Standard Component Properties, Continued
	Editing the Color User Interface
	1. Click on Import.
	2. Browse to import the appropriate MsgLib.
	3. Click on Open.
	4. Edit the Name and Date fields.
	1. Check the Enable Custom Image check box.
	2. Click on Import Image...
	3. Browse to select the appropriate image.
	4. Click on Open > Apply.
	Figure 6-5 . Color User Interface - Display Options
	Figure 6-6 . Color User Interface - Access Levels


	Editing the IDNAC Power Supply
	1. Enter the card’s custom label. This label should make the card easily identifiable.


	Editing Standard Component Properties, Continued
	Editing the IDNAC Power Supply
	1. Configure the Depleted Battery Cutout option. If selected, the power supply card shuts itself off after detecting a depleted battery condition when no AC power is present. If this option is selected, a jumper must be installed on the power supply ...
	2. Select the optional cards that are connected to the power supply card. The choices are:
	Figure 6-7 . IDNAC - Data Entry Tab

	3. Click in the 25V Regulator box if a 25V regulator card, 4007-9802, is used with the FACP.
	4. Click OK to confirm the selection.
	1. Select a point type from the drop-down menu.
	2. Edit the AuxNAC point type custom label. This label should make the point easily identifiable.
	3. Click on Apply > OK to confirm the edits.
	Figure 6-8 . IDNAC - AuxNAC Tab

	1. Select a point type from the dropdown menu.
	2. Edit the Aux Relay point type custom labels. This label should make the point easily identifiable.
	3. Click on Apply > OK to confirm the edits.
	Figure 6-9 . IDNAC - Aux Relay Tab



	Editing Standard Component Properties, Continued
	Editing the IDNAC Power Supply
	1. The choice are:
	2. Configure the devices that are attached to the IDNAC Power Supply.
	Figure 6-10 . IDNAC - Point Editing Tab

	3. Depending on the selected device, enter the required information in the Properties section. Consult Chapter 7 for the details on how to edit points for TrueAlert devices.

	Editing the IDNET Multiloop
	1. Enter the card’s custom label. This label should make the card easily identifiable.
	2. Click in the box beside the following functions to activate them:


	Editing Standard Component Properties, Continued
	Editing the IDNET Multiloop
	1. Select an IDNet point to configure in the table.
	2. Assign a device type to the IDNet point.
	3. Assign a point type to the IDNet point.
	4. Enter a custom label. This label should make the IDNet point easily identifiable.
	Figure 6-11 . IDNet Multiloop - Point Editing Window

	5. Tag the IDNet point to a Zone by clicking on Zone List. The TagList window is displayed (Figure 6-12).
	a. Scroll through the list and select the zone to populate.
	b. Press the space key. A “>>” symbol appears to the left of each point to indicate that it is selected.
	Figure 6-12 . TagList Window

	6. Click OK. If an error message is displayed, click OK and make the appropriate modifications.
	7. Click Apply > OK to confirm the edits.
	Figure 6-13 . IDNet Multiloop - Loop Editing Window



	Editing Standard Component Properties, Continued
	Editing the NAC Power Supply
	1. Enter the card’s custom label. This label should make the card easily identifiable.
	1. Configure the Depleted Battery Cutout option. If selected, the power supply card shuts itself off after detecting a depleted battery condition when no AC power is present. If this option is selected, a jumper must be installed on the power supply ...
	2. Select the optional cards that are connected to the power supply card. The choices are:
	3. Select the NAC options for the wiring. The choices are:
	4. Click in the Wheelock Devices (Code 3) box if ONLY Wheelock device are used with the FACP.
	5. Click in the 25V Regulator box if a 25V regulator card is used with the FACP.
	6. Click Apply > OK to confirm the edits.
	Figure 6-14 . NAC - Data Entry Tab



	Editing Standard Component Properties, Continued
	Editing the NAC Power Supply
	1. Select a circuit to configure in the table.
	Figure 6-15 . NAC - NACs Tab

	2. Select a point type from the Point Type drop-down list.
	3. Enter a custom label.This label should make the point easily identifiable.
	4. Select the EOL resistance from the EOL Resistance drop-down list.
	5. Click Apply > OK to confirm the edits.
	1. Select a circuit to configure in the table.
	Figure 6-16 . NAC - AuxNAC Tab

	2. Select a point type from the Point Type drop-down list.
	3. Enter a custom label. This label should make the point easily identifiable.
	4. Click Apply > OK to confirm the edits.


	Editing Standard Component Properties, Continued
	Editing the Zone/ Relay Card
	1. The panel assigns an address when a Zone/Relay card is added. Set the card address to match the programmer assigned address.
	2. Enter the card’s custom label. This label should make the card easily identifiable.
	3. Select the location for each Zone/Relay card. By default, the selected block is F (bottom left corner). The other choices are block E, block G, and block H.
	1. Select the device type. The choices are:
	2. Select the point type.
	3. Enter the card’s custom label. This label should make the card easily identifiable.
	4. Select the EOL resistance from the EOL Resistance drop-down list.
	5. Click Apply > OK to confirm the edits.
	Figure 6-17 . Zone / Relay Card / Point Editing Tab

	6. Tag each point to a Zone by clicking on Zone List. The TagList window is displayed (Figure 6-12).
	a. Scroll through the list and select the zone to populate.
	b. Press the space key. A “>>” symbol appears to the left of the point to indicate that it is selected. Click OK. If an error message is displayed, click OK and make the appropriate modifications.

	7. Click Apply > OK to confirm the edits.


	Editing Standard Component Properties, Continued
	Editing the Zone/ Relay Card
	1. Select to which point you want to apply the auto fill from the Auto Fill drop-down menu. The choices are:
	2. To apply the same custom label to other points, check the Custom Label check box.
	3. To add an identification number after the label, check the Automatically increment last number in custom labels check box.
	4. The following fields are grayed out:
	Figure 6-18 . Zone / Relay Point Editing - Auto Fill Window

	5. Click on OK to confirm the edits.


	Editing Standard Component Properties, Continued
	Editing the Serial DACT Card Per Point
	1. The panel assigns an address when a DACT card is added. Set the card address to match the programmer assigned address.
	2. Enter the card’s custom label. This label should make the card easily identifiable.
	3. Select a card address, from 0 to 31.
	Figure 6-19 . DACT Card - Basics Tab

	1. Click on the Point Types drop-down list box and select the point type whose event codes needs to be changed. (The Next and Previous buttons allow you to scroll through the list without clicking on the drop-down list box.)
	2. Click on the Enable Edit checkbox at the top left of the window.
	3. A warning window appears. Click on Yes.
	Figure 6-20 . DACT - Event Codes Tab

	4. The non-editable fields remain grayed out. Define the appropriate event codes for both the Event and the Restoral columns.
	5. Click Apply > OK to confirm the edits.


	Editing Standard Component Properties, Continued
	Editing the Serial DACT Card
	1. Click on the Enable Edit checkbox at the top right of the window.
	2. A warning window appears. Click on Yes.
	3. The non-editable fields remain grayed out. Define the appropriate local points for both the Event and the Restoral columns.
	4. Click Apply > OK to confirm the edits.
	Figure 6-21 . DACT - Local Point Tab

	1. Click on a point in the grid.
	2. Edit the appropriate fields for both the Event and the Restoral columns.
	3. Edit the SDACT point type name and the SDACT point type description if necessary.
	4. Click Apply to confirm the edits
	1. Click on a point in the grid.
	2. Click on Delete.
	3. Click on Apply to confirm the edits.
	Figure 6-22 . DACT - Point Types Tab

	1. Click on Add.
	2. Edit the SDACT point type name and the SDACT point type description. These labels should make the points easily identifiable.
	3. Edit the appropriate fields for both the Event and the Restoral columns.
	4. Click Apply > OK to confirm the edits.


	Editing Standard Component Properties, Continued
	Editing the Serial DACT Card
	1. To edit a point, click on the point or use the up and down arrow with the <space bar> to toggle point selection.
	2. Depending on the point, edit the fields as necessary. The non-editable fields remain grayed out.
	Figure 6-23 . DACT - Points Tab


	Editing the Event DACT Card
	1. The panel assigns an address when a DACT card is added. Set the card address to match the programmer assigned address.
	2. Enter the card’s custom label. This label should make the card easily identifiable.
	3. Select a card address, from 0 to 31.


	Editing Standard Component Properties, Continued
	Editing the Event DACT Card
	Figure 6-24 . DACT Event Reporting - Basics Tab
	1. Select the Enable Edit checkbox.
	2. A warning window appears. Click on Yes.
	3. Define the appropriate local points for both the Event and the Restoral columns.
	4. Click Apply > OK to confirm the edits.


	Editing Standard Component Properties, Continued
	Editing the Event DACT Card
	1. Select the Enable Edit checkbox at the top right of the window.
	2. A warning window appears. Click on Yes.
	3. Define the appropriate local points for both the Event and the Restoral columns.
	4. Click Apply > OK to confirm the edits.
	1. To edit a point, click on the point or use the up and down arrow with the <spacebar> to toggle point selection.
	2. Depending on the point, edit the fields as necessary. The non-editable fields remain grayed out.

	48-LED Module
	1. Enter a card address for the 48-LED Module.
	2. Enter the card’s custom label. This label should make the card easily identifiable.


	Editing Standard Component Properties, Continued
	48-LED Module
	Figure 6-25 . 48-LED Module High Level
	Figure 6-26 . 48-LED Module Low Level


	Editing Standard Component Properties, Continued
	48-LED Module
	1. Select a column and then a point that needs to be edited. LED pairs are yellow and red.
	2. Select the Mode from the Mode drop-down list. Under this mode, only three options are available. If an error is detected, a red “X” is displayed in the HW Ref column. Pass the mouse over the row to display the tool tip describing the problem.
	3. Create Reference Address for the points by pressing F9.
	4. Enter a point custom label. This label should make the point easily identifiable.
	5. When editing the 8 points of the Display Column 6, LED pairs can be either yellow/red or yellow/green.
	6. Repeat for each point that needs to be edited.
	1. Select a column and then a point that needs to be edited. Point type:
	2. Select the Mode from the Mode drop-down list.
	3. Create Reference Address for the points by pressing F9.
	4. When editing the 8 points of the Display Column 6:
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	Editing TrueAlert Devices Properties
	Introduction
	1. Go to the Hardware Configuration window.
	2. Double click on the IDNAC Power Supply icon.
	3. Click on the Point Editing tab.
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	TrueAlert ES AO Appliance Point Editing
	Table 7-1 . TrueAlert ES AO Point Editing Options
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	TrueAlert ES VO Appliances Point Editing
	Table 7-2 . TrueAlert ES VO Point Editing Options
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	Table 7-3 . TrueAlert ES VO-H Point Editing Options
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	Table 7-4 . TrueAlert ES VO-L Point Editing Options
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	Table 7-5 . TrueAlert ES VO-LH Point Editing Options
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	Table 7-6 .TrueAlert ES AV Point Editing Options
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	TrueAlert ES AV-H Appliance Point Editing
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	Table 7-8 .TrueAlert ES AV-L Point Editing Options
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	Table 7-8 . TrueAlert ES AV-L Appliance Point Editing, Continued
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	TrueAlert ES AV-LH Appliance Point Editing
	Table 7-9 .TrueAlert ES AV-LH Point Editing Options


	Point Editing for TrueAlert Device, Continued
	TrueAlert ES AV- LH Appliance Point Editing
	Table 7-9 . TrueAlert ES AV-LH Appliance Point Editing, Continued


	Point Editing for TrueAlert Device, Continued
	ISO Options
	Table 7-10 .TrueAlert Isolator Editing Options

	Repeater Options
	Table 7-11 . Repeater Editing Options


	Point Editing for TrueAlert Device, Continued
	DCAI Options
	Table 7-12 . DCAI Editing Options

	TrueAlert STRB Appliances Point Editing
	Table 7-13 . TrueAlert STRB Point Editing Options


	Point Editing for TrueAlert Device, Continued
	TrueAlert Horn Appliance Point Editing
	Table 7-14 . TrueAlert Horn Point Editing Options
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	TrueAlert A/V Appliances Point Editing
	Table 7-15 . TrueAlert AV Point Editing Options
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	Viewing, Adding, and Editing Lists
	List Tab
	Sort Function
	Figure 8-1 . Sort Window

	Custom Label Spell Check
	1. Position the pointer in the point list and press the F7 button. (Alternatively, you can rightclick in the List window and select Spell Check when the list of options appears.)
	2. Correct the misspelled word in any of the following ways. (Use the Ignore and Ignore All buttons to ignore the misspelled word.)
	1. Position the pointer in the List Window and press the CTRL + F key combination. (Alternatively, you can right click in the List Window and select Search or Find from the list that appears.)
	2. Enter the Search text in the Search What field. Click on the Search in Column field and select the column in which to search. Click on Search Next to start the search.
	3. Press the F3 key to continue searching the List Window for another occurrence of the item you are searching.


	Viewing, Adding, and Editing Lists, Continued
	Managing Points
	Turning Autogen Off and On from the General List Tab
	1. Click on the List tab at the top of the programmer.
	2. Click on the General List subtab at the bottom of the window.
	3. Right click on the list whose autogen property you want to change. Select Properties from the list that appears. A dialog similar to Figure 8-2 appears.
	Figure 8-2 . List Properties Window

	4. Click on the AutoGen field and change the setting.


	Viewing, Adding, and Editing Lists, Continued
	Basic Operations
	Adding a User- Defined List
	1. Open the List Window by selecting the List Tab at the top of the Programmer.
	2. Open the TagList window by either pressing the Insert key or right clicking in the List Window and selecting Add List.
	3. You can select points for the list using a combination of the following three methods. When you select points, the TagList window adds the “>>” character to the left of the point to indicate that the point is tagged.
	4. Click on the OK button in the TagList window. A dialog box appears, prompting you to name the list. Enter descriptive text and click on OK.

	Editing an Existing User- Defined List
	1. Open the list's Tag List by either right clicking on the list and selecting Tag List from the menu that appears, or click on the list and press the F9 key.
	2. When the tag list appears, click on the points you want to add or delete. Press the spacebar to toggle whether the point is tagged (included in the list) or not. Tagged points are identified by the “>>” to the left of the point name.
	3. Click on OK to accept the changes.
	4. Edit the List Label and the Alternate List Label.
	5. Press OK.


	Viewing, Adding, and Editing Lists, Continued
	Latching Supv Verification
	1. Open the List Window by selecting the List Tab at the top of the Programmer.
	2. Click on the Latching Supv Verification tab at the bottom of the List Window.
	3. Click on the Supv Verification group into which you want to move points. Right click and select Tag List.
	4. Use the mouse or arrow keys to highlight each point you want to move into the group. A point is selected when a “>>” appears to the left of the point. Repeat this step to select other points.
	Table 8-1 . Canadian/Domestic Operation

	1. Right click on one of the groups and select Properties. The Alarm Verification Properties dialog appears.
	2. Click on the Alarm Verification tab.
	3. Click on the drop-down list box and select Canadian or Domestic operation.
	Figure 8-3 . Alarm Verification Properties Dialog



	Viewing, Adding, and Editing Lists, Continued
	Latching Supv Verification
	1. Right click on the group whose name you want to change and select Properties. The Alarm Verification Properties dialog appears.
	2. Click on the List tab in the dialog.
	3. Enter a name for the group in the Description field.
	4. Click the Apply button, followed by the OK button to close the dialog.

	WalkTest™

	Viewing, Adding, and Editing Lists, Continued
	WalkTest
	1. Open the List Window by selecting the List Tab at the top of the Programmer.
	2. Click on the WalkTest tab at the bottom of the List Window. A screen similar to the one shown in Figure 8-4 appears.
	Figure 8-4 . WalkTest Tab

	3. Right click on WalkTest Group 0 and select Properties. A properties dialog appears. Click on the WalkTest tab in the dialog. Remove the checkmarks from the Monitor and Control checkboxes. Click the Apply button, followed by the OK button to close ...
	4. Select the monitor points to move as follows:
	a. Right click on the WalkTest group into which you want to move the points (for example, using Figure 8-4, right click on the line called LST WALKTEST GROUPX). When the list of options appears, select Tag List.
	b. In the Tag List, use the mouse or arrow keys to highlight each monitor point you want to move into the group. Press the space bar to tag or un-tag points to be added or deleted. A point is selected when a “>>” symbol appears to the left of the...
	c. Repeat these steps to move other monitor points into the group. When you move points, the points are automatically unselected in WalkTest Group 0 - Monitor Points and moved into the group you chose.

	5. Select the signal/relay points to move as follows:
	a. Right click on the WalkTest group into which you want to move the signal/relay points (for example, using Figure 8-4, right click on the line called LST WALKTEST GROUPX - SIGNALS/RELAYS). When the list of options appears, select Tag List.
	b. In the Tag List, use the mouse or arrow keys to highlight each signal/relay point you want to move into the group. Press the spacebar to tag or un-tag points to be added or deleted. A point is selected when a “>>” symbol appears to the left of...
	c. Repeat these steps to move other signal/relay points into the group.
	d. The points that you selected in Step b above are not automatically deleted from WalkTest Group 0 - Signals/Relays list. If you do not want these points to be in both groups, you need to open up the WalkTest Group 0 - Signals/Relays list and delete...



	Viewing, Adding, and Editing Lists, Continued
	WalkTest
	1. Click on the WalkTest tab at the bottom of the List Window.
	2. Double click on one of the WalkTest groups to view its properties window. (Alternatively, you can right click on the group and select Properties from the menu that appears.)
	3. Use the guidelines listed below to set the properties for the WalkTest group.
	Table 8-2 . WalkTest Group Property Guidelines

	4. After making changes to the WalkTest Group properties, click on the Apply button to apply the changes and then click on OK to close the window.


	Viewing, Adding, and Editing Lists, Continued
	Elevator Recall List
	Figure 8-5 . Elevator Recall Tab
	1. Open the List Window by selecting the List Tab at the top of the Programmer.
	2. Click on the Elevator Recall tab at the bottom of the List Window.
	3. Select the monitor points to move:
	a. Right click on the Elevator Shaft group into which you want to move monitor points (for example, using Figure 8-5, right click on the line called LST ELEVATOR SHAFTX PRIMARY MONITOR ZONES). When the list of options appears, select Tag List.
	b. In the Tag List, use the mouse or arrow keys to highlight each monitor point you want to move into the group. Press the spacebar to tag or un-tag points to be added or deleted. A point is selected when a “>>” symbol appears to the left of the ...
	c. Repeat these steps to move other monitor points into the group.
	d. Points that you move from Elevator Shaft 1 Primary Monitor Zones list to another group are not automatically deleted from Elevator Shaft 1 Primary Monitor Zones list. To delete points from this list, you need to highlight the Elevator Shaft 1 Prim...

	4. Select the signal/relay points to move as follows:
	a. Right click on the Elevator Shaft group into which you want to move the signal/relay points (for example, using Figure 8-5, right-click on the line called LST ELEVATOR SHAFTX PRIMARY RELAY). When the list of options appears, select Tag List. When ...
	b. In the Tag List, use the mouse or arrow keys to highlight each signal/relay point you want to move into the group. Press the space bar to tag or un-tag points to be added or deleted. A point is selected when a “>>” symbol appears to the left o...
	c. Repeat these steps for the Alternate and Shaft lists within the selected group.
	d. If you want to delete relay points from the Elevator Shaft 1 Primary Relay list, you need to first right click on the Elevator Shaft 1 Primary Relay list, select Properties, and set the AutoGen field to No. Next, press F9 to see the tag list, and ...



	Viewing, Adding, and Editing Lists, Continued
	Elevator Recall List
	1. Click on the Elevator Recall tab at the bottom of the List Window. Double click on the appropriate Elevator Recall list.
	2. Edit the description field and click on the Apply button. Click OK to close the screen.

	Zone Lists
	1. Open the Zone List tab in the programmer.
	2. Double click on an empty Zone List. The Zone List Properties window opens.
	3. Enter a custom label to describe the Zone List.
	4. Enter an alternate custom label to describe the Zone List.
	5. Click on the Select Point button; the Tag List window opens.
	6. Select the points that you want to include in the list.
	7. Click on OK to confirm the selection.
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	Custom Control
	Introduction
	In this chapter

	Custom Control Overview


	Custom Control
	Role of Lists and Pseudo Points
	Anatomy of a Custom Control Equation
	Figure 9-1 . Input Statement Example
	Figure 9-2 . Output Statement Example


	Custom Control, Continued
	Anatomy of a Custom Control Equation
	Figure 9-3 . Logical Operator: AND
	Figure 9-4 . Logical Operator: OR
	Figure 9-5 . Logical Operator: NOT

	Using a Ladder Logic Diagram to Evaluate an Equation

	Custom Control, Continued
	Using a Ladder Logic Diagram to Evaluate an Equation
	Figure 9-6 . Logic Diagram


	Custom Control, Continued
	Custom Control Window
	Figure 9-7 . Custom Control Window


	Custom Control, Continued
	Selecting User Program
	1. Right click on one of the user programs, located at the bottom of the program list, and select Add Equation from the list of options.
	Figure 9-8 . Add Equation

	2. The Custom Control Program Properties dialog (Figure 9-9) appears. Enter a name for the equation in the Label field and click on OK.
	Figure 9-9 . Equation Properties



	Custom Control, Continued
	Adding Input Statements
	1. In the Equations box, position the cursor just to the right of [INPUTS].
	Figure 9-10 . Positioning the Cursor

	2. Click Add. The dialog shown in Figure 9-11 appears.
	Figure 9-11 . Select Input Opcode Dialog

	3. Click on the drop-down list box, select one of the Opcodes, and click Next. Opcodes available: Select Opcode, Select Input Qualifier, Select Item, Select Point.
	4. The next dialogs displayed by the wizard depend on the Opcode you selected in Step 3. Follow the Wizard’s windows to create input for the equation.
	5. The Finish button becomes available when all dialogs related to the input Opcode have appeared. Click it to finish defining the input statement.


	Custom Control, Continued
	Adding Output Statements
	1. In the Equations box, position the cursor just to the right of [OUTPUTS].
	2. Click on the Add button. The dialog shown in Figure 9-11 appears.
	3. Click on the drop-down list box, select one of the output Opcodes, and click the Next button. Opcode available: Select Item, Set/Reset Priority, Select Point.
	4. The next dialogs displayed by the wizard depend on the Opcode you selected in Step 3. Follow the Wizard’s windows to create the output for the equation.
	5. The Finish button becomes available when all dialogs related to the output Opcode have appeared. Click it to finish defining the output statement.

	Floor Above/Floor Below Wizard
	Figure 9-12 . Floor Above/Below


	Custom Control, Continued
	Selecting Floor Tab
	1. Start the Floor Above/Below Wizard by clicking on the Floor Above/Floor Below Wizard tab, which is located along the bottom left part of the Custom Control window.
	2. Right click in the blank area above the tab. When the list of options appears, select Create Floor Group. (The ES Panel refers to each set of floor above/below equations as a Floor Group. This is the name of the group or area that the floor above/...
	Figure 9-13 . Create Floor Group
	Figure 9-14 . Select Group



	Custom Control, Continued
	General Information
	Figure 9-15 . Floor Above/Below Data


	Custom Control, Continued
	Specifying Floor Names
	Figure 9-16 . Specify Floor Names

	Specifying Input and Static Points
	Figure 9-17 . Input and Static Points


	Custom Control, Continued
	Using the Selective Signaling Wizard
	Figure 9-18 . Selective Signaling

	Selecting Selective Signaling Wizard Tab
	Figure 9-19 . Create Selective Signaling Group
	Figure 9-20 . Naming Group


	Custom Control, Continued
	Setting General Options
	Figure 9-21 . General Information

	Setting Zone Names
	Figure 9-22 . Zone Names


	Custom Control, Continued
	Linking Initiating and Notification Points
	Figure 9-23 . Linking Initiating and Notification Devices
	1. Click on the button labeled Alarm Points. A tag list appears. Use the up and down arrow keys to move through the list. Use the spacebar to tag (select) a point. A “>>” symbol appears to the left of the point when it is selected. Click OK to co...
	2. In Notification Points in this Signal Zone, click the notification appliance you want to turn on when the tagged initiating devices activate. The choices are: Visual Points, Audible Points, TrueAlert Zones (Addressable), and TrueAlert Zones (Non-A...
	3. You can also activate other notification signal zones when a tagged initiating device activates. To do this, click on the Notification Zones button to the right of the Other Signal Zones Notified label. A tag list appears. Use the up and down arro...
	4. Click Next to continue. A screen showing the equations created by the wizard appears. Click Finish.


	Custom Control, Continued
	Using the Sounder/Relay Base Wizard
	1. Start the Sounder/Relay Base Wizard by clicking on the Sounder/Relay Base Operation Wizard tab, which is located along the bottom left part of the Custom Control window.
	2. Right click in the blank area above the tabs. When the list of options appears, select Create Point Group. A figure similar to appears.
	Figure 9-24 . Creating Point Group

	3. Enter a Name for the group in the Point Group field and enter any comments in the Comments box. Click Next to continue. Refer to the appropriate section below for specific information.

	Activating Base on Alarm
	1. To select this option, select the radio button labeled “Alarm—Activate Base on Alarm.”
	2. If necessary, you can select a different Custom Control user program. To do this, click on the control to the right of Program # and select the appropriate program number. Click Next to continue.
	Figure 9-25 . Sounder/Relay Base Information



	Custom Control, Continued
	Activating Base on Alarm
	3. A dialog similar to the following appears. Select the operation for the device as either “Hold Device ON until Reset” (sounder or relay remains activated until reset) or “Hold Device on until Silence” (sounder or relay remains activated un...
	Figure 9-26 . Specifying Device Operation

	4. Click on the Group Points button. A tag list, containing single station points appears. Use the up and down arrow keys to move through the list. Use the spacebar to tag (select) a point. A “>>” symbol appears to the left of the point when it i...
	Figure 9-27 . Tagging Points

	5. Click OK to continue. The previous screen appears. Press Next to continue. A screen showing the Custom Control statements appears. Click Finish.


	Custom Control, Continued
	Common Ground Fault LED Control

	Custom Control, Continued
	Suppression Release Introduction
	Suppression Release General Capabilities
	Table 9-1 . Number of NACs for Hazard Area


	Custom Control, Continued
	Suppression Release General Capabilities
	Figure 9-28 . Suppression Release Overview


	Custom Control, Continued
	Suppression Release Device and Point Types
	Table 9-2 . Valid Device and Point Types


	Custom Control, Continued
	Suppression Release Device and Point Types
	Table 9-2 . Valid Device and Point Types, continued


	Custom Control, Continued
	Suppression Release Signal Responses
	1. Alarm Silence/System Reset

	Suppression Release Use Cases
	1. Hazard Area Name: Area 1
	2. Comments: n/a


	Custom Control, Continued
	Suppression Release Use Cases
	Table 9-3 . 10 Second Delay Abort, Actions and Responses


	Custom Control, Continued
	Suppression Release Use Cases
	Table 9-4 . NYC Abort, Actions and Responses


	Custom Control, Continued
	Suppression Release Use Cases
	Table 9-5 . IRI Abort, Actions and Releases
	1. Hazard Area Name: Area 1
	2. Comments: n/a


	Custom Control, Continued
	Suppression Release Use Cases
	Table 9-6 . Immediate Release, Actions and Responses


	Custom Control, Continued
	Step 1. Defining Hazard Area
	1. Click the Custom Control tab.
	2. Click the Suppression Release Wizard subtab. A screen similar to the one shown in Figure 9-29 appears.
	Figure 9-29 . Create Hazard Area Menu Choice

	3. Right click on the blank area of the screen labeled Hazard Area.
	4. Click on Create Hazard Area from the menu that appears. A screen similar to the one shown below appears.
	5. Enter a name for the hazard area in the Hazard Area Name field and enter any applicable comments. Click Next to continue.
	Figure 9-30 . Naming Hazard Area



	Custom Control, Continued
	Step 2. Specifying Initial Data and Options
	Figure 9-31 . Cross Zone (Dual Detector) Options


	Custom Control, Continued
	Step 3. Specifying Abort Switch Operation
	Figure 9-32 . Abort Switch Options


	Custom Control, Continued
	Step 3. Specifying Abort Switch Operation
	Step 4. Setting Timer Options
	Figure 9-33 . Timer Configuration Options


	Custom Control, Continued
	Step 4. Setting Timer Options
	Step 5. Specifying Hazard Area Points
	Figure 9-34 . Tag List Buttons


	Custom Control, Continued
	Step 5. Specifying Hazard Area Points
	1. Click on the button corresponding to the type of suppression points you want to select. The TagList screen shown in Figure 9-35 appears.
	2. The TagList screen displays all points with the relevant suppression release point type. To select a specific point for inclusion in the hazard area being programmed, click on the point to highlight it and then press the space bar.
	Figure 9-35 . Tagging Points

	3. Click OK when you are finished selecting points. The screen containing the Tag List buttons (Figure 9-34) reappears. Click Next when all points associated with this hazard area have been chosen.


	Custom Control, Continued
	Step 5. Specifying Hazard Area Points
	Figure 9-36 . Reviewing Options
	Figure 9-37 . Icon Added Following Programming


	Custom Control, Continued
	Deleting Hazard Area
	1. Right click the name of the hazard area (see Figure 9-37) and select the Delete Hazard Area option. A dialog appears warning you that all Custom Control equations associated with the hazard area will be deleted.
	2. Click Delete associated list and pseudo points
	3. Click Yes
	Figure 9-38 . Deleting Hazard Areas


	Editing Existing Hazard Area
	Figure 9-39 . Manual Edit


	Custom Control, Continued
	Scheduling Options for Self-Test Wizard
	Step 1. Creating a New Self-Test
	1. Click on the Custom Control tab.
	2. Click on the Scheduled Self-Test Wizard subtab, right click inside the blank area of the Scheduled Tests and select the Create Self-Test option. A screen similar to the one shown in Figure 9-40 appears.
	3. Complete the Self-Test Name and Comments fields
	4. Click Next.
	Figure 9-40 . Wizard entry screen



	Custom Control, Continued
	Step 1. Creating a New Self-Test
	5. The next screen, shown in Figure 9-41, specifies the Custom Control Program Number. This is the program number under which the self-test custom control equations created by the wizard are stored. No specific program number is reserved for use by S...
	Figure 9-41 . Initial Data Screen


	Step 2. Selecting Start Time and Frequency of the Self-Test
	1. In the Self-Test Start Time area select the time to run the Self-Test.
	2. In Recurrence Pattern, click the frequency and the day that the self-test is going to run.
	3. Click Next.
	Figure 9-42 . Self-Test Time and Recurrence (Weekly Configuration Shown as an Example)



	Custom Control, Continued
	Step 3. Selecting Self-Test Triggering Point and Point List
	1. In Self-Test Triggering Point, click Select Pseudo Point to choose a pseudo point that will be used to activate Self-Test (Figure 9-43).
	2. Inside Self-Test Options, click Select Point List to choose the points list for Self-Test.
	In Volume select whether horns on sounder devices will be disabled during Self-Test.
	In Trouble on Fail select yes or no to choose if a trouble will be generated if self-test fails.
	Click Next.
	3. In the summary screen that appears, ensure that all of the settings are configured correctly and click Finish to complete the Self-Test Wizard. Table 9-7 lists all the default values for the Scheduled Self-Test Wizard.
	Figure 9-43 . Self-Test Triggering Point and Point List
	Table 9-7 . Default Values for the Self-Test Wizard Settings
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	USB File Transfer
	USB File Transfer
	1. Insert the USB storage device into the 4007ES Panel and upload the job currently running on the panel. The job is uploaded into a zip folder. The USB storage device must be formatted with FAT32 file system.
	2. Take the USB storage device out of the panel and insert it in the PC.
	3. Unzip the job and open it using the same version of the Programmer as the Master .BIN file running in the panel. For example, if 4007_3.02.03.bin is the file in the panel, then Programmer version 3.02.04 must be used.
	4. Save the job, build it, and then re-open it using the most recent version of the Programmer.
	5. Click on the Transfer menu option and then on USB.
	6. In the USB Transfer window (Figure 10-1), click CFIG, Panel Exec and Include Binary Files checkboxes and make sure the files are attached.
	Figure 10-1 . USB Transfer Window

	7. Select the appropriate mass storage device and click on the Download button to download the files to the USB storage device. If older files are detected, the Overwrite Files dialog box appears. Click on the Yes button to replace the old files with...


	USB File Transfer, Continued
	USB File Transfer
	8. Disconnect the USB storage device from the PC and insert it into the USB port located on the CPU board that is mounted on the inner door panel of the 4007ES. Files that need to be updated are flagged for an upgrade on the panel display (Figure 10-2).
	Figure 10-2 . System Upgrade Window

	9. Press the Process Upgrade button on the touchscreen and confirm the selections.
	10. When prompted, press the button to take a snapshot of the existing panel software to be able to go back to the original files, if necessary.
	11. After the panel reboot, press on the System Upgrade button to verify that no software is marked for an upgrade and disconnect the USB storage device by pressing the Eject USB button located under the Mass Storage.

	Files Transferred

	IP File Transfer
	IP File Transfer
	File Transfer Connection to the PC
	Figure 10-3 . Front Panel Ethernet Service Port

	Starting the IP File Transfer Utility
	Figure 10-4 . Transfer Icon


	IP File Transfer, Continued
	IP Communication Parameter Settings
	Figure 10-5 . File Transfer Settings Window

	Downloadable Files

	IP File Transfer, Continued
	Download Tab
	Figure 10-6 . IP File Transfer Download Tab


	IP File Transfer, Continued
	Download Tab
	1. To download a software feature, make sure the Service Mode (Jumper 7) is enabled. Select the type of file you want to download by clicking on the radio button next to the file you want to download. The options are:
	2. Once the selection has been made, use the checkboxes to select the download options:
	3. Use the File name box to select the file you want to download to the panel.
	4. Click on the Download button to start the process.


	IP File Transfer, Continued
	Upload/Reports Tab
	Figure 10-7 .Upload/Reports Tab
	1. Click on the Upload/Reports tab near the top of the IP File Transfer window. See Figure 10-7.
	2. Select the type of file you want to upload by clicking on the radio button next to the item.
	3. Chose one of the following:
	4. Use the File name box to select the directory on your PC you want to upload the report to.
	5. Click on the Upload button to start the upload.


	IP File Transfer, Continued
	Type of Transfer
	Chapter 11 .
	Port Vectoring
	Introduction
	In this chapter

	Choosing Event Groups to Route
	1. Click on the Port Vectoring tab, located just beneath the row of icons, to view the window used to route events to the RS-232 port or the DACTs. A window similar to the one shown in Figure 11-1 appears.
	Figure 11-1 . Port Vectoring Tab

	2. In the Available Ports list, located on the left side of the window, click on the line containing the port you want to program. If you choose RS-232, all of the event types shown in the figure are available for routing. If you choose one of the DA...
	3. In the Event Types list, located on the right side of the window, select the checkboxes corresponding to the event types that you want to route to the device selected in Step 1.
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	AMON Point Type
	Introduction
	In this chapter

	AMON Pt Type Tab
	Figure 12-1 . AMON Point Type Tab



	AMON Point Type
	Adding a Point Type
	1. To start this wizard, right click in the blank space just below the Point. When the menu appears, click on Add. A dialog similar to the one shown in Figure 12-3 appears.
	Figure 12-2 . Initial AMON Point Type Dialog

	2. Enter data in the initial dialog’s fields, as follows:
	Table 12-1 . Alarm Type



	AMON Point Type, Continued
	Adding a Point Type
	3. Click the Next button to view the dialog shown in Figure 12-3.
	Figure 12-3 . 4mA and 20mA Values Dialog

	4. Enter data in the 4mA and 20mA Values dialog (refer to Table 12-2).
	Table 12-2 . 4mA and 20mA Values

	5. Click the Next button. A dialog similar to the one shown in Figure 12-4 appears.
	Figure 12-4 . Threshold Unit Values Dialog

	6. In the Threshold Unit Values Dialog, you can specify up to three thresholds.
	7. Click Finish.


	AMON Point Type, Continued
	Editing a Point
	1. Right click on the point you want to modify.
	2. Click on Properties.
	3. Modify the AMON Properties as required.
	Figure 12-5 . Editing an AMON Point Type

	4. Click Apply > OK.

	Deleting a Point
	1. Right click on the point you want to delete.
	2. Click on Delete.
	3. Click on Yes to confirm.
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	Adding or Editing Network Information
	Introduction
	In this chapter

	Role of the Network Programmer
	Public Versus External Points
	General Network Programming Guidelines


	Adding or Editing Network Information, Continued
	General Network Programming Guidelines
	4007ES Programmer Network tab
	Figure 13-1 . Network Tab


	Adding or Editing Network Information, Continued
	Gaining Access to the Network Information
	1. Click on the Network tab, shown in the upper right corner of Figure 13-2.
	2. Click on the Network Information subtab on the bottom left of the window.
	Figure 13-2 . Network Tab, Showing Network Information



	Adding or Editing Network Information, Continued
	Editing the Network Name and Node Number

	Adding or Editing Network Information, Continued
	Procedure to Declare Public Points
	1. Click on the Network tab shown in the upper right corner of Figure 13-1.
	2. Right click on the Public Points folder and select the Edit Public choice. The tag list is shown in Figure 13-3.
	3. Position the highlight on a point and press the space bar to tag the point. A >> symbol is shown to the left of the point to indicate that it is selected. (To remove this symbol and deselect a point, highlight the point and press the space bar again.
	Figure 13-3 . Public Points Tag List


	Procedure to Declare External Points
	1. Right click on the External Points folder and select the Edit Externals choice. The dialog shown below appears. Click on the drop down list box and select the number of the node containing the points you want to declare external.
	Figure 13-4 . Select Network Node



	Adding or Editing Network Information, Continued
	Procedure to Declare External Points
	2. Click OK. The tag list shown in Figure 13-5 appears. This taglist contains all of the points that are currently declared public on the node selected in Step 1 above.
	Figure 13-5 . Tag List for External Points

	3. Position the highlight on a point and press the space bar to tag the point. A >> symbol is shown to the left of the point to indicate that it is selected. (To remove this symbol and deselect a point, highlight the point and press the space bar again.

	Programming Network Alarm Silence

	Adding or Editing Network Information, Continued
	Programming Central Network Silence
	Figure 13-6 . Central Network Silence
	1. Open the network job, using the network programmer. Open the job for the node you have designated as the Central Network Silence Node.
	2. When the ES Panel programmer appears, click on the Network tab at the top of the programmer. When the Network window appears, click on the Network Points subtab at the bottom of the Network window.
	3. Right click in the Network window. When the choices appear, click on Edit Externals. A dialog similar to the following appears. Click on the drop down list box and choose one of the nodes on the network.
	Figure 13-7 . Select Network Node



	Adding or Editing Network Information, Continued
	Programming Central Network Silence
	4. Click OK to close the dialog. When you do this, a tag list containing the public points from the selected node appears. Click on P217 Network Signal Silence and press the space bar to select the point. Click OK to close the taglist.
	5. Repeat Steps 3 and 4 for every node on the network.
	6. Click on the List tab at the top of the programmer. When the List window appears, click on the General List subtab at the bottom of the window. Scroll through the list, right click on L106 - External Alarm Silence Points and select Tag List.
	7. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click on the Network Externals check box. Click on the OK button. All of the External Points appear.
	8. Click on each entry for P217 - Network Signal Silence (each node on the network should have an entry) and press the space bar to add the entry to L106. N:P217 represents the Node Number.

	Programming Distributed Network Silence
	Figure 13-8 . Distributed Network Silence


	Adding or Editing Network Information, Continued
	Programming Central Network Reset
	Figure 13-9 . Central Network Reset
	1. Open the network job, using the network programmer. Open the job for the node that will serve as the Central Reset Node.
	2. When the ES Panel programmer appears, click on the Network tab at the top of the programmer. When the Network window appears, click on the Network Points subtab at the bottom of the Network window.
	3. Right click in the Network window. When the choices appear, click on Edit Externals. A dialog appears. Click on the drop down list box and choose one of the nodes on the network.
	4. Click OK to close the dialog. When you do this, a tag list containing the public points from the selected node appears. Click on P210 and press the space bar to select the point. Click P211 and press the space bar to select the point. Click OK to ...
	5. Repeat Steps 3 and 4 for every node on the network.
	6. Click on the List tab at the top of the programmer. When the List window appears, click the General List subtab at the bottom of the window. Scroll through the list, right click on L103 and select Tag List.
	7. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click the Network Externals check box. All of the External Points appear.
	8. Click on the entry for P210 and press the space bar.
	9. Repeat Steps 6 through 8 for every node on the network.
	10. Click on the List Tab at the top of the programmer. When the List window appears, click the General List subtab at the bottom of the window. Scroll through the list, right click L104 and select Tag List.


	Adding or Editing Network Information, Continued
	Programming Central Network Reset
	11. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click on the Network Externals check box. All of the External Points appear.
	12. Click on the entry for P211 and press the space bar.
	13. Repeat Steps 10 through 12 for every node on the network.

	Programming Distributed Network Reset
	Figure 13-10 . Distributed Network Reset
	1. Open the network job, using the network programmer.Open the job for one of the nodes.
	2. When the ES Panel programmer appears, click on the Network tab at the top of the programmer. When the Network window appears, click on the Network Points subtab at the bottom of the Network window.
	3. Right click in the Network window. When the choices appear, click on Edit Externals. A dialog similar to the following appears. Click on the drop down list box and choose one of the nodes on the network.
	Figure 13-11 . Choose Node

	4. Click OK to close the dialog. When you do this, a tag list containing the public points from the selected node appears. Click on P212 and press the space bar to select the point. Click OK to close the taglist.


	Adding or Editing Network Information, Continued
	Programming Distributed Network Reset
	5. Click on the List tab at the top of the programmer. When the List window appears, click on the General List subtab at the bottom of the window. Scroll through the list, right click on L105 and select Tag List.
	6. Click on the Filter icon at the top of the Tag List. When the list of choices appears, click on the Network Externals check box. All of the External Points appear.
	7. Click on every entry for P212 and press the space bar to add the entry to L106.
	8. Repeat Steps 3 through 7 for every node on the network.

	Distributed Configuration
	Figure 13-12 . Distributed Configuration
	1. Open the network job by using the network programmer.
	2. Open the job for the node that will serve as the central reset node.
	3. When the ES Panel programmer appears, click the Network tab at the top of the programmer.
	4. When the Network window appears, click the Network Points subtab at the bottom of the Network window.
	5. Right click in the Network window.
	6. When the choices appear, click on Edit Externals. A dialog box appears.
	7. Click on the drop-down list box and choose one of the nodes on the network.
	8. Click on OK to close the dialog. A tag list containing the public points from the selected node appears.
	9. Click on P463 and press the space bar to select the point.
	10. Click on P464 and press the spacebar to select the point.
	11. Click OK to close the taglist.
	12. Repeat Steps 5 to 11 for every node on the network.
	Appendix A.


	ULC Programming Requirements
	Introduction
	In this chapter



	Required Operations
	Introduction
	Procedure
	1. Click the Hardware tab and expand the Unit 0, Box 1, Bay 1, and Block A icons to display the Color User Interface icon, see Figure A-1. Click the + signs to the left of the Unit 0, Box 1, Bay 1, and Block A icons to expand them.)
	2. Right click the Color User Interface icon (highlighted in Figure A-1) and select Properties.
	3. Click check box S527 Operation, as shown in Figure A- 2.
	4. Click OK to close the dialog box.
	Figure A-1 . Expanded View of Hardware Configuration



	Required Operations, Continued
	Procedure
	Figure A- 2 . Color User Interface Properties with S527 Operation Check Box
	Figure A- 3 . ULC Labeling Requirements for LEDs


	Alarm Cutout Timer Feature
	Introduction
	Enabling Alarm Cutout Timer
	1. Click the Panel tab.
	2. Click the Systems Options subtab located at the bottom of the programmer.
	3. Click the Alarm Cutout Timer checkbox. Specify the timer value on the Seconds box to the right of the checkbox.

	Programming the LED
	1. Click the Point tab.
	2. Scroll until the points with the Digital device type are visible. Select a point which has an empty custom label field. (For purposes of demonstration, pseudo point P700 has been selected.)
	3. Right click on the point selected and select Properties.
	4. Enter the description in the custom label field, as shown in Figure A- 4.
	5. Click OK.
	Figure A- 4 . Pseudo Point Properties

	1. Review Chapter 8 of this manual for the process of creating Custom Control equations.
	2. Create the equation shown below in Figure A-5, which turns the assigned pseudo point ON when the Alarm Cutout Timer expires.
	3. Create a second equation, shown in Figure A-6, which turns the assigned pseudo point OFF when a subsequent alarm resounds the signaling devices and when the system is reset.


	Alarm Cutout Timer Feature, Continued
	Programming the LED
	Figure A- 5 . Custom Control Equation to Turn ON Pseudo Point
	Figure A- 6 . Custom Control Equation to Turn OFF Pseudo Point
	1. Review the section detailing how to program the LED module, see Chapter 6.
	2. Select a YELLOW LED to program. Set the Mode to ON and set the Reference Address to the pseudo assigned in Step 1, as shown in Figure A-7.
	3. Click OK.


	Alarm Cutout Timer Feature, Continued
	Programming the LED
	Figure A- 7 . LED Module Properties


	Releasing Specific Controls and Indications
	Introduction
	Pre-Discharge LED Programming (Red LED)
	1. Open the suppression releasing wizard for that hazard and write down the list number created for Manual Release Points and Automatic Release Points (L268 and L269 in this example).
	2. Pick any available digital pseudo point (P720 in this example) and program it to turn ON whenever a point in the lists from step 1 are detected going active.


	Releasing Specific Controls and Indications, Continued
	Pre-Discharge LED Programming (Red LED)
	3. Write an equation to turn off the LED when the zone releases.
	4. Write (or add to an existing equation) the equation to turn off the digital pseudo during system startup or upon system reset.
	5. Choose an available RED LED on the LED Module (under the Hardware tab in the programmer) and set its mode as "ON" and set the reference address to the list that was assigned.


	Releasing Specific Controls and Indications, Continued
	Discharge LED Programming (RED LED)
	1. Click the Custom Control tab.
	2. Click the Suppression Release Wizard subtab.
	3. Right-click the title (next to the wizard graphic) and select Properties to open the Hazard Area.
	4. Select the Points tab and write down the List assigned to Suppression Dump Points.
	5. Choose an available RED LED on the LED Module located under the Hardware tab. Set its mode as "ON" and set the reference address to the list that was assigned.


	Releasing Specific Controls and Indications, Continued
	Abort Switch Active
	1. Open the digital Pseudo Point list and look for a digital pseudo point created by the Suppression Release Wizard called SupRel Abort Switch Activate- yourhazardname. It should be towards the end of the list as the wizard just selects the next avai...
	2. Choose an available Yellow LED on the LED Module located under the Hardware tab. Set its mode as "ON" and set the reference address to the digital pseudo point that was assigned.

	Abort Switch Trouble during Normal Supervisory Conditions
	1. Change / Program the abort IAMs type from SUPABRT to a UTILITY point type in the Hardware tab for the IDNet devices. These IAMs should have already been assigned to the Hazard Area in the Suppression Release Wizard. If not, assign them now.


	Releasing Specific Controls and Indications, Continued
	Abort Switch Trouble during Normal Supervisory Conditions
	2. Configure three unused digital pseudo points to be used as two new troubles and a supervisory point. Label them as follows (change HAZNAME to the appropriate label for your hazard area):
	3. In the Suppression Release Wizard that you are working on, right click the title (next to the wizard graphic) and select Properties to open the Hazard Area.
	4. Select the points tab and write down the lists assigned to Abort Switches and Automatic Release Points.
	5. Enable Manual Editing of the suppression release wizard equations.


	Releasing Specific Controls and Indications, Continued
	Abort Switch Trouble during Normal Supervisory Conditions
	6. Click the List tab in the Programmer and right click the list for the abort switches made during step 3 and select where used to show all the custom control equations this list is referenced in.
	7. Add a HAZNAME - Abort Switch Trouble equation to annunciate troubles from this abort switch as shown below when the hazard area is not in alarm. Use the lists you wrote down from above as the input lists and the trouble digital pseudo point you cr...
	8. Add a HAZNAME - Abort Switch Short Circuit equation to annunciate short troubles from this abort switch as shown below. Use the abort list you wrote down from above as the input lists and the trouble digital pseudo point you created the Abort Swit...


	Releasing Specific Controls and Indications, Continued
	Abort Switch Trouble during Normal Supervisory Conditions
	9. Add a HAZNAME - Abort Switch Supervisory equation to annunciate a supervisory when the abort switch is activated in alarm as shown below. Use the lists you wrote down from above as the input lists and the supervisory digital pseudo point you creat...

	Releasing Service Signal Silence Programming - Optional (Pushbutton and Yellow LED)
	1. Program a button and a LED for Releasing Service Signal Silence (RSSS).
	a. Move the power LED function to the 4010-9805 LED module because the panel defaults to the bottom LED programmed as power when configured for ULC operation. This vacates a LED next to the silence button.
	b. If a second Hazard Zone is required, do the same for the ground fault trouble. To move the functionality of the LED mimic the mode, reference address, point type and any custom labels to an available LED.
	c. Configure the switch as Mode PBT* and select an available digital pseudo point as a reference address. The Custom Label appears on the display for the switch.
	d. Label it appropriately for the hazard area you are silencing.
	e. Configure the LED to as Mode ON and have it track another available digital Pseudo.



	Releasing Specific Controls and Indications, Continued
	Releasing Service Signal Silence Programming - Optional (Pushbutton and Yellow LED)
	2. Check if there are any manual or automatic alarms in the system and if someone is requesting to silence the NACs. The equation below checks this.
	3. Add to the reset equation for the pre-discharge LED above to reset the NACs and the LED during a system reset or startup.


	Releasing Specific Controls and Indications, Continued
	Releasing Service Signal Silence Programming - Optional (Pushbutton and Yellow LED)
	4. Disable the Suppression Release Wizard to delete the default equation written by the Suppression Release Wizard to silence the NACs on system silence. If it is not deleted it will still silence the hazard area.
	a. Right click the wizard for that hazard and select enable Manual Edit.
	b. Click Yes in the confirmation box that follows.
	c. Return to your custom control equations and find the equation that the Suppression Release Wizard labeled On System Silence - yourhazardname
	d. Right click and select Delete.




